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TRADEMARKS

Alconox is a registered trademark of the Alconox Company.

ASAP is a registered trademark of Micromeritics Instrument Corporation.
Chemraz is a registered trademark of Green, Tweed.

Kalrez is a registered trademark of DuPont Dow Elastomers L.L.C.

MATLAB is a registered trademark of MathWorks.

Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Python is a registered trademark of Python Software Foundation.

Teflon is a registered trademark of E. I. DuPont de Nemours Company.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under
the following license:

This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the
use of or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list
of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and
must not be misrepresented as being the original source. Such altered versions also must not be mis-
represented as being Info-ZIP releases — including, but not limited to, labeling of the altered versions with
the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further pro-
hibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

Copyright © 2019. Micromeritics Instrument Corporation. All rights reserved.
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. Ifaninstrumentor product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fithess for use.
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CORPORATE PROFILE

Micromeritics Instrument Corporation is a leading global provider of solutions for material characterization with best-
in-class instrumentation and application expertise in five core areas: density; surface area and porosity; particle size
and shape; powder characterization; and catalyst characterization and process development. Founded in 1962, the
company is headquartered in Norcross, Georgia, USA and has more than 300 employees worldwide. With a fully
integrated operation that extends from a world class scientific knowledge base through to in-house manufacture,
Micromeritics delivers an extensive range of high-performance products for academic research and industrial
problem-solving. The implementation of tactical partnerships to incubate and deliver valuable new technologies
exemplifies the company’s holistic, customer-centric approach which extends to a cost-efficient contract testing
laboratory — the Particle Testing Authority (PTA). The strategic acquisitions of Freeman Technology Ltd and Process
Integral Development S.L. (PID Eng & Tech) reflect an ongoing commitment to optimized, integrated solutions in the
industrially vital areas of powders and catalysis.

Freeman Technology (Tewkesbury, UK) brings market-leading powder characterization technology to
Micromeritics’ existing portfolio of particle characterization techniques. The resultis a suite of products that directly
supports efforts to understand and engineer particle properties to meet powder performance targets. With over 15
years of experience in powder testing, Freeman Technology specializes in systems for measuring the flow
properties of powders. In combination with detailed application know-how these systems deliver unrivalled insight
into powder behavior supporting development, formulation, scale-up, processing and manufacture across a wide
range of industrial sectors.

PID Eng & Tech (Madrid, Spain) complements Micromeritics’ renowned offering for catalyst characterization with
technology for the measurement and optimization of catalytic activity, with a product range that extends to both
standard and bespoke pilot scale equipment. Launched in 2003, PID Eng & Tech is a leading provider of
automated, modular microreactor systems for the detailed investigation of reaction kinetics and yield. These
products are supported by a highly skilled multidisciplinary team of engineers with in-depth expertise in the design,
construction and operation of laboratory units and process scale-up.

The Particle Testing Authority (PTA) provides material characterization services for fine powders and solid materials
using Micromeritics’ instrumentation alongside complementary solutions from other vendors. With the certification
and expertise to operate across a wide range of industries the PTA offering runs from single sample analysis to
complex method development, method validation, new product assessment, and the analytical support required for
large scale manufacturing projects. An experienced, highly trained team of scientists, engineers, and lab
technicians works closely with every client to ensure that all analytical requirements are rapidly and responsively
addressed.

Micromeritics has a strong global network with offices across the Americas, Asia, and Europe complemented by a
dedicated team of distributors in additional locations. This ensures that local, knowledgeable support is available
for every customer, in academia or industry. Micromeritics works across a truly diverse range of industries from oil
processing, petrochemicals and catalysts, to food and pharmaceuticals, and at the forefront of characterization
technology for next generation materials such as graphene, metal-organic-frameworks, nanocatalysts, and zeolites.
Engineering solutions that work optimally for every user is a defining characteristic of the company.

MicroActive ASAP 2020 Operator Manual
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CONTACT Us

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA/USA /30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International — contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Learning Center
Phone: 1-770-662-3607
www.Micro.edu
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ABOUT THIS MANUAL

Log in to your customer portal to access the following:

« Calculations

« Error Messages

o MicroActive ASAP 2020 Operator Manual in PDF format
« MicroActive Report Tutorials

o Smart VacPrep Operator Manual in PDF format

Parts and accessories can be found online at www.Micromeritics.com.

D All references to ASAP 2020 in this document encompass the optional ASAP 2020A

unless otherwise noted. References to chemisorption (or E) are not applicable to the
optional ASAP 2020A analyzer.

The following icons may be found in this manual:

Common Ilcons

Icon Refers to

Chemical Adsorption only (not applicable to the ASAP 2020A)

Physical Adsorption only

NOTE — Notes contain important information applicable to the topic.

CAUTION — Cautions contain information to help prevent actions that may damage the
analyzer or components.

>®.\Em

WARNING — Warnings contain information to help prevent actions that may cause
personal injury.

v MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019


http://www.micromeritics.com/Customer-Login.aspx
http://www.micromeritics.com/

[M] micromeritics’ Abouthis Manua

To view the full EC Declaration of Conformity document, visit the Micromeritics web page at
www.Micromeritics.com.

Original Instructions (English)

Part Number 202-42804-01 (Rev -) Released Feb 2019
Copyright 2019

Micromeritics Instrument Corporation

4356 Communications Drive

Norcross, GA/USA /30093-2901
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1 Analyzer Components for ASAP 2020

1 ANALYZER COMPONENTS FOR ASAP 2020

Parts and accessories can be found online at www.Micromeritics.com.

FRONT PANEL

A
Physical Adsorption

Front Panel Components

Chemical Adsorption

connector

Component Description

A | Elevator Provides placement of the dewar or furnace.

B |Vacuumpump panel |Provides access tothe vacuum pumps.

C |Powerindicator light |Blinks when power is applied to the analyzer; illuminates when the
analysis program is initiated and ready for operation.

D |Valve/Fanconnector | Connects the sample exhaust valve and cooling fan. The cooling
fan prevents overheating which could cause damage to the valve
and/or O-rings. It is controlled by a thermostat and operates only
when excessive heating occurs.

E |Samplethermocouple | Provides connection of the sample thermocouple.

connector
F | Gasflow meter Indicates the flow rate of gas passing through the sample tube.
Gas flow meterinlet | Connects the sample tube exhaust to the flow meter - measuring
flow through the tube.
H |Furnace coolinggas |Provides connection of a compressed air supply for cooling the fur-

nace.

Furnace ther-
mocouple connector

Provides connection of the furnace thermocouple.

MicroActive ASAP 2020 Operator Manual
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1 Analyzer Components for ASAP 2020

[M] micromeritics’

Front Panel Components (continued)

Component Description
J |Furnace power con- | Provides connection of the furnace power cord.
nector
K |Furnace circuit Protects the furnace in the event of a fault in the wiring. If the circuit
breaker breaker trips (pops out), contact a Micromeritics Service Rep-
resentative.
L |Highvacuum pump Power switch for the high vacuum pump.
switch
1.2 MicroActive ASAP 2020 Operator Manual
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FRONT UNDERSIDE PANEL

Pe ®

I} micromeritics
ASAP 2020

Front Underside Panel Components

Component Description
A |Degasports Two degas ports. Each degas port has a heating mantle con-
nection.
B |Heating mantle power | Use to connect the heating mantle power cord.
connector
C |Coldtraps (Optional) One cold trap is used for degassing and one for ana-
lysis.
D |[Pgport Use to install a P (saturation pressure) tube when performing ana-
lyses.
Sample port Use to install the sample tube.
F [High vacuum pump llluminate when the high-vacuum pumps are operating at normal
indicators speed. The left indicator is for degas operations and the right one
for analysis.
G |Hangers Four hangers for placement of protective shields.
H |Heatingmantlether- |For connecting a heating mantle thermocouple — one ther-
mocouple connector | mocouple connector for each degas port.
| Heating mantle Protects the heating mantle circuitry in the event of a failure.
breaker

MicroActive ASAP 2020 Operator Manual

202-42804-01 (Rev-) — Feb 2019 1-3



1 Analyzer Components for ASAP 2020

[M] micromeritics’

SIDE PANEL

HI

JKLM

Side Panel Components

Component Description
A | Vaporgas port For attaching the water vapor option or connecting
avapor gas.
B |Gasinletports [ Provides connection for analysis gas for physical

adsorption analyses.

C |Gasinletports [® Provides connection for analysis gas for chemical
adsorption analyses.

D |Degas backfill port Provides connection of a gas for degassing the
sample.

E |Heliuminletport Provides connection of helium for measuring the
free space.

F | Gasflow meter exhaust port Provides connection to a fume hood for safe vent-
ing of preparation gases.

G | Furnace cooling gasinlet port Admits the air supply for cooling the furnace.

H |Ethernetport Provides connection to the computer or Ethernet
Switch.

| RS232 port Not used.

1.4 MicroActive ASAP 2020 Operator Manual
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1 Analyzer Components for ASAP 2020

Side Panel Components (continued)

Component Description
J | Power connector For connecting the instrument to the electrical sup-
ply.
K |Voltage selector switch For setting the analyzer to the correct incoming

AC line voltage.

Power switch

For powering the instrument ON and OFF.

Valve circuit breaker

Protects the valve circuitry in the event of a failure.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019
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ANALYZER COMPONENTS FOR ASAP 2020A

FRONT COMPONENTS

Front Panel Components

Component Description

A Elevator Provides placement of the dewar.

B Power indicator light | Blinks when power is applied to the analyzer; illuminates when the
analysis program is initiated and ready for operation.

(03 Psat port Use to measure saturation pressure.

D Sample port Use to attach a sample for analysis.

1-6
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BACK PANEL COMPONENTS

A
NN

B \\

c s .

Back Panel Components

Component Description

A Gas Inlet ports For attaching the analysis gases.

B Helium Inlet port Provides connection of helium for measuring the free space.
Cc Vacuum Port For attaching vacuum pumps.

D Ethernet Port Provides connection to the computer or Ethernet switch.

E RS232 Port Not used.

F Power Provides electrical cable connector. Includes ON/OFF switch.

MicroActive ASAP 2020 Operator Manual
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EQUIPMENT OPTIONS AND UPGRADES

Parts and accessories can be found online at www.Micromeritics.com.

Equipment Option

Description

Chemical Adsorption
Option

Adds a stainless steel manifold with chemically resistant Kalrez seals
to support analyses using aggressive gases or vapors as the
adsorptive.

Allows the chemical adsorption capability to be added to an

ASAP 2020 analyzer. If a 10 torr transducer and a high-vacuum pump
system do not exist on the current analyzer, an upgrade of the
transducer and pump system will be required.

Chiller Dewar

A closed loop recirculating system that utilizes a high surface area
copper coil to provide excellent heat transfer between the dewar and
the recirculating liquids. Log in to your customer portal to access the
Chiller Dewar Quick Start Guide (part number 025-42801-00).

Cold Trap

This kit contains all hardware and cold trap dewar needed for making
the cold trap operational.

CryoStat

A closed-cycle CryoCooler based on the Gifford-McMahon (GM) refri-
geration principle. It uses helium gas from a helium compressor to gen-
erate cryogenic temperatures. The cryostat eliminates the need for
liquid nitrogen and can obtain temperatures below the 77 K of liquid
nitrogen. The decibel rating of the CryoStat HC-4A Zephyr is 56 dBa
at 1 meter.

HiVac System

Adds a 10 mmHg transducer and a high-vacuum pump to the standard
physical adsorption system. This system provides low pressure cap-
ability and pressure measurement resolution required for analysis of
low surface area materials using krypton as the adsorptive.

Micropore Option

Adds a 0.1 mmHg transducer and a high-vacuum pump. This system
delivers accurate porosity data on pores between 0.35 and

3 nanometers and provides a comprehensive selection of micropore
reports.

Multigas to Micropore

Allows a HiVac analyzer to be used for micropore analyses. This kit
adds a 0.1 torr transducer to allow pressure measurements to be
made more accurately in the sub 0.1 torr region.

Vapor Adsorption Includes optional vapor accessories.

Option

2020A Analyzer Expansion unit for the ASAP 2020.

1.8 MicroActive ASAP 2020 Operator Manual
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GAS REQUIREMENTS

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are required.
Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases should be of a
purity of 99.999% or better. Gas regulators can be ordered from Micromeritics. Parts and
accessories can be found online at www.Micromeritics.com.

All analyzer types Chemical adsorption units

(CGA580) N, 99.999% All gases listed to the left and:

(CGA580)He 99.999%

(CGA 580) Kr * 99.995%  |(CGA350)H, 99.999%
(CGA 350) CO 99.990%

* Krypton needed for krypton units

only
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1 Analyzer Components for ASAP 2020

[M] micromeritics’

SPECIFICATIONS FOR ASAP 2020 AND 2020A

Specification

Description

Cryogen System

Analysis Time

Unlimited. Cryogen dewars may be refilled without affecting the
accuracy of results.

Capacity

3 liter dewar, which typically provides up to 72 hours of unattended
analysis.

Special Features

Isothermal Jackets maintain cryogen level constant on sample tube
and P tube during analysis while evaporation of cryogen occurs.

Degas System (optional)

Backfill Gas

User-selectable, typically helium or nitrogen.

Pressure Range

0 to 950 mmHg.
Accuracy: 1% best fit straight line.

Temperature Range

Ambientto 450 °C, 1 °C increments.
Accuracy: Deviation less than £10 °C of set point at thermocouple.

Electrical
Voltage 100, 115, 230 VAC +10%
Frequency 50to 60 Hz
Power 700 VA, operating
Environment
Temperature 10to 30 °C, operating
-10to 55 °C, storing or shipping
Humidity 20 to 80% relative, noncondensing

Gases

Argon, carbon dioxide, nitrogen, krypton (multigas system), and other suitable gases.

Manifold Temperature Transducer

Type

Platinum resistance device (RTD)

Accuracy

+0.02°C

1-10
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Specifications for ASAP 2020 and 2020A

Specification Description
Physical (ASAP 2020)

Height 99cm (39in.)

Width 85cm (33.5in.)

Depth 61cm(24in.)

Weight 115 kg (250 Ibs.)

Physical (optional ASAP 2020A)

Height 94.5cm (37.2in.)

Width 38.1cm (15.01in.)

Depth (chassis)

59.0 cm (23.2in.)

Depth (with vacuum
tube)

68.1cm (26.8in.)

Weight

68 kg (150 Ibs)

Pressure Measurement

Accuracy (Analysis system only) — Includes nonlinearity, hysteresis, and nonrepeatability. Trans-
ducer manufacturer’s specifications. All within 0.15% of reading.

Range

0to 950 mmHg

Resolution

1000 mmHg Transducer

0.001 mmHg (Analysis system and P system)

1 mmHg (Degas system)

10 mmHg Transducer
(high-vacuum systems)

0.00001 mmHg

1 mmHg Transducer Mico-
pore systems (optional for
high stability)

0.000001 mmHg

0.1 mmHg Transducer
Micropore systems with 0.1
mmHgq transducer (optional

for high stability)

0.0000001 mmHg

Sample Size

Sample tubes are available for various size pellets, cores, and powders. Sample tube stems are

normally 1.27 cm (1/2 in.) OD with 9 cc bulbs. Also available are 0.635 cm (1/4 in.) or 0.953 cm (3/8
in.) OD with 9 cc bulbs. A 22-mm (0.87 in.) ID, 25 mm (1.0 in.) OD sample tube kit is also available.
Special tubes can be designed to accommodate unusual samples. If other sizes are required, con-
tact your local Micromeritics representative.

MicroActive ASAP 2020 Operator Manual
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1 Analyzer Components for ASAP 2020 Ei “’Ii[“,.I"[]I’Tler‘iticﬁim

Specification

Description

System Capacity

Analysis

1 sample port and 1 saturation pressure tube (2 each with the
optional ASAP 2020A).

Sample Preparation

2 degas ports (ASAP 2020). The optional ASAP 2020A has no
degas ports.

Total Operating
Capacity

Up to four complete analysis units can be controlled independently
by one computer.

Vacuum System

Vacuum Pump

Mechanical, two-stage, for analysis; optional for degas. Ultimate
vacuum 5 x 10" mmHg. Dry pumps available for systems equipped
with optional high-vacuum pump.

High-vacuum Pump

(Ifinstalled.) Less than 3.8 x 10" mmHg, as measured by pump
manufacturer according to Pneurop Standard 5608.

Computer Requirements

required.

« Drives. USB port.

« Operating System. Windows 7 Professional or higher operating system is recommended for
the best user experience.

« Desktop Installation Required. The application should not be installed on a network drive
with shared access. Multiple users cannot operate the application at the same time.

« 10 Base T or 100 Base T Ethernet Port. If the computer is to be connected to a network, two
Ethernet ports are required. If more than one Ethernet based unit is connected to the same com-
puter (or if a Smart VacPrep or ASAP 2020A is purchased), an Ethernet switch will also be

« Read / Write Permissions. All users of the application will need Read/Write permission to alll
directories and subdirectories where the application is installed.

In keeping with a policy of ongoing product improvement, specifications are subject to change

without notice.

1-12
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Ei m icromepitics“ 2 About the Software

2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Help menu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own
tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs, and copy and
paste graphics, are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.

SOFTWARE SETUP

/ If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes — such as adding, moving, or removing a unit, etc.

to the computer's operating system manual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup program must
match. The IP address must be 192.168.77.100.

/ If the IP address needs to be changed on the computer connected to the analyzer, refer

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



2 About the Software

[M] micromeritics®

MENU STRUCTURE

All program functions use standard Windows menu functionality. The title bar contains a Unit [N]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Main Menu Bar Options

Option Description
File Use to manage files used by the application — such as sample files, ana-
lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit
[n] displays on the menu bar for each analyzer attached to the computer.
Smart VacPrep (Ifinstalled.) Use to access the menu for each installed Smart VacPrep.
Reports Use to run reports and view the results.
Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.
Window Use to manage open windows and display a list of open windows. A check-
mark appears to the left of the active window.
Help Provides access to the online operator manual, the Micromeritics web
page, the analyzer web page, and information about the application.
2.2 MicroActive ASAP 2020 Operator Manual
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Ei micromeritics“ Common Fields and Buttons

COMMON FIELDS AND BUTTONS

The fields and buttons in the following table are located in multiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Common Fields and Buttons

Field or Button

Description

Add

Add an item to the list.

Add Log Entry

Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically. Autoscale means that the x- and y-
ranges will be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when

Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this
alphanumeric field can be used to enter additional information about
the sample, such as a sample lot number, sample ID, etc. This field
label may have been renamed or may not display if modified in
Options > Default Methods.

Browse Searches for afile.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.
Close Closes the active window.

Close All Closes all active windows. If changes were made and not yet saved, a

prompt displays for each changed file providing the option to save the
file.

MicroActive ASAP 2020 Operator Manual
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2 About the Software

[M] micromeritics®

Common Fields and Buttons (continued)

Field or Button

Description

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Select the number of copies to print. This field is only enabled when
Printis selected.

Delete When working with pressure tables and pressures, Delete removes
the selected information.

Destination Select the report destination.

Edit When working with report parameters, highlight the item in the Selec-
ted Reportslist box and click Edit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes.

Export Exports datain a sample file as a .REP, .TXT, or .XLS file. When
saved to afile, the data can be imported into other applications.

File Select the destination directory. Enter a new file name in the File name
field, or accept the default. Select to save the file as a report system
(.REP), a spreadsheet (.XLS), a portable document format (.PDF), or
an ASClII text (.TXT) file format.

File name Select a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From/To When working with report parameters windows, enter the From and
Torange for x- and/or y-axes.

Insert Use to insert one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification,
and file status.

Name The Name column is a list of files in the selected directory or library.

Next Click to move to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click to move to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not beenrunona
sample, this button is disabled.
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Common Fields and Buttons

Common Fields and Buttons (continued)

Field or Button

Description

Print

Sends the report to the selected destination (screen, printer, or file).

Remove Remove the selected file or files from the list.

Replace Click to select another file where the values will replace the current
file’s values.

Replace All Click to select another .SMP file where the values will replace all val-
ues for the active sample file. The original file will remain unchanged.

Report Click to display a window to specify report output options.

Save Saves changes to the active window.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Use to display the data from the current analysis.

Instrument Log. Use to display recent analyses, calibrations, errors,
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION

In the File Selector window, the Mic Description column and the Mic Status column display file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display a menu of
standard Windows functions.

File Status

File Status Description

Analyzing Sampile files that are currently being used for analysis.
Complete Sample files used in an analysis that has been completed.
Entered Sample files containing manually entered data.

No Analysis Sample files which have not been used to perform an analysis.

File Type, Extension, and Location

File Type File Name |Default Location
Extension

Alpha-s Curve * ALS Param directory
Adsorptive Properties ADP Param directory
Analysis Conditions ANC Param directory
Degas Conditions .DEG Param directory
Heat of Adsorption Report | -HOA Param directory
Methods .MTH Param directory
Report Options .RPO Param directory
Sample Information .SMP Data directory
Sample Tube Properties |.STB Param directory
Thickness Curve ** .THK Param directory

* Alpha-S Curve file. Saves the relative pressures and resulting quantities adsorbed as an ASCII
text file. These data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative
pressure.

** Thickness Curve file. Saves the relative pressures and corresponding thicknesses as an ASCI|I
text file. These data are derived by dividing the condensed volume of adsorptive by the selected
surface area. The density conversion factor in the adsorptive properties file is used to convert
quantity adsorbed to volume of condensed adsorptive.
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[M] micromeritics’

File Status, Description, Extension, and Location

File types available when printing or exporting reports:

Portable document format .PDF
Report .REP
Spreadsheet XLS
Unicode TIXT
Extensible markup language XML
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KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example:

« toaccess the File menu, press Alt + F, then press the underlined letter on the submenu
« Alt + F opens the File menu, then press O to access the File Selector

/ If the underscore does not display beneath the letter on the menu or window, press the
Alt key on the keyboard.

Keyboard Shortcuts

Field or Button |Description

Alt +[Unit n] Opens the Unit [n] menu.

Alt+F Opens the File menu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save

changes displays.

Alt+H Opens the Help menu.

Alt + 1 Opens the Options menu.

Alt+R Opens the Reports menu.

Alt+V Opens the Smart VacPrep menu.

Alt + W Opens the Window menu.

Shift + F9 Opens the shortcut menu of either the selected component on the analyzer

schematic when manual control is enabled or onscreen reports.

Ctrl+ N Opens a new sample file.

Ctrl+ O Opens the File Selector window.

Ctri+P Opens the File Selectorto start a report from a selected .SMP file.

Ctrl+ S Saves the openfile.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.
5.8 MicroActive ASAP 2020 Operator Manual
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[M] micromeritics’ Keyboard Shortouts

Keyboard Shortcuts (continued)

Field or Button |Description

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selectorto start a report from a selected .SMP file.
F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.
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[M] micromeritics®

OPTION PRESENTATION

Options > Option Presentation

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Option Presentation Display

Presentation Display

Description

Advanced

Displays all parts of sample and parameter files. Navigate to para-
meter windows by selecting the tabs across the top of the window.

Basic

Displays sample information in a single window. This display option is
used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted

Displays the sample file in a single window similar to the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered to
change to the Basic or Advanced display option. This display type is
typically used in laboratories where analysis conditions must remain
constant — such as the pharmaceutical industry. The Advanced option
is not available at the bottom of the window when using the Restricted
display option.

Show Splash Screen

Enables (or disables) the splash screen upon application startup.

Show Degas
Conditions [¢

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab if not using a
SmartPrep or Smart VacPrep.

Presentation, or select Basic or Advanced from the drop-down list at the bottom of the

/ Specify or change the default option presentation by selecting Options > Option

window.

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same.
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Option Presentation

=S o
Sample: Degas Analysis Report
Description Conditions Conditions Options
Method: [Default ~ [E=NEER )
Sample: | default Method: | Defauit -]
Operator: Sample:
Submitter: Operator:
Bar Code: Sample Tube: sample Tube -
Sample tube:  Sample Tube - Mass
@ Enter © Caleulate
Mass e Mass: =
@ enter ) Calaate Sample Mass: 10000 g Empty tube: 10000 | g
: : 000C Sample + tube: 2.0000 | g
Sample Mass:  1.0000 g Empty tube:.  1.0000 | g Eorhr 1000 gfems
Sample +tube: 2.0000 | g C0000)
ity: s
Density:  1.000 g/am P
Degas conditions: [Degas Conditions -
Type of Data User Parameters
® automatically eollcted Parameter 1 0.000 R e S i [Run coneitons -]
) Manually entered Parameter 2 0.000 Report options: [Report options -
Parameter 3 0.000
Add Log Entry... Replace All..
Comments:
Add Log Entry
Replace Al sens]  [ome ]  [ome
Save As Close | [advanced -

option presentation

option presentation

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies

report options.
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LIBRARIES

Options > Manage Libraries

/ This feature is available only to Windows 7 and higher operating systems.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files that are stored in multiple locations — such as folders
on a C: drive, a network location, a connected external hard drive, or a connected USB flash drive —
providing access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items — such as saved searches and search
connectors — cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original file
storage location. However, when deleting files or folders from within a library, they are deleted from
their original file storage location.
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[M] micromeritics’

METHODS

Options > Default Method
File > Open > [LMTH File]

A Method determines the default sample identification format and sequence number. A Method is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sampile file created.

The Method drop-down list displays only those methods applicable to the open sample file type.

[E=SHen =8 Eon x|
s e

port
nnnnnn

nnnnnn

Operator

Default Method Sample Information File

Default Methods

Field or Button Description

Specify a default numeric string to be used as a prefix in the Sample
field when a new sample file is created. This number increments with
each sample file created.

Sequence Number
[text box]

Sample file name Enter a format for the sample identification. The entry in this field

[text box] becomes a part of the saved sample file name. Include the $ symbol to
have the sample file number included as part of the identification.

Sample These field labels may be renamed and the new label becomes a part

Operator of all new sample files.

Submitter

Bar Code [text box]

Default Method Files

Method Selected

Default File Modified

Physical Adsorption

2020.SMP

Chemical Adsorption

2020Chemi.SMP
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[M] micromeritics’

CREATE A METHOD

File > New Method [d

1. Onthe Create a Method window, select the Sample Morphology to be used and the Material
Type and Characterization, then click Next.

7| Create a Method [E=H E=R(F=5)

Sample Morphology

(@ Powder

() Formed material

Material Type and Characterization

High surface area oxide

Zeolite

MOF

Carbon black

Activated carbon

Pharmaceutical Exdpients or active ingredients

~

)

’1

L

~

] Create 3 Method EI@

Preparation

Degas temperature:  Eilil °C

Analysis gas: [Nltrogan -~

Isotherm Collection

[#]Surface area

[#]Total Pore volume and average pore size
[#]Mesopore size distribution via adsorption
[#]Mesopore size distribution via desorption

2. Enter a Degas temperature, then select an Analysis gas from the drop-down list.

3. Select the applicable isotherm collections. The Isotherm Collection options determine the pres-
sures of the data points measured in the analysis. Click Finish.

4. See Methods on the previous page to complete the form.

Options > Default Method

See Methods on the previous page to complete the form.
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Configure the Analyzer

CONFIGURE THE ANALYZER

UNIT CONFIGURATION

Unit [n] > Unit Configuration > Gas

Use to display hardware / software configurations, calibrations, and gas selections of the connected
analyzer. The analyzer has gas inlets for up to six analysis gases for physical adsorption and 12 for

chemical adsorption.

The gases connected to the inlets must be specified in the analysis program. If the gas is changed on
one of the inlets, the same change must be made on the Unit Configuration window.

Unit Configuration

X
Volume Calibration Configuration
System Lower Reference  Date e
60.0000 450000 250000  Uncalibrated
P address:
A/D Calibration Serial #: demo . .
Manifold tamperature: Uncalibrated P P hys ical Adsorphon
Manifold transducer offset: Boot: Demo Boot Block
Uncalibrated Controler:  Demo Application <
I e Application:  MicroActive for ASAP 2020
Uncalibrated
neatora Smartvac Software Versions P1: N2 | Pz [ar < pxleo2 ~
10 mmiHg transducer offset: Unaliorated Boot: Boot Demo v1.00
M e e Uncailbrated Application:  Degas Demo App v1.00 P4 Kk ~| ps v e v
1mmHg transducer offset: Uncalibrated E—
1 mmig transducer scale: Ungalibrated MultiGas Cancel
Micropore
SmartVac /
Vacuum: Unealibrated
X
Volume Calibration Configuration
System Lower Reference  Date == H 1
60.0000 45.0000 25.0000 Uncalibrated c hemlcal Adsorptlon
IP address:
A/D Calibration Serial #: demo
Marifold temperature: Unealibrated Software Versions
Manifold transducer offset: Boot: Demo Boot Block PL N2 hd PZ: A b4 P3: [Co2 hd
Uncalibrated Controller:  Demo Application
R D Application:  MicroActive for ASAP 2020 P& ke v e M ~
Uncalibrated
ncalora SmartVac Software Versions o B 7 ozl 7 ol »
10 mmHg transducer offset: Uncalibrated Boot: Boot Demo v1.00 )
10 mimHg transducer scale: Uncaiibrated Application:  Degas Demo App v1.00 ca: [NH3 V| = vl o ~
0.1mmHg transducer offset: Uncalibrated Features:
0.1 mmHg transducer scale: uncalbrated MultiGas Cancel
Micropore HD
Chemi
— N
acuum: Uncalibrated — P e —
Sample thermocouple: Uncalibrated 1
R rcalbrsed
Furnace voltage: Uncalibrated Tz

Field or Button

Description

Calibrations [group box] | Displays calibration information for analyzer components.
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[M] micromeritics®

Unit Configuration (continued)

Field or Button

Description

Configuration

Displays the IP address used by the analysis program, serial number,

[group box] and type of analyzer.
IP address. Displays the IP address of the analyzer.
Change IP [button]. Click to display the Unit IP Setup window. Use to
change the IP address and subnet mask assigned during installation.
Do not edit these fields unless instructed by a Micromeritics Service
Representative.
Board ID [button]. Click to display information from the electronic
circuit boards in the analyzer. These parameters cannot be edited.
Gas [button] Displays ports for gas selections.
Software Versions Displays the software versions of the MIC BIOS, controller, and ana-
[group box] lysis program.
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Ei micromeriticsn Unit Selections

UNIT SELECTIONS

Options > Units

Use to specify how data should appear on the application windows and reports. This menu option is
not available if using Restricted option presentation in a standard installation environment.

I i)
Quantity Adsorbed Unit (@ pmalfg (@) mmolfg ) am3fg STP
Length Unit @ nm @R Quantity Adsorbed () pmolfg @) mmolfg () cm3fg STP
BIH/D-H Pare Dimension () width ©) diameter @) radius Pressure Urit @ kPa () mbar () mmHg
Pressure Unit T kPa *) mbar @ mmHg Pressure Symbol @ p,p® @ P, Po
Pressure Symbal ©p,p° @P,Po Temperature Unit @K @
Temperature Unit G @
Analysis Temperature Unit @K (6L
Physical Adsorption Chemical Adsorption
MicroActive ASAP 2020 Operator Manual 917
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INSTRUMENT STATUS

SHOWwW INSTRUMENT LOG

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors, or messages.

[E= El

[] Analysis Calibration [¥]Message
5/30/2014 10:26:07 AM  Message: Instrument Unit 1 - S/N: connection initialized. A
5/30/2014 10:24: 16 AM Message:! Instrument Unit 1 - $/N: connection closed.
5/30{2014 6:32:17 AM Message: Instrument Unit 1 - S/N: connection initialized.
5/29/2014 11:08:23 AM Message:! Instrument Unit 1 - $/N: connection closed.
5/29/2014 10:51:39 AM Message: Instrum it 1-5/N: connection initialized
5/23/2014 8:54:01 AM Message:! Instrument Unit 1 - $/N: connection closed.
5/23(2014 8:53:53 AM Message: Instrument Unit 1 - S/N: connection initialized.
5/21/2014 10:17:50 AM Message: Instrument Unit 1 - 5/N: connection closed. s

215005 e Moeoor- peoperi o Bl copmection il

Report.
Field Description

Add Log Entry [button] | Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Analysis/ Select the logs to display.

Calibration/

Message [check box]

Report [button] Click to select print destination and report start date.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Ei m icromeritics"“ Show Instrument Schematic

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

[ ma ][ a ][ o2 ||

« ] L]
g &n &" o™ &" o

He PS
Vacuum 2 % 3 4 5
1

. 5 7
Physical == ¢
N 760.00 mmHg j 8 9 11
AdSOI’ptIOI‘l 7.6000 mmHg Vapor
0.076000 mmHg \ I I I
NOTE: Vapor (port 8) not applicable to
the 2020A

c1
(v [~ [ [ « | I | D
epl epz $F3 ew $F5 epﬁ 52

Py He ép5 s c3
Yacuum L z 3 Fl 5 (D

- Y c4
A(;heml:::_al — 7 o Ve ] W |

Sorp |0n 760.00 mmHg * -
oo =) I‘D i
0.076000 mmHg —(D—:I

| 298.4 k| 308.1K
10.0 K/min
External Trigger
Analyzer Schematic Icon Table
Icon or Symbol Description
’ Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Open.

Servo Valve. Closed.
@
-
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Analyzer Schematic Icon Table (continued)

Icon or Symbol Description
Elevator.

C| Sample Tube and Furnace Elevator. The sample tube icon is white
when the sample and furnace temperatures are 50 °C or lower. If either

Ii the sample or furnace temperature exceeds 50 °C, the sample tube icon
I I turns orange. Temperature readings and ramp rate are displayed below

and to the left of the icon. The furnace icon resides on the elevator.

ﬁ Sample Tube. Cannot be manually controlled.

Analysis Valve Descriptions

Valve Description

Unrestricted vacuum

Restricted vacuum

Helium inlet port valve

Restricted analysis gas

Unrestricted analysis gas

Lower manifold isolation

Vapor inlet port (not applicable to the 2020A)

O (o ( N~ WOIN|(=

Sample port

Restricted Psat tube port

-
o

1 Unrestricted Psat tube port

P1 through P6 Gas inlet port valves
PS Supply valve for physical adsorption gases

PV Vacuum valve for physical adsorption gases

MicroActive ASAP 2020 Operator Manual
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Instrument Schematic Shortcut Menus

Schematic Shortcuts

Schematic Shortcut
Icon

Description

Valve options

‘v

Close. Closes the selected valve.
Open. Opens the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Elevator options

]

Raise. Select Raise to raise the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right click and select
Stop from the menu).

Lower. Select Lower and press the keyboard space bar to lower the
elevator.

Stop. Stops the elevator from moving.

Temperature control
options

{

On. Enables the temperature control.
Off. Disables the temperature control.

Set. Select to set the following:

« Enable or disable temperature control
« Control sample temperature

« Control furnace temperature

o Cool the sample toless than 50 °C

« Set heater power percent
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SHow STATUS
B st = e =
v |
Sample:
Stage Last Point p (kPa) pip° Q (mmol/g) p° (kPa) Run Time
Idle o 0.0000000 0.1035915 0.00000 101.3250 0:00
Details: | ]
Physical Adsorption
77 status ===
v |
Sample:
Stage Last Point p (kPa) Q (mmol/g) Run Time Manifold G:
Idle o 0.0000000 0.00000 0:00 Unknown
Details: | ]

Chemical Adsorption

If multiple units are attached to the computer, select Show Status on each Unit [n] menu. The status

for all units display.

2-22
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EXPORT FILES

File > Export

]EW See also:
—= Exported Data Example on page G - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or to a file. Data can be exported as a .PDF, .REP, .TXT, . XML, or . XLS file format.
The type of data to include or exclude can be selected during the export process. When exported to a
file, the data can be imported into other applications that read these file formats.

LiST FILES

File > List

Provides the option to create a list of sample file information —such as file name, date, time the file
was created or last edited, file identification, and file status.

Select one or more files from the file selector, then click List.

File Listing
Mo. File Mame Date Time File Identification Status
1 d-4cn2exsmp 11/4/2018 10:12:01 AM D4 Carbon (example) Complete
2 KRMCMBO.SMP  11/4/2018  10:12:01 AM MCME1 80 K (Kr) (heat of Complete
adsorpiion)
3 KRMCMBOSMP 1142018  10:12:01 AM MChM41 80 K (Kr) (heat of Complete
adsorpiion)
4 KRMCMID2.SMP 11472018  10:12:01 AM MCME1 102 K (Kr) (heat of Complete
adsorpiion)
5 KRMCM110.5MP  11/4/2018  10:12:01 AM MCM41 110 K (Kr) (heatof Complete
adsorpiion)
6 KRMCMIZ20.5MP  11M4/2018  10:12:01 AM MCM41 120 K (Kr) (heatof Complete
adsorpiion)
7 KRMCMI30.SMP  11:M4/2018  10:12:01 AM MCM41 130 K (Kr) (heatof Complete
adsorpiion)
& n2blank.smp 1142018 10:12:02 AM Blank Tube Test Mo Analysis
9 refchmbrsmp 1142018 10:12:02 AM Reference Chamber Run Mo Analysis
10 sial_refsmp 1142018 10:12:02 AM Silica Alumina Reference Material Mo Analysis
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SOFTWARE UNINSTALL

When the software is uninstalled using uninstall.exe, only the files required to run the application are
removed. Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.exe file located in the software installation
directory, then follow the prompts.

SOFTWARE UPDATES

Log in to your customer portal to access and download the latest analyzer software version.

When performing a software update, existing data files are not overwritten. There are three types of
subsequent installation:

« alater version than the current installation
« the same version as the current installation
« an earlier version than the current installation

Insert the setup media into the media drive. The setup program starts automatically. If the program
does not start automatically, navigate to the installation media drive, locate and double click the

setup.exefile.
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[Mi micromeritics® 3 Sample Files

3 SAMPLE FILES

Sampile files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options and may be
displayed in either Advanced, Basic, or Restricted presentation display mode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example — if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring conditions
can be created. When the sample file is created, the Analysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sampile file, the new file can be edited as
needed without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

Specify or change the default option presentation by selecting Options > Option
Presentation, or select Basic or Advanced from the drop-down list at the bottom of the
window.
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CREATE SAMPLE FILES

Options > Option Presentation > Show Degas Conditions P
File > New Sample > [.SMP File]
File > Open > [.SMP File]

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the default display option by selecting Options > Option Presentation or select
Basic or Advanced from the drop-down list at the bottom of the window.

Sampile files created in Basic option presentation must selected from parameter files created in
Advanced option presentation.

The values specified in the parameter portions of the default method are the defaults for new sample
files. To navigate from one set of parameters to another, select the parameter tab across the top of
the window.

Sample Tube parameters are edited on the Sample Description tab.

/ The Degas Conditions tab displays only if enabled in Options > Option Presentation >
Show Degas Conditions.

o[ ==
Sample ‘ Degas Analysis Report
Desaription Conditions Conditions Optons
Method: |Defauit
Sample: [ Activated Carbon |
Operator: [ h |
5]
Submitter: | SN3003 =S
Method:
Sample tube: | Sample Tube <] | edt.. Sample: [ Siica Alumina - 215 2/ ]
— Operator: ‘ 1K |
O Enter (®) Caleulate Sample tube: Sample Tube hd
Sample mass: 01427 g Empty twbe: | 37.8810 |
Mass
le +tube: | 38.0237 |
oensty: [ o0 falom @g @enter Ocsaiate
e Sample mass: | 0.3200 |g Empty tube:
le + tube:
Densiy: [ 1000 e sape *ube
Degas Conditions
Comments: SA-+ADSBIH+DESBIH+TPY
prEE SA+ADSBIH4DESBH-+TPY v
Close Advanced v Preview e G > Elevion]
Example of tabbed file editor in Example of file editor in
Advanced option presentation Basic option presentation
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Description window. Use a mouse to click in the field first where information is to be

/ A bar code reader may be used to enter text into many of the fields on the Sample

entered then scan the bar code with the bar code reader.

Sample Files

Field or Button

Description

Active Metals [button]

[«

Displays a list of active metals.

Add Log Entry [button]

Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Bar Code

Enter bar code reader information if a bar code reader is connected to
the computer’'s USB port. If a bar code reader is not used, this
alphanumeric field can be used to enter additional information about
the sample, such as a sample lot number, sample ID, etc. This field
label may have been renamed or may not display if modified in
Options > Default Methods.

Comments [text box]

Enter comments about the sample or analysis. Comments display in
the report header.

Mass [group box]

If mass = 1, the reported surface area equals the total surface area but
it is always shown as m2/g. If an accurate mass is entered, the repor-
ted surface area is normalized per gram of sample. Choose whether to
enter mass manually or have the system automatically calculate mass.
Enter a value for sample mass. Mass can be changed any time before,
during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used to
calculate sample mass:

Masssample = Masssampie+tube — Massype

Density. Value is used for the calculated free space method only. Use
0.000 for a blank analysis.

Method [drop-down box]

Select a method from the drop-down list.

Operator [text box]

Enter operator identification information. This field label may have
been renamed or may not display if modified in Options > Default
Methods.

MicroActive ASAP 2020 Operator Manual
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[M] micromeritics®

Sample Files (continued)

Field or Button

Description

[drop-down box] [&d

Sample [text box] Enter a sample description. This field label may have been renamed or
may not display if modified in Options > Default Methods.
Sample Tube Select a sample tube file from the drop-down list, or click Edit to

modify or create a new sample tube file.

Submitter [text box] Enter submitter identification information. This field label may have
been renamed or may not display if modified in Options > Default
Methods.

Type of Data Automatically collected. Select if the type of data will be

[group box] automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. If Manually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

See Manually Enter Data on the facing page.

User Parameters
[group box]

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report. Some fields may not display (or may have a different field
label) if modified in the method from which the sample file was created,
either through Options > Default Method or File > Open >
Method. See SPC Report for Physical Adsorption on page 7 - 4.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Open a Sample File

OPEN A SAMPLE FILE

File > Open > [.SMP File]

When working with an existing sample file, consider making a copy of the sample file to
maintain the original configuration options.

Close Advanced -

Previen

s
Relatve Sressure ipip”]

Clos=

File Type File Status Displays
Preparing
Prepared Tabbed file editor
Physical Adsorption or | No Analysis
Chemical Adsorption Complete
Analyzing MicroActive report window
Entered
= ) [E=mEEE =
= o =
—== R o0 [ v [
Method: g *,f O Caladated
Q:i e E ﬁf ;f s R
Submitrs | 1.P. Oler % / A — ®) 1deal 25 law Henseeality Factor:
Sample tube: | sample Tube v Edt.. ° g,.z" ® reie s (EEE;EE:Z: EZ:: peend™.
gsssnw O caulate o o > Retsive Prascura (ob’) e [7 e Ot (Corta e
Sample Mass‘__ﬂ 1150 |g Empty tube:
] Samplatimhe: Isotherm
)
iﬂm:'::‘:éswwun Add Log Entry : . /p‘*éﬁ‘
3 —t
Replace A e el -

Example of tabbed file editor

Example of report window

If a sample file with a Complete status is opened, to return to the tabbed file editor, select Advanced
or Basic from the drop-down at the bottom of the window.

MANUALLY ENTER DATA

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

« Copy and paste onto the graph area of the interactive window
« Import data into the interactive window

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019




3 Sample Files

[M] micromeritics®

CoPY AND PASTE MANUALLY ENTERED DATA

1. Open a sample file with a Complete status. The file will open to the interactive reports window.
2. Rightclick in the graph area of the interactive reports window, then select Copy data.

Save

0.1
Relative Pressure (p/p")

Close:

o]
Isoth Free Space
sotherm @ Measured  Ambient: 15,9512 cm? Analysis: 56,7619 cm?
_ : : i 16,0000 45,000
£ v Include report
& d
) v Enable overlays
= Sellct overl. SampleMass:  0.2550 g
a i Fluid Property Information
b=
z Autoscale all axes Cpen.., | [Savefs..,
E Reset axs limits to initial setting (9] ads -phase F.5. correct GEm AR
z
E) Show curve »
z -er—e Edit curve » Summary
E N
@) Adsarption point e
Edicaxis , © Relste Fresare D [pranat... |
) Desorption point
01 0.2 0.3 04 Editlegend 10 Absolute Pressure Srface area poirt
Pell  Edittitl
Copy graph Summary
Copy data - —
0.456814 emig
— Co data 0837098752
B PY 1286224
@ 4
o
z Single point desarption
5 tatal pore volure: 0.624827 emlg
= atrel. ure: 0.004488805
2 Maxirm ter: 3.488.086 &
5
B 2
? Singl rea: 2103326 mélg
) ure: 0.236799572
g
=4
—
o

Isatherm - Previen

B

|=2E=n ")

Isothorm

@cntered  Ambient:
O Calcated.

10000 Jom  Anaiyss: [ 1.0000 |em?

‘Sample mass: [ 10000 g
Flid roperty Information

03

05 05 07 08 08

04 .
Relative Pressure (p/p)

Isotherm

Quantity Adsorbed (mmollq)

Preview

Open another sampile file using Advanced option presentation.
On the Sample Description tab, select Manually entered in the Type of Data group box.
Click the Advanced down arrow at the bottom of the window, then select Isotherm.

6. Ensure that all parameter fields are set appropriately, then click Paste.
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IMPORT MANUALLY ENTERED DATA

When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

For Physical Adsorption or Chemical Adsorption:

» Relative Pressure

« Absolute Pressure (mmHg)

« Absolute Pressure (kPa)

« Absolute Pressure (mBar)

» Quantity Adsorbed (mmol/g)

« Quantity Adsorbed (cm?3/g STP)
» Quantity Adsorbed (cm3/g STP)

Sample Physical Adsorption ASCII Text File

Silica Alumina : Adsorption

Relative Pressure Quantity Adsorbed (cm3/g STP)
0.108629 50.6657
0.22288 60.7813
0.339909 71.3095
0.459512 84.4172
0.577447 102.672
0.654583 121.707
0.760074 179.096
0.855713 334.565
0.958511 394.675
0.996251 403.793
Silica Alumina : Desorption
Relative Pressure Quantity Adsorbed (cm3/g STP)
0.996251 403.793
0.86016 389.626
0.753567 256.264
0.664418 133.099
0.542416 96.7366
0.422295 79.7351
0.346371 71.5994
0.2519 62.8256
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0.152718 54.2336
0.103389 49.5803

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. Onthe Sample Description tab, select Manually entered.
3. Click the Advanced down arrow at the bottom of the window, then select Isotherm.

0 tew i 2 oo )
Free Space
Isotherm
Measured
1.0
@ Entered  Amblent: 10000 | em®  Analysis: 1.0000  cm?

Calculated

Sample Mass: 10000 g
Fluid Property Infarmation

A : . Open... Save As...

Ads,-phase F.5. correction

Quantity Adsorbed (cr®/g STF)
=
T

Summary

® Adsorption point o and ...
@ Relative Pressure pron R and T
L e e I B o e e e et Desorption point §
03 04 05 0B 07 s g pbsollte Pressure () surfacs aves print Importe | | Faste—

Felative Pressure (p/fp”)

=
2

o
=)
o
o
i

\ [ Import...
Summary -
Isotherm
1 Single point adsorption
= total pore volurne: —

a at relative pressure: Select a pressure.
% Maximum pore diametsr. —

=

= Single point desorption

8 total pore volume: —

= atrelative pressure: Select a pressure.
g L e Maxirum pore diameter —

2

B .

L Single point surface area: —

= at relative pressure: Select a pressure
&

ES

=]

00 — - :
15730 10718 107
Relative Pressure (p/p”)
Enter a walue between 00000 and 9,999.0000.
save As Close Isatherm - Preview

4. Ensure that all parameter fields are set appropriately, then click Import.

5. Openthe .TXT file. The data from the original sample file is imported and displayed. If an error
message appears instead, verify that the . TXT file format is correct.
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ACTIVE METALS FOR CHEMICAL ADSORPTION

Options > Active Metals Defaults

(or click Active Metals on the Sample Description tab when using Advanced presentation option)

&Qh See also:

ﬁr% Atomic Weights and Cross Sectional Areas on page A - 1

Up to 20 elements can be specified. At least one element must have a non-zero % of sample weight.

E=0|E=R
Element AmmAc Atomic | Density %Dfsarr:'vple % Reduced | MxQy | MxQy
Weight K:Ar:::(rs‘;i; {gfam3)|  weight X Y [m
1 [chromum | 7| s1oee  o0e3s 7100 000, 10000 1 o0
| 2fwbat x| sa93  oussz e noo w000 1 O
_SEDPDET j 63.540 0.0680, 8.960 0.00 100.00 1 o
4 |molybderum | 95.940  0.0730 10.220 000 w0000 1 O
Znid:al | sw ooses ssoz 000 10000 1 O
| 6 |palladium | 106.400 0.0787 12.020 0.00 100,00 1 0
7 |platinum j 195.090 0.0800, 21.450° 0.00 100.00 1 o
themum | me200 00840 20020 000 10000 1 O
| 9 |hodum x| w2005 00752 1241 000 1000 1 o0
| 10|siver ~| w7868 o0ses 10500 noo w000 1 O
Enter a unique element name,
Active Metals
Field or Button Description
% of Sample Weight * Percentage, by weight, of each element contained in the sample.
[column]
% Reduced * [column] The percent of metal reduced during preparation.
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3 Sample Files [M] micromeritics’

Active Metals (continued)

Field or Button Description

Adsorptive [button] Click to display and modify both the adsorptives and their asso-
ciated stoichiometry factor. Stoichiometry factors for each gas are
metal-specific.

1000
1000
1000
1.000 I
1000

Stoichiometry Factor. The stoichiometry factor is defined as the
moles of metal species covered per mole of adsorptive.

Atomic Cross Sect. Area |Atomic cross-sectional area of the element.
(nm?) [column]

Atomic Weight [column] Atomic weight of the element.

Density g/cm?3 [column] Density of the element.

Element [drop-down box] Select or enter the active metal.

MxOy, X * XandY values specify the empirical formula for metal and oxygen,
MxOy, Y * respectively, in a metal oxide.

[column]

* Options are shown only when using the Active Metals button on the Sample Description
tab.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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4 PARAMETER FILES

Parameter files allow for repeated use of parameter sets. For example — if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring conditions
can be created. When the sample file is created, the Analysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sampile file, the new file can be edited as
needed without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed or new
parameter files can be created.

The following file types can exist as part of the sample file as well as individual parameter files:

Parameter File Types

File Type File Extension
Adsorptive Properties .ADP
Analysis Conditions ANC
Degas Conditions [3] .DEG
Method .MTH
Report Options .RPO
Sample Tube [7] .STB
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[M] micromeritics®

ADSORPTIVE PROPERTIES

File > Open > [LADP File]

(or click Edit next to the Adsorptive selection on the Analysis Conditions tab when in Advanced

option presentation)

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

123.323 kPa
0,380 nm

: 0.162 pmz
Adsorbate molecular weight: 23.01

") High-resolution flid properties

Adsorbed-phase free-space comection

Dosing Method Adsorptive:

[E=8 EeE 52

Mnemonic:

Maximum manifold pressure: 925.00 mmHg
Therm. tran. hard-sphere diameter: 0.330 nm
Molecular cross-sectional area: 0162 m:

Adsorbate molecular weight: 28.01

2491- Highlighted fields contain errors. Please correct the errors bef

Physical Adsorption

Adsorptive Properties

Chemical Adsorption

Field or Button

Description

Adsorbate molecular
weight [text box]

The molecular mass is used for the weight % column of the isotherm
tabular report and for the pressure composition isotherm plot.

Adsorbed-phase free-
space correction

Adsorbed molecules occupy volume in the sample tube, reducing the
analysis free space. Select Adsorbed-phase free space correction to

[check box] ﬂ adjust the reported quantity adsorbed to correct for this effect. This
option is appropriate for all sample analyses that use the real gas equa-
tion of state.

Adsorptive [text box] Name of the adsorptive gas whose properties are being defined.

Density Conversion
Factor [text box] [

Factor determined by obtaining the ratio of the gas density (STP) to
the liquid volume. This field is disabled if Non-condensing Adsorptive is
selected.

4-2
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Adsorptive Properties

Adsorptive Properties (continued)

Field or Button

Description

Dosing Method
[group box] [d

Normal. Dose from a pressurized tank of gas attached to a gas inlet
port.

From Psat tube. Select if the Psat tube is to be filled with condensed
adsorptive and dosed from the Psat tube. Select this option if using
krypton.

High-resolution fluid
properties [selection] ﬂ

Use to import parameters from a Fluid Properties (.FPI) file. Changing
fluid properties should only be necessary if an adsorptive is to be used
for which no adsorptive properties are provided. Contact Micromeritics
Scientific Services if new fluid properties are required. See Contact
Us on pageiii.

Ideal gas law with non-
ideality correction

[selection] |

Use if there is no compressibility table for the gas being used or if you
want to match existing data. This factor adjusts the ideal gas law for cal-
culating the quantity of gas in the cold free space. Most gases are
nearly ideal near room temperature and at pressures not much above
atmospheric pressure, so the cold free space is where the correction is
most important. If selected, enter the non-ideality factor field.

Maximum manifold
pressure [text box]

The highest pressure to which the manifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925 mmHg. Low pres-
sure sources will require lower numbers. For gases to be used for dos-
ing after charging a tube from a gas inlet, enter the maximum pressure
for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box]

Enter the mnemonic name for the adsorptive. If this gas is connected
to a gas inlet port, this mnemonic must be entered in the Unit Con-
figuration Gas Selection for the inlet port. See Unit Configuration
on page 2- 15

Molecular cross-sec-
tional area [text box]

The area that a single adsorbed molecule occupies on the surface of
the sample. It is used in surface area calculations.

Non-condensing
Adsorptive [check box]

Select if using a non-condensing analysis gas. When selected, the
Density conversion factor field and the PSAT vs T button are dis-
abled.

Non-ideality factor

[text box] [

Compensates for the forces of attraction between molecules in a real
gas. This value is used for a calculated free space.

Psat vs T [button] [

Click to edit the Psat vs Temperature table. The table contains sat-
uration pressures and their corresponding temperatures. To edit, click
in a field and enter the value.
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4 Parameter Files [M] micromeritics’

Adsorptive Properties (continued)

Field or Button Description

Therm. tran. hard- An estimate of molecular size used in calculating the thermal
sphere diameter transpiration correction.

[text box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’

Analysis Conditions

ANALYSIS CONDITIONS

File > Open > [LANC File]

(or click the Analysis Conditions tab when in Advanced option presentation)

Analysis conditions specify the parameters used to guide an analysis.

[E=N[E=R("=") [E== =R
sample Degas Analysis Report Sample Degas Analysis Report
Desaription Conditions Conditions Options Description Conditions Conditions Options
Analysis Conitions: ‘ Run Conditions ~ ‘ Analysis Conditions: | Run Conditions “ ‘
Adsorptive: | Nitr 77.35K ~ Edit...
borptve: | Nivogen @ | ! Adsorptive: | *No Selection = <] Edit...
Upto Add aPoint Every
Pre-analysis evacuation time: .50 | h
Reative | Relatve "
Pressure Pressure InsertRange.
) (%) o o Add aPoint Every
Absolute Absolute Insert Range...
1 | 0.000000001
4‘ TrEeh Pressure Pressure
(wa) (kPa)
1 | o.0000001 Fnsert
Clear
Delete
Append
Clear
Append
[ absolte pressure dosing i
Preparation. . Free Space.. peandT.
Equiibration Interval: 5
Dosing... Equilibration... Backfil...
Preparation... || FreeSpace... | | Temperature... Dosing. . Termination...
Repeat analysis
Evacuation time: h
Save As Close Advanced v Save As Close Adwanced v Previe

Analysis Conditions

Field or Button

Description

Absolute pressure dos-

Specifies pressure targets in mmHg, mbar, or kPa instead of relative

[drop-down box]
erties.

See Adsorptive Properties on page 4 - 2.

ing [check box] [d pressure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.
Adsorptive Select an Adsorptive Properties file from the list of defined gases to be

used for analysis. After selection, click Edit to modify adsorptive prop-
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4 Parameter Files

[M] micromeritics’

Analysis Conditions (continued)

(=85l 5T
Adsorptive: -
—
=8 EEN T
[] Non-condensing Adsorptive
Dosing Method Aadsorptive: -

Maximum manifold pressure: 123.323 kPa ,
T — . lomal Mnemoric:

erm. tran. hard-sphere diameter: 0.3860 rm ) From Psat tube .
Molecuiar cross-sectional area: 0.162 rm2 TG TS 52500 ol

=y Therm. tran. hard-sphere diameter: 0.3880 nm
Adsorbate molecular weight: 28.01 VerrierE &
Molecular cross-sectional area: 0.162 mm?
() High-resolution fiuid properties
Adsarbate molecular weight: 2.01
Adsorbed-phase free-space correction
Open... Save...

@ Ideal gas law with non-deality correction

Non-ideality factor: 0.0000520

Density conversion factor:  0.0015488 2491- Highlighted fields contain errors. Please correct the errors befi

[drop-down box]

Analysis Conditions

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Backfill [button] |3

lysis.

Select gas for backfilling the sample tube at the start and end of an ana-

E=5Ecl 5

Backfil Gas: |M2

Backfill sample at start of analysis

Backfill sample at end of analysis

Cancel

-

Analyzing.

The options are disabled if the file status is Entered, Complete, or

4-6
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[M] micromeritics’

Analysis Conditions

Analysis Conditions (continued)

Field or Button

Description

Dosing [button]

Options for dosing tolerance, low pressure dosing, and dosing near
saturation pressure.

= o ]

Absolute pressure tolerance: 0.5666 kPa

Relative pressure tolerance: 5.0 %
[ Low pressure incremental dose mode

0,044

10

Enter a value between 0.0000 and 101.3250.

0K Cancel

oK Cancel

Physical Adsorption Chemical Adsorption

Absolute / Relative pressure tolerance. Values used to determine
how close the actual pressure must be to each target pressure from
the pressure table. At lower pressures, the relative tolerance value is
lower. At higher pressures, the absolute tolerance value is lower. For
example:

Experiment 1. There might be an absolute tolerance of

5 mmHg, a relative tolerance of 5%, and a target pressure of
40 mmHg; 5% of 40 mmHg is 2 mmHg. Since 2 mmHg
(relative tolerance) is lower than 5 mmHg (absolute tolerance),
2 mmHg is used. Therefore a minimum pressure of 38 mmHg
(40 - 2) must be attained to collect data for a target pressure of
40 mmHg.

Experiment 2. There might be an absolute tolerance of 5
mmHg, a relative tolerance of 5%, and a target pressure of
200 mmHg; 5% of 200 mmHg is 10 mmHg. Since 5 mmHg
(absolute tolerance) is lower than 10 mmHg (relative
tolerance), 5 mmHg is used. Therefore a minimum pressure of
195 mmHg (200 - 5) must be attained to collect data for a
target pressure of 200 mmHg.

Normally, surface area measurement points are widely
spaced and the resulting measurement is not very sensitive to
the precise location of points so wider tolerances may be used.
Unnecessarily tight tolerances lengthen the analysis.

First pressure fixed dose. ﬁ
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4 Parameter Files

[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

This option is most frequently used when performing a
standard nitrogen analysis of mesoporous materials such as
catalysts. If the first pressure table point is low and the gas
uptake of the sample is expected to be high, this option can
shorten the time required to reach the first point on the
pressure table.

The sample is dosed repeatedly at low pressures with a
specified amount of gas until the first pressure point is
reached. This initial dosing quickly meets the adsorptive
demand of the sample.

The first point on the pressure table is the threshold value,
triggering the transition from the Fixed Dose Mode to Pressure
Table Mode. When the first pressure table value is reached,
Fixed Dose Mode is disabled, and points are equilibrated and
recorded in accordance with the specified pressure table.

Enter the amount of gas to be added to the sample for each
dose cycle.

Maximum volume increment. ﬂ Select to determine when
additional data points are collected between target pressures in
regions of adsorption. When the maximum increment has been

adsorbed since the last collected data point, another point is
equilibrated and collected. During desorption, this field is treated as a
maximum volume decrement value.

Equilibration [button] [

Provides options to specify the equilibration interval and delay time.

=R 5
Relative Equilibration
ressu Interval (s)
() [ meert |
1 1.000000000| 5 o
Clear
= Column heading reads
Absolute Pressure (mmHg)
when Absolute Pressure
Minimum equilibration 5 g
delay st pip® >~ 0.995: Dosing is selected.
600 s
Enter a relative pressure from 0 to 1
OK Cancel

Minimum equilibration delay at p/po > = 0.995. The minimum
number of seconds required before equilibration can occur for a

4-8
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[M] micromeritics’

Analysis Conditions

Analysis Conditions (continued)

Field or Button

Description

relative pressure greater than or equal to 0.995. This field is not
available if Absolute pressure dosing is selected on the Analysis
Conditions tab.

Relative Pressure (p/p°®) or Absolute Pressure. The pressure the
equilibration interval will be applied.

Equilibration interval

The number of seconds between successive pressure readings during

(continued)

[text box] [& equilibration. Long equilibration intervals tend to lengthen analyses,
however, they do improve data integrity. Short equilibration intervals
produce a faster analysis but may reduce the accuracy of data.

Free Space [button] How the free space is to be measured.

=1 e

@ Measure EI@

Lower dewar for evacuation

E— W h @ Measure after analysis

[[] outgas test

= Estimated analysis free space: 20.0000 cm?
e — _J Enter
) Caleulate
x| Concal |
T Cancel
Physical Chemical
Adsorption Adsorption
Free Space [3]| Measure

« Lower dewar for evacuation. If the dewar is to be lowered for
evacuation, select this option and enter the length of time for evac-
uation after the free space measurement in the Evacuation time
field. If using a cryostat, the operator must manually move the cryo-
stat assembly when prompted.

« Evacuation time. The length of evacuation time prior to free space
measurement.

« Outgas test. Checks for system leaks or sample outgassing. After
free space is measured, the dewar is lowered and the sample evac-
uated for the specified amount of time. The leak test is performed
after evacuation. If the pressure rises more than 0.025 mmHg
within the time specified in the Outgas test duration field, outgassing
is present. If a leak is found, the leak test repeats nine times, with 30
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4 Parameter Files

[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

minutes evacuation between tests. If the 10th leak check fails, the
analysis stops and the operator is notified. While leak testing slightly
increases analysis time, it prevents the continuation of analysis and
collection of erroneous data if a leak occurs.

Enter. Allows manual entry of free space.

Calculate. Use to have the free space measurement calculated using
the sample and tube parameters.

Free Space [¢
(continued)

Enter. Allows manual entry of free space.

Measure after analysis. Measures free space after analysis ends.
Enter the estimated free space measurements.

p° and Temperature
Options [button] [

How the saturation pressure (P()) is to be measured or calculated and
the analysis bath temperature.

[ s and Termperature Optians =)= =]

Po Options
() Measure Pa in the Pa tube For eath isotherm point.
() Measure Po at intervals during analysis.
120

7 Measure Psat of the gas specified below. Caleulate Po of the
adsarptive From the measured Psat.

Hitrogen

Psatvs. T...

() Caleulate Pa from the analysis temperature.
@ Enter Po.

Pao: 760,000 mmHg

Analysis Temperature Options
@ Enter the analysis temperaturs.
Analysis bemperaturs:  77.300 K
(©) Caleulate the analysis kemperature From Po or Psat.

760,000

p° Options. Select one option indicating how Py, is to be measured or
calculated.

/

Analysis Temperature Options. Select an option to enter analysis
temperature manually, or choose to have it automatically calculated

If using a cryostat, select either the Calculate p, or
Entered py option. Also enter an analysis temperature.
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[M] micromeritics’

Analysis Conditions

Analysis Conditions (continued)

Field or Button

Description

from p°® or Pj. An estimated P can be entered if a measured P option
is selected.

Psat Gas. If choosing to measure the P for each isotherm point using
a gas other than the adsorptive, select the P gas from the drop-down
list, then click Edit to modify the P adsorptive properties. Refer to the
Adsorptive drop-down list earlier in this table for details on editing this
window.

Pre-analysis evacuation
time [text box] [«

Evacuation is required prior to analysis. The default setting is 30
minutes.

Preparation. Use to set the evacuation rate, unrestricted pressure,
and setpoint.

Temperature. Use to set the temperature and ramp rate.

Preparation [button]

Evacuation rate / time / level, leak test and time values, elevator
prompts, and in situ degassing or activation.

(3 Preparation Options | = [Ee |
Backfil gas: | No Selection * -
s iation Unrestricted evac. from:  0.67 kPa
(1 Preparation Opt =R [EER == P Evacuatontme: 0,10 h
[ Fast evacual ttion
Time: re
) (Kmin) (min)  (Pa)
Unrestricted evac. from:  0.67 kPa EVAC He 3231 10.0 60 Insert.

FLOWH2 3231 100 60 -
Vacuum setpoint: 13 pa EVAC He 3231 10.0 50 =
Coacuston fine o hours SOAK HZ 3231 100 60 0.0 =
vacuation time: LEAK 3731 10.0

Leak test
L=
120

[] Use TranSeal

Step Detail

Leak Test

Qutgas rate limit: 5.3e-004 kPa/min
Cancel

cone

Evacuation time. The length of time for preliminary evacuation.

Fast evacuation. Select for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation is
not selected.
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4 Parameter Files

[M] micromeritics®

Analysis Conditions (continued)

Field or Button

Description

Preparation [g]
(continued)

Leak test. Enables the system to check for leaks or sample
outgassing before the analysis. The leak test allows sample pressure
to rise during the test. If the pressure rises more than 0.15 mmHg, the
analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Use TranSeal. Select if using the TranSeal to transfer the sample
from the preparation port to the analysis port under vacuum.

Vacuum setpoint. The vacuum level to be achieved before timed
evacuation begins.

Preparation [&
(continued)

Backfill gas. Lists the available backfill gases.
Vacuum level. The pressure for unrestricted evacuation.

In situ activation. When selected, preparation steps will be done. If
not selected, the task table is disabled and analysis starts after the
preliminary evacuation.

See Chemical Adsorption Tasks on page 4 - 14 for
information on inserting tasks for a chemical adsorption
analysis.

Repeat analysis

Pressure at which heating will stop and hold the sample temperature

[check box] [g approximately constant until the pressure falls below the Hold pres-
sure. This feature prevents damage to the sample structure due to
'steaming’, as well as sample elutriation due to excessive escaping gas
velocity.
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[M] micromeritics’

Analysis Conditions

Analysis Conditions (continued)

Field or Button

Description

Temperature [text box]

Provides access to furnace and accessory temperature control.

[ -=- sl
Analysis temperature: 323.1 K
Temperature rate: 10,0 Kjfmin
Enter a value between 731 and 1,373.2.

Analysis temperature. Enter the analysis temperature.

Temperature rate. Enter the analysis temperature rate.

Termination [button] [

Backfill options after analysis.

[E=R[E=R">=
Backfill after analysis
[ Cool to less than 50 =C

Select the backfill gas if backfill is to be done after the analysis.

Cool to less than 50 °C. Select to enable the cool down option.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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4 Parameter Files Ei micl‘omer‘itiGS“

CHEMICAL ADSORPTION TASKS

File > Open > [.SMP File] > Analysis Conditions tab > Preparation > Insert

(33 Preparation Opticns [= ===

Backfil gas: [ No Selection * -

[T Fast Evacuation Unrestricted evac. from:  0.67 kPa

Vacuum level: 6.7 Pa Evacuation time: 0,10 h

[#]1n situ activation
Task Gas Temp. Rate Time Pressure
®

(Kfmin) (min)  (kPa)

EVAC He 3231 10.0 60 —
FLOW H2 3231 10,0 60
EVAC He 3231 10.0 &0
SOAK H2 323.1 10.0 60 0.0
LEAK. 323.1 10.0
Step Detail
Leak Test
Qutgas rate limit: 5.3e-004 kPa/min

To ensure safe operation and reliable results, an evacuation task should be included:
» between tasks using different gases

« preceding a leak test

An evacuation will be performed at the analysis temperature for the Pre-analysis Evacuation Time
after the last task and before analysis.

Chemical Adsorption Tasks

Task Description

Evacu atio n [se/ectlon] Evacuation Task Options
Gas: [Helium -
Evacuate for 60 min below 6.7 Pa
D Fast Evacuation

Unrestricted evac. pressure:  0.67 kPa
Temperature: 323.1 K

Temperature rate: 10.0  Kfmin

Evacuate for [n] below [n]. The minutes and pressure for
preliminary evacuation.

Evacuation rate. The rate for restricted evacuation.
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Ei m icromeritics“ Chemical Adsorption Tasks

Chemical Adsorption Tasks (continued)

Task

Description

Fast Evacuation. Select for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Gas. Gas used for the evacuation task.
Temperature. The temperature to reach during evacuation.
Temperature rate. Enter the analysis temperature rate.

Unrestricted evac. pressure. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation is
not selected.

Flow [selection]

r
Flow Task

Gas: [Hydrogen - ]
Flow Rate: 50.0  cm3 STP/min
Time: 60 min
Temperature: 50,0 =C
Temperature rate: 10.0 =C/min

|| []5et external trigger |

Flow Rate.The rate at which gas is to flow.
Gas. Gas used for the flow task.

Set external trigger. If selected, the contact closure used to trigger
an external Mass Spectrometer or Calorimeter will be activated. If
deselected, the contact closure will be deselected.

Temperature. The temperature at which the gas will flow for the
specified time.

Temperature rate. Enter the analysis temperature rate.

Time. The duration of time the sample should remain at the specified
temperature.
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4 Parameter Files

[M] micromeritics’

Chemical Adsorption Tasks (continued)

Task Description
Leak Test f Leak Test Task
[selection]

Outgas rate limit: 5.3e-04 kPajmin

Temperature: 50,0 =C
Temperature rate: 10,0 °C/fmin

| Enter a value between 1.3e-07 and 1.3e-02,

Outgas rate limit. If a measured leak or outgas rate exceeds the
entered value, the test will be reported as failed. Analysis will not be
canceled.

Temperature. The target temperature for the leak test.

Temperature rate. Enter the analysis temperature rate.

Soak [selection]

— |

Gas: [Hydrogen - ]

Minimum pressure: 0.0 kPa
Time: 60 min

Temperature: 323.1 K

Temperature rate: 10,0 Kjfmin

Gas. Gas used during the soak task.

Minimum pressure. The minimum pressure to be maintained over
the sample during the soak.

Temperature. The temperature at which sample is to be soaked.
Temperature rate. Enter the analysis temperature rate.

Time. The duration of time the sample is to soak at the specified
temperature.
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EVACUATION RULES FOR CHEMICAL ADSORPTION

Evacuation parameters apply to all four stages of evacuation with the exception of evacuation time.
Evacuation time is set using the fields specified in the following evacuation rules.

When an analysis starts, evacuation begins:

1. atambient temperature before the first preparation step. This step uses the Evacuation time
field on the Preparation Options window.

2. atanalysis temperature after preparation and prior to the start of the analysis stage. This step
uses the Pre-analysis evacuation time field on the Analysis Conditions window.

3. atanalysis temperature before the repeat analysis if Repeat analysis is selected on the Ana-
lysis Conditions window. This step uses the Repeat Analysis / Evacuation time field.

4. atanalysis temperature before the free space measurement if Measure after analysis is selec-
ted on the Free Space Options window. This step evacuates for 90 minutes.
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4 Parameter Files

[M] micromeritics®

DEGAS CONDITIONS

File > Open > [.DEG File]

(or click the Degas Conditions tab when in Advanced option presentation)

Degassing is a required step in preparation for an analysis. The Degas Conditions tab provides
settings that will be automatically applied during the degassing procedure.

[E=NEER
Degas Conditions: Degas Conditions -
Evacuation Phase Heating Phase
Temperature ramp rate: 10.0 Kfmin Ramp rate: 10.0 Kjmin
Target temperature: 03 K Hold temp: 303 K
Evacuation rate: 0.67 kPafs Hold time: 10 min
Unrestricted evac. from: 0.67 kPa
Vacuum level: 1.3 Pa Evacuation and Heating Phases
Evacuation time: 10 min Hold pressure: 13.3 kPa
/| Badifill sample tube
Close
Degas Conditions
i Description
Field or Button escriptio

[check box]

Backfill sample tube

Indicate if the sample tube should be backfilled automatically or wait
for operator response.

Degas Conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Evacuation and Heating
Phases [group box]

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample struc-
ture due to 'steaming' and /or elutriation due to excessive escaping gas
velocity.

[group box]

Evacuation Phase

Options provide conditions for the evacuation phase of the degassing
operation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Target temperature. Targeted temperature for evacuation.
Evacuation Rate. Rate used for evacuation.

Unrestricted evac. from. Pressure at which the unrestricted
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[M] micromeritics’ Degas Condtions

Degas Conditions (continued)

Field or Button Description

evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Heating Phase Options provide conditions for the heating phase while degassing.

[group box] . . )
Ramp rate. The rate at which the temperature will change while

advancing to the hold temperature.

Hold temp. Temperature at which the sample is to be held while
degassing.

Hold time. How long the sample is to be held at the specified
temperature before beginning to cool down.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



4 Parameter Files Ei micl‘omeriticsn

REPORT OPTIONS

File > Open > [.RPO File]

(or click the Report Options tab when in Advanced option presentation)

]EW\ See also:
Es ~.I\I

=y
—_—1

o About Reports on page 7 - 1
o Selected Reports on page 8 - 1

Log in to your customer portal to access MicroActive Report Tutorials and the Calculations
document.

Additional reports are available using the Reports menu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Optionsfiles also help in customizing report details such as axis scale, axis range, column headings,
and components of thickness curve equations. These files may contain tabular reports, plots, or
both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of up
to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a different
plot type from the same analysis. See Graph and Sample Overlays on page 7 - 26.
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[Mi micromeritics® Report Options

[E= EER =) [E=8 R =

Report Options: Report Options

Show report title
Show graphic Graphic

- Report Options: Report Options -

Show report title
Show graphic Graphic

miclogo.emf miclogo,emf m}
Height: 0,250 in Width: 2,000 in Height:  0.250 in Width: 2,000 in
Selected Reports: Selected Reports:
Isotherm
[]Summary - I}
l Overlays... ] l Edit... ] [ Isotherm Overlays... I l Edit... ] [ Difference Method
[Flser []Sinfelt Method
[ apply thermal transpiration correction [CLangmuir []Langmuir
[FFreundich H []Freundiich
[ Temkin [ Temkin
9.53 [tPlat [] Advanced Rpt.
[ Alpha-5 Method [Cloptions
[ f-Ratio Method [CIsample Log
[C]BIH Adsorption
[]8IH Desorption
["]Dolimore-Heal Adsorption
[Coollimore-Heal Desarption =

Enter a value between 0.100 and 7.500.

Enter a value between 0.100 and 7.500.

Physical Adsorption Chemical Adsorption
Report Options
Field or Button Description
Apply thermal tran- Use to correct the temperature-induced pressure difference between
spiration correction the manifold and the chilled sample tube. This option is most sig-
[check box] P nificant for pressures less t_haq approximately 1 0 mm_Hg.
Always use thermal transpiration when performing micropore
analyses.
Inside diameter of sample tube. Enabled when Apply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.
See the Thermal Transpiration Correction section of the Calculations
document. Log in to your customer portal to access the Calculations
document.
Overlays [button] See Graph and Sample Overlays on page 7 - 26.
Report Options Browse for a .RPO file that contains report options parameters to be
[drop-down box] used in the report.
Selected Reports Select the report names to include in the report.
[group box]
Show graphic [check box] | Use to show a graphic on the report header.
Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

MicroActive ASAP 2020 Operator Manual

202-42804-01 (Rev-) — Feb

2019 4-21



http://www.micromeritics.com/Customer-Login.aspx

4 Parameter Files [M] micromeritics’

Report Options (continued)

Field or Button Description
Show report title Select and enter a report title to appear on the report header.
[check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’

Sample Tube for Physisorption

SAMPLE TUBE FOR PHYSISORPTION

File > Open > [.STB File]

(or click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced

option presentation)

Sample Tube files specify information about the sample tube.

[E=N EoH T

Sample tube:

Empty Tube Properties
(for calculated free space)

Warm free space: 10000  cm?

Cold free space: 1.0000  cm?

MNon-ideality factor:

Load From Sample File...

0,0000620

Enter a value between 0.0000 and 9,999.0000.

[ Use isothermal jacket
[] Use filler rod
Vacuum seal type

@ None

_ Seal Frit

) TranSeal

-

Sample Tube
Field or Button Description

Cold free space
[text box]

Empty sample tube gas capacity measured with the dewar raised.

Load from Sample File
[button]

Loads parameters from the selected sample file.

Non-ideality factor
[text box]

Compensates for the forces of attraction between molecules in a real
gas. This value is used for a calculated free space.

Sample tube
[drop-down box]

Itis a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod
[check box]

Selectif afiller rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 square meters of total surface area.

MicroActive ASAP 2020 Operator Manual

4-23

202-42804-01 (Rev-) — Feb 2019




4 Parameter Files [M] micromeritics’

Sample Tube (continued)

Field or Button Description

Use isothermal jacket | Selectif anisothermal jacket is to be used. An isothermal jacket main-

[check box] tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type Select the seal type to be used.

[group box]

Warm free space Empty sample tube gas capacity measured at room temperature.

[text box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics’

5 Degassing

5 DEGASSING

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. The

sample must be clean when an analysis is performed. The degas process heats the sample to

remove the moisture and contaminants.

START DEGAS

Unit [n] > Start Degas

Automatic Degas

1 Sample Browse...

Degas Conditions Clear

2 Sample Browse...

Degas Conditions Clear

g

Cancel

Select the file for each degas port to be used, then load the sample into the sample tube and install
the sample tube on the degas port. Allow the sample to cool before transferring to the analysis port to

start the analysis.
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TRANSFER A DEGASSED PHYSICAL ADSORPTION SAMPLE TO AN
ANALYSIS PORT

]_:g{r_\_ See also:
.FE: ‘-I |

T ‘_rfﬂj Worksheets on page K - 1

The sample tube must be removed from the degas port, weighed, and then installed onto the
analysis port for analysis.

degas port. If it is necessary to remove the sample tube and a Seal Frit was not used,

/ If the sample tube will not be mounted on the analysis portimmediately, leave it on the
insert a rubber stopper into the sample tube.

Rubber Port fitting
stopper
Seal frit
s / (optional) \
Po tube W g
\ L O-ring

Po tube isothermal et

jacket \ L‘é
Connector nut
Insulated dewar cover ‘i

Ferrule

Sample tube
isothermal jacket Assembled

/

Sample tube

1. Allow the sample tube to cool.

Do not touch the sample tube or the heating mantle until they have reached room tem-
perature. Touching the sample tube, heating mantle, or heating mantle clip before they
have cooled could result in burns.

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube.

3. Hold the sample tube, loosen the port connector nut, and remove the sample tube from the
degas port.

4. Remove the connector nut, ferrule, and O-ring from sample tube stem.
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Transfer a Degassed Physical Adsorption Sample to an

Ei m icr'(n“'ler'iticﬁiHJ Analysis Port

5. Weigh the sample tube set. Use the Sample Data Worksheet to determine the sample mass.

6. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube
bulb.

7. Place the connector nut, ferrule, and O-ring onto the sample tube stem.

8. Remove the stopper and immediately attach the sample tube to the analysis port, pushing it
fully up into the port. Secure it in place by screwing the connector nut onto the analysis port
connector; hand tighten the connector nut. If a Seal Frit was used, it does not have to be
removed.

9. Place the dewar cover over the sample tube stem just above the isothermal jacket.
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5 Degassing

TRANSFER A DEGASSED CHEMICAL ADSORPTION SAMPLE TO AN
ANALYSIS PORT

_ Iso:
;:Eﬁ.\ See also
__-'°_r_::®' Worksheets on page K - 1

degas port. If it is necessary to remove the sample tube and a Seal Frit was not used,

/ If the sample tube will not be mounted on the analysis portimmediately, leave it on the
insert a rubber stopper into the sample tube.

O-ring

Port filter
Ferrule

\ )
é / Exhaust
Sample nut \ e filter
g / Exhaust

—_

Ferrule

E———_| Quartz sample

tube

f 0o oo

0

Quartz filler A
rod o

Thermocouple

clip —
@
/

1. Allow the sample tube to cool to room temperature (approximately 15 minutes).

Wool quartz

Do not touch the sample tube or the heating mantle until they have reached room tem-
perature. Touching the sample tube, heating mantle, or heating mantle clip before they

have cooled could result in burns.

5.4 MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019



Ei micromeritics“ Enable Manual Control of Degas Ports

8.
9.
10.
11.
12.
13.

While holding the sample tube, loosen the port connector nut and remove the sample tube
from the degas port. Immediately insert a rubber stopper into the sample tube.

Remove the connector nut, ferrule, and O-ring from sample tube stem.
Weigh the sample tube set. Use the Sample Data Worksheet to determine the sample mass.

Slide an isothermal jacket down over the sample tube stem until it touches the sample tube
bulb.

Place the connector nut, ferrule, and O-ring onto the sample tube stem.

Remove the stopper and immediately attach the sample tube to the analysis port, pushing it
fully up into the port. Secure it in place by screwing the connector nut onto the analysis port
connector. Hand tighten the connector nut.

Insert the temperature thermocouple in to the clip on the sample tube.

Place the dewar cover over the sample tube stem just above the isothermal jacket.
Place the furnace onto the elevator.

Slide the insulator dewar cover onto the sample tube.

Open the instrument schematic and raise the elevator.

Ensure the insulating dewar cover remains properly seated on the top of the furnace.

ENABLE MANUAL CONTROL OF DEGAS PORTS

Unit [n] > Degas > Enable Manual Control

Unit [n] > Degas > Show Degas Schematic

See also:

See Show Degas Schematic on page 5 -7

Use to enable the manual control of degas ports.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



5 Degassing

[M] micromeritics®

SHow DEGAS STATUS

Unit [n] > Degas > Show Status

Use to show the current status for each port.

? Degas Status

Sample:
Status:  Idle

= e

Sample:
Status:  Idle

Show Degas Status

Field or Button

Description

Cancel [button]

Discards any changes or cancels the current process.

Check [button]

Click to check the outgassing rate of the sample on the selected port.
The following actions occur:

« The current degassing step is suspended (on both ports). Degass-
ing can be checked after the vacuum setpoint has been attained, or
during a temperature ramp and hold. If using this option during any
other step, a message indicating the SmartVac Prep is not in a valid
state is displayed.

« The vacuum valves are closed and the vacuum level monitored.

« The Status window is displayed (if not already displayed). The
Status window will indicate that the degassing operation is being
checked and will display the outgassing rate as it becomes avalil-
able.

During the degas check, the Check button changes to Continue.
When Continue is clicked, the valves open, the temperature ramp or
hold continues, and the degassing operation resumes. If the
outgassing rate indicated that contaminants have been removed from
the sample (minimal pressure increase), click Skip to advance to the
next state of the degassing operation. For example, if degassing is
checked degassing after the setpoint is attained, Skip advances the
process to the ramping stage.

Sample

The sample file being used with the degassing operation for each port.

Skip [button]

Skips the current stage of the degassing operation for the selected
port.

Status

The current stage of the degassing operation for each port.

5-6

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019



Ei micromeritics“ Show Degas Schematic

SHow DEGAS SCHEMATIC

Unit [n] > Degas > Show Degas Schematic

Use to display the degas schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Degas > Enable Manual Control).

D5

v E : i
acuum T

D¥

Backfill me(])

Current = 500 *C Current = 500 *C

Analyzer Schematic Icons

Icon or Symbol

Description

¢

Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve.

Servo Valve. Closed.

Servo Valve. Open.

Elevator.

S
-
i

Sample Tube. Cannot be manually controlled.
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Degas Schematic Components

Schematic Description
Components

D1 and D2 Sample port valves
D5 Vacuum valve

D6 Servo isolation valve
D7 Gasinlet port valve

SCHEMATIC SHORTCUT MENUS

Each manually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover the mouse pointer over
the component icon and right click.

Schematic Shortcuts

Schematic Shortcut
Icon

Available Options:

Valve options

Open. Opens the selected valve.

Close. Closes the selected valve.

Temperature control
options

{

Disable. Disables the temperature control.

Set. Select to set the ramp rate and target temperature.

5-8
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6 PERFORM AN ANALYSIS

If using a cryostat for analysis, see CryoStat on page D - 1 prior to use.

DEWAR PRECAUTIONS

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to burst.

When handling dewars containing liquefied gases or cryogenic liquids:

« Wear protective equipment:

o goggles or face shield
o aninsulated or rubber apron
o insulated gloves

« When pouring liquefied gases from one container to another:

o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o ventthe receiving container to the atmosphere

FOR GLASS DEWARS

» Use aplastic stirring rod when stirring substances in a dewar containing liquefied gases (or other
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a
protective coating.

« Do not handle heavy objects above the dewar. If unavoidable, place a protective cover over the
dewar opening. If an object of sufficient weight is accidentally dropped into the dewar, shattering
may occur.

« Ifthe dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of fly-
ing particles should the dewar be knocked over, dropped, or broken.
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CHECK THE CRYOGEN LEVEL

If performing an analysis that requires use of the cold trap and cryogen, check the cryogen level in
the dewar. It should be about 25 mm (1 in.) from the top.

The cryogen must not be cold enough to trap the carrier gas or analysis gas. Do not use
/ liquid nitrogen with argon carrier gas. For example, use an alcohol and liquid nitrogen
slurry (-80 °C).

A Use appropriate safety procedures when handling all cryogens. Be sure to wear safety
glasses and gloves, and observe the precautions listed earlier.
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PREPARE FOR ANALYSIS

The steps in this topic properly prepare the equipment for an analysis. It is recommended to perform
the tasks in the provided order.

= N
$ See also:
i1

— o Dewar Precautions on page 6 - 1
o Select a Sample Tube on the next page
o Step1-Clean and Label Sample Tubes on page 6 - 5
o Step2- Create the Sample File on page 6 - 7
o Step 3 - Determine the Sample Mass on page 6 - 8
» Step4 - Degas the Sample on page 6 - 13
o Step5- Sample Tube Installation on page 6 - 16
» Step 6 - Fill and Install the Dewar on page 6 - 19
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SELECT A SAMPLE TUBE

A sample tube set consists of:

o Sample tube
« Stopper or Seal Frit
o Filler rod

Standard sample tubes for the analyzer have a 1.27 cm (1/2 in.) outside diameter (OD). Stepped
ferrules, smaller O-rings, isothermal jackets, and filler rods are available for adapting the smaller
stems to the degas or analysis ports. The stem diameter selected for use is a matter of accuracy and
precision requirements, as well as personal preference and convenience in loading the sample.

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended for
1.27 cm (1/2in.) OD sample tubes.

Filler rods help to ensure accuracy in samples with lower total surface areas by reducing the free
space volume. Itis generally a good practice to use filler rods for samples having less than 100
square meters of total surface area. Filler rods are unnecessary for samples with total surface areas
greater than 100 square meters.

/ Filler rods can interfere with thermal transpiration correction and, therefore, should not
be used when performing micropore analyses.

The weight of the empty sample tube should be determined after it has been cleaned, degassed, and
filled with backfill gas. The sample tube should be allowed to cool to room temperature before
backfilling. After the sample tube has cooled, remove it from the degas port and weigh it.

/ If a Seal Frit is not used, insert a stopper immediately after removing the sample from
the degas port.

The mass of the isothermal jacket may vary slightly and cannot be considered as constant; therefore,
do not weigh it with the sample tube set.
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CLEAN AND LABEL SAMPLE TUBES

/ The equipment images in this topic may differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are supplied by Micromeritics and which are supplied by the
user. The procedures following the materials table are recommended.

Supplied by Micromeritics Supplied by User
« Fillerrod « Acetone orisopropyl alcohol
o Funnel « Analytical balance
« Sample data worksheet « Cryogen for cold trap dewar
o Sample tube « Detergent (such as Alconox)
« Sample tube brush « Dryingoven
« Sample tube rack « Forceps
« Sample weighing support (required for chem- | « Insulated gloves
ical adsorption sample tubes) « Pipecleaners
« Stopper for sample tube « Rubber gloves or lint-free cloth
« Safety glasses
« Ultrasonic cleaning unit
« Waste container

1. Preheatdrying ovento 110 °C.

2. Verify that the ultrasonic cleaning unit is clean.

3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the
ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fillthe sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.
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5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.

7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl
alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the
rack. Bake in a vacuum oven for two hours at 110 °C.

/ Samples tubes can also be cleaned with high purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

/ Do not insert the filler rods at this time. Filler rods are inserted before the sample tube is
installed on the analysis port.
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10. Blow out the sample tubes with oil-free compressed air.

11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry
with a clean, lint-free cloth.

12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper.

CREATE THE SAMPLE FILE

;;Qh See:

__'T'{r_’c:@' Create Sample Files on page 3 - 2
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DETERMINE THE SAMPLE MASS

See also:

Sample Data Worksheet for Gas Adsorption on page K - 2

PHYSICAL ADSORPTION

Clean, dry sample tubes are essential for accurate results. How much sample to use can be
determined best by experiment. In general, a sample providing 40 to 120 square meters of total
surface area is recommended for nitrogen analysis. Less than 40 square meters may cause
unreliable results. More than 120 square meters will extend analysis time.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total weight. Proper weighing techniques are most important in this case. Use no less than 100 mg to
reduce the effect of weighing errors.

Care should be taken when loading powders — the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is important
to know the true sample mass.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true sample
mass.

1. Record the sample tube identification on the Sample Data Worksheet.

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at
zero (0).

3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing
support and place it on the balance.

4. Record the stabilized mass on the Sample Data Worksheet . Remove the sample tube set
from the balance.

/ Do not touch the sample with bare hands while performing the following steps. Doing so
could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero (0).
6. Slowly pour the specified amount of sample into the sample container.
7. Remove either the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.

MicroActive ASAP 2020 Operator Manual

6-8 202-42804-01 (Rev -) — Feb 2019



Ei micromeritics“ Determine the Sample Mass

8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the
weighing container into the sample tube.

. / Funnel

Straw
TIP:
Use a drinking straw tube
(approx 6mm [1/4 in ]
/ Sample tube diameter) that fits inside the
sample tube to keep the
P inside wall of the sample
WEIthg tube clean.
support \

Balance

9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. Onthe Sample Data Worksheet, record the following:
a. Mass of the sample tube set with the sample.

b. Subtract the Mass of empty sample tube set from the Mass of sample tube set plus
sample.
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CHEMICAL ADSORPTION

;?EE% See also:
1

,__5_?_%' Use Quartz Filter Discs for Chemical Adsorption on the facing page

Bulb sample tubes are for pellets and other samples without loose particles. Using
powder samples in bulb tubes may cause the loose particles to go into the analyzer's
exhaust.

1. Record the sample tube identification on the Sample Data Worksheet.

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at
zero.

3. Ifanalyzing a powder or sample made of fine particles, push a piece of quartz wool all the way
down into the sample tube. See Use Quartz Filter Discs for Chemical Adsorption on the
facing page.

4. If using quartz wool, put a second piece of quartz wool just inside the sample tube. If using fil-
ter discs, push a filter disc down into the tube until it sits on top of the quartz wool. Place a
second filter disc just inside the sample tube.

5. Place the sample tube set (sample tube with quartz wool or filter discs and stoppers) on the

sample support. Record the stabilized mass on the Sample Data Worksheet.

6. Remove the sample weighing support and sample tube set from the balance.
7. Place the sample container on the balance and allow the balance to stabilize at zero.

/ Do not touch the sample with bare hands. Oil from hands could affect the accuracy of
results.
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8. Slowly add approximately 0.5 to 1.0 gram of sample to the sample container.

If a second piece of quartz wool or filter disc was inserted, remove the top portion of the quartz

wool or the filter disc from the sample tube.

10. Use a funnel to slowly pour sample from the container into the sample tube on top of the
quartz wool in the tube.

©

/ Ensure all sample in the container is placed in the sample tube to avoid errors caused by
incorrect sample mass.

11. If using quartz wool, insert the top portion of quartz wool into the tube and press it down. If
using filter discs, insert the filter disc into the tube and press it down.

/ Ensure the disc is flat on top of the sample. A seal must be created around the edge to
prevent the sample from escaping.

12. Wipe the top of the sample tube with a lint-free cloth, such as a Kimwipe®, to remove any
quartz wool that may have adhered to the surface.

13. Weigh the sample tube set containing the sample and the stoppers. Record this mass as the
Sample + tube.

Use Quartz Filter Discs for Chemical Adsorption

/ The equipment images in this topic may differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

/ The use of quartz wool is not mandatory, however it can provide extra protection for light
powdered samples.

Wear latex gloves when handling the sample tube. The natural oils in human skin can
chemically damage and weaken the quartz tube. It is also important that the sample tube
and its components, as well as the sample and exhaust ports, be clean and free of
debris. Dust particles from quartz wool or the insulator disc of previous analyses may
adhere to the port and/or components, preventing a proper seal of the sample tube.

Use quartz filter discs or quartz wool to aid in chemical adsorption sample preparation. Quartz filter
discs (placed both below and above powdered samples) not only provide a more uniform sample
surface but also keep the analyzer free of sample debris. The filters can be used up to 900 °C.
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1.

Insert quartz wool and

Insert a small portion of quartz wool into the sample tube to serve as a support for the
powdered sample. Use a filler rod or smaller sample tube to push the quartz wool to the bot-
tom of the sample tube.

&

Top disc, powdered
sample, bottom disc,

disc quartz wool

Insert a quartz disc into the sample tube and push it into the tube until it rests on top of the
quartz wool. Inspect the disc to ensure that there is a good seal and that the sample will not go
past the filter. An additional filter can be inserted if needed.

. Insert a second filter disc on top of the quartz wool. Ensure that the filter is placed high enough

into the sample tube for easy retrieval.

Take the initial tube weight (with both filters).

Remove the top filter disc. Place it on a clean surface, then use a funnel to add the powdered
sample on the bottom filter disc.

Reinsert the top filter disc into the sample tube, then use a rod or smaller sample tube to push
it down until it reaches the top of the sample.

To remove the quartz wool and disc after analysis, use the quartz wool extractor tool.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019



Ei “'Ii'(?-I'l‘.l“’IEI“itiGﬁim Degas the Sample

DEGAS THE SAMPLE

Unit [n] > Start Degas

Most solid materials absorb moisture and other contaminants when exposed to the atmosphere. The
sample must be clean before an analysis is performed. The degassing process involves heating the
sample and placing it under vacuum to remove moisture and other contaminants.

Physical Adsorption

Sample tube
fitti
- \@ Seal Frit and

O-ring \ / opener

¢
Ferrule E
—

/ Sample tube

Thermocouple
connectors

\@5/

1. While holding the degas port plug, remove the connector nut and plug from the degas port by
turning the connector nut counter-clockwise.
2. Place the degas port connector nut, ferrule, and O-ring onto the sample tube set.

Connector nut

Connector nut

Heating mantle

/ The Seal Fritis for 1/2 in. sample tubes only. When using a 1/4 in. or 3/8 in. sample tube,
the Seal Frit opener must be removed from the sample connector

3. Remove the rubber stopper from the sample tube and attach the sample tube set to the degas
port.
4. Push the sample tube in to a full stop.

A Mounting the sample tube at an angle might break the tube and cause injury.
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5. Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up to the
degas port and turning the connector nut clockwise.
6. Tighten the connector nut securely by hand.

Never use atool to tighten the nut; doing so may cause the sample tube to break.

7. Place a heating mantle over the sample tube bulb and secure the mantle in place with a
mantle clip.

8. Securely insert the heating mantle thermocouple plug and thermocouple power plug into the
thermocouple outlets on the analyzer.

9. Degasthe sample.

10. After degassing, transfer the sample tube to the analysis port. See Transfer a Degassed
Physical Adsorption Sample to an Analysis Port on page 5 - 2.

Chemical Adsorption

Sample tube
fitting

Connector
nut

Connector nut

Thermocouple
/ connectors

1. While holding the degas port plug, remove the connector nut and plug from the degas port by
turning the connector nut counter-clockwise.

2. Place the degas port connector nut, ferrule, and O-ring onto the sample tube set.

3. Remove the rubber stopper from the sample tube and attach the sample tube set to the degas
port.

4. Push the sample tube in to a full stop.

A Mounting the sample tube at an angle might break the tube and cause injury.
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5. Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up to the
degas port and turning the connector nut clockwise.

6. Tighten the connector nut securely by hand.

Never use atool to tighten the nut; doing so may cause the sample tube to break.

7. Ensure the exhaust tube of the sample tube has been capped.
8. Place a heating mantle over the sample tube bulb and secure the mantle in place with a
mantle clip.
9. Securely insert the heating mantle thermocouple plug and thermocouple power plug into the
thermocouple outlets on the analyzer.
10. Degasthe sample.
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SAMPLE TUBE INSTALLATION

PHYSICAL ADSORPTION

Sample tube
fitting

N

Seal Frit and
O-ring opener
[~
[
Ferrule \ Sample tube
Connector /
nut
Isothermal
jacket
If using... Then...

A rubber stopper Remove it.

An isothermal jacket | Slide the jacket down over the stem of the sample tube until it touches the
sample tube bulb.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into the
tube.
Filler rod Sample tube

Do not hold the rod vertically and drop the rod into the tube;
this could break the rod and/or tube.

1. Loosen the connector nut on the P tube and rotate the P tube out of the way.
2. Ifusing a TranSeal and/or isothermal jacket, install it.
3. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
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4. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely
hand tighten the connector nut onto the analysis port.

5. Position the dewar cover approximately 3/4 in (19 mm) below the connector nut.

CHEMICAL ADSORPTION

Wear latex gloves when handling the sample tube. The natural oils in human skin can
chemically damage and weaken the quartz tube. It is also important that the sample tube
and its components, as well as the sample and exhaust ports, be clean and free of
debris. Dust particles from quartz wool or the insulator disc of previous analyses may
adhere to the port and/or components, preventing a proper seal of the sample tube.

O-ring
Port filter
Ferrule
\ o
._% a/ Exhaust
Sample nut =) o filter
\ O/
E) Exhaust
fe—
(]
Quartz filler
rod Ferrule

#—-—____ Quartz sample

tube

Thermocouple

clip ——

e

Wool quartz

1. Use alint-free swab moistened with IPA and wipe the interior rims of the sample and exhaust
ports.

2. Use alint-free tissue moistened with IPA and wipe the O-ring, ferrule, and connector nuts for
the sample and exhaust tubes. Place on a lint-free tissue.

Sample and exhaust ports, as well as all components that contact the sample and
exhaust ports, must be clean, therefore it is recommended that the previous steps be
repeated each time a sample tube is installed onto a port

3. Ifusing a hanging filler rod (recommended), hold the sample tube slightly tilted and carefully
place the filler rod into the tube.

4. Assemble and install the sample and exhaust tube components.
5. Insertthe assembled sample tube into the exhaust port.
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[M] micromeritics’

6. Slide the connector nuts up the stems and screw the nuts clockwise to secure the tube in
place. Hand tighten both connector nuts until snug.

7. Insert the temperature thermocouple into the thermocouple clip on the sample tube.

8. Ensure the furnace is on the elevator shelf and manually raise the elevator using the instru-
ment schematic. On the schematic, right click the furnace icon and select Raise to raise the
elevator. If it is necessary to stop the elevator, right click the elevator icon again and select

Stop.

[ 2 [ A [[eo2 [ « ] | |
$Pl $P2 $P3 $P4 $P5 $PE

PV He
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1 2 % 3 4
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0.0101325 kPa

I

External Trigger

2984 K
298.4 K

Ps
5
9

cs
O

cv

©
c3
©

c4

X

C5

—0—_ |

co

—0— |

308.1 K
10.0 K/min

8. When the elevator reaches the top, insert the two furnace disk halves on top of the furnace
opening. Place the first disk behind the sample tube and the second disk in front of the sample

tube. Ensure the clip remains above the furnace disks.
9. Install the safety shield to cover the furnace.
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FiLL AND INSTALL THE DEWAR

/ The equipment images in this topic may differ slightly from your equipment, however the
instructions are the same unless otherwise noted.

{i&b\ See also:

TSy Dewar Precautions on page 6 - 1

1. Fillthe dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than 2 1/4 in.
(5.7 cm) from the top. Filling the dewar higher than this will cause an error in the free space
measurement.

/ Incorrect fluid levels can lead to measurement errors. Check the level of the bath liquid
before each analysis.

2. Insertthe dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.
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Wetness orfrozen
condensation indicates bath ( Levelindicatormark J
liquid level

3. For bestresults, if the dewar has not been used for a while, allow approximately 30 minutes
for the temperature of the dewar to stabilize with the bath liquid, then recheck the level of the
bath liquid. Add additional liquid if necessary.

4. Slide the dewar cover to ensure a proper seal on the top of the dewar.

5. Place the dewar on the elevator.

6-20 MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



Ei micromeritics“ Perform a Sample Analysis

PERFORM A SAMPLE ANALYSIS

Unit [n] > Sample Analysis

[=le =]

View: | gperation ~

[ e Densty: 1000 | gfems Mass:| L0000 | g
Browse... | gompje +Tube: 20000 | g Empty Tube: 10000 | g
Edit

Clear

Report after analyss. ..

Sample:
Stage Last Point p (kPa)
dle [ 0.0000000

Details: [

p/p® Q (mmol/g) p° (kPa) Run Time
0.1035915 0.00000 1013250 0:00

CAUTION ﬁ Use caution when removing the sample tube if using a hanging filler rod. The sample
tube O-ring or dewar cover may snag the filler rod retaining ring. Loosen the snag gently;
excessive force may break the tip of the filler rod.

Sample Analysis

Field or Button Description

Density / Mass / Enter values for the sample’s mass and density. These values may be
Sample + Tube / edited after analysis.

Empty Tube [text box]

New [button] Creates a new sample file.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Suspend Resume Skip Portreport Live graph

~. \ /
N Y By
v (] [»] (=]

—— SN3075 13X Reference Material

T\k\ m“\

Quantity Adsorbed (envig STP)

Sample:  5N3075 13X Reference Material
Stage Last Point P (mmbg) P[P0 Q (cm/g STP) Po (mmHg) Run Time
Analysis 29 of 30 0.001553 0.000002 87.8737 746.189 48:58

Details: [Dosi for 44 seconds. Dos <m*/q STP. 1

Sample Analysis Graph

Field or Button Description
Live Graph Settings Select Thermal transpiration, x-axis Quantity (relative or absolute pres-
[button] sure), and the x-axis Scale (linear or logarithmic).

Report after analysis Generates reports to the selected destination when the analysis is com-
[button] plete.

Port [button] Generates a report on data being collected. The reports are displayed
on the computer monitor only.

Resume [button] Restarts the suspended analysis.

Skip [button] Moves to the next step. Select the ports to skip.

Status window Displays the last point pressure and relative pressure for each port.

Suspend [button] Suspends an analysis in progress.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MicroActive ASAP 2020 Operator Manual

6-22 202-42804-01 (Rev -) — Feb 2019



Iml m icromeritics“ Perform an Analysis Sequence for Chemical Adsorption

PERFORM AN ANALYSIS SEQUENCE FOR CHEMICAL ADSORPTION

Unit [n] > Analysis Sequence

_]EH\ See also:
&)

N "_r_’cﬁ_?ﬁ Use Quartz Filter Discs for Chemical Adsorption on page 6 - 11

Use to perform a sequence of analyses. If the Analysis Sequence option is selected and a sequence
analysis is already in progress, the program continues to run the four steps for the analysis in
progress. Files can be added and removed from the sequence while it is in progress.

/ Sample files must be created prior to performing an analysis sequence. See Sample
Files on page 3 - 1.

A Ensure the furnace is raised to its uppermost position otherwise hazardous conditions
can result.

Operator intervention will be required between analyses in the sequence if the temperature control
type changes. Intervention will be required if at the beginning of the analysis.

2. Sequence Analysis =)o s
Ve
[ _cuswx 10000225 ]
VAP 52> Crm P e 000 5 )
sopena
e
=
Coe
,,,,,, -
mmmmmmmmmmmm
ssssssss
e s ol +tbemos: B2 0 Prepmetisbacdt o
e eton o o
bomass: w305 o A feepaes B0 aw [k G Tenperstre
Cse ] [ e
= o)
S
Stage Lastpom » () Qmmotie) RunTime  Manifold Gas
Ta S 000000 G300 25 Uakaow
Details: [ 1

tube O-ring or dewar cover may snag the filler rod retaining ring. Loosen the snag

@ Use caution when removing the sample tube if using a hanging filler rod. The sample
gently; excessive force may break the tip of the filler rod.
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Analysis Sequence

Field or Button

Description

Analysis free space
[text box]

Free space used for analysis.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is com-
plete.

Sample + tube mass
[text box]

Sample tube weight plus sample weight.

Sample mass [text box]

Sample weight.

Tube mass [text box]

Sample tube weight.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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7 ABOUT REPORTS

Reports > Open Report > [.REP file]

Opens a saved report.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.

Reports > Start Report

Generates a report on a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.
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HEAT OF ADSORPTION REPORT

Reports > Heat of Adsorption

Heat of Adsorption X
Quantities Adsorbed (mmolfg)

(e e [}

Report Settings

Add Samples... [7]show report title [ Heat of Adsorption |
[ show graphic C:\Vicromeritics\midogo. emf
Heighti| 0.250 |in Width: | 2.000 |in
Destinati
Preview
Edit Quantites... Opmt  Copes: | 1] 5] File type:| Report System (*re) v
OFile File name HOAReport
C:\MICROMERITICS 2]
Tabular report Isostere plot Heat of adsorption plot
[ open.. | [ saven | [ mepot | [ ox | | caneel |

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The isosteric
heat of adsorption is an important parameter for characterizing the surface heterogeneity and for
providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different temperatures
to obtain the heat of adsorption.

Heat of Adsorption Report

Field or Button Description
Add Samples [button] Adds a sampile file to the table.
Clear Samples [button] | Removes all entries from the table.

Edit Quantities [button] |Use to specify the range of surface coverage to include in the report.

Edit Quantities Adsorbed X

ncreasing gty ads: 0.00000 - 44614774 mmol/g
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Heat of Adsorption Report

Heat of Adsorption Report (continued)

Field or Button

Description

Insert Range. Click to specify the starting and ending quantities
adsorbed and number of points to insert.

Load Table. Imports values from another file.
Save Table. Saves the current table as a .QNT file.

Apply. Applies all table changes.

Heat of adsorption plot
[selection]

Generates the Heat of Adsorption data in a graphical format.

Isostere plot [selection]

Generates a graph showing quantities of gas adsorbed versus the tem-
perature.

Remove Sample [button]

Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title

Select and enter a report title to appear on the report header.

[check box]
Tabular report Generates a tabular report of the included samples. A tabular report
[check box] contains the numeric values contributed by each sample.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SPC REPORT FOR PHYSICAL ADSORPTION

Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more efficient
to select only the necessary variables.

Analysis Options Surface Area Pore Volume r‘ 2 @

[] sample mass ["] Single-point BET [] Adsorption total
BET Dubinin-Astakhov Alpha-5
[T Equiibration interval ["] Multi-point BET [ Desorption tatal
[ c value [ Micropore surface area [ Slope:
[C] Evacuation time [ ] Langmuir [C] tPlot micropore
[T monclayer volume [ClLimiting micropore volume [T v-intercept
(] Analysis temperature [C] t-Plot micropore []B3H cumulative adsarption o
Correlation coefficent
[ saturation pressure [T t-Plot external [7)83H cumulative desorption Dubinin-Radushkevich DFT Pare Size
[]Warm free space []BIH adsorption [7]0H cumulative adsorption Langmuir [CIMicropore surface area [] Total pore area
[C]cold free space []BIH desorption [0+ cumulative desorption [l vake [ Monolayer capacity [ZITotal pore volume
[C]Parameter 1 [Clo-+ adsorption Pore Size [£] Monclayer volume MPMethod DFT Surface Area
[ClParameter 2 [Clo- desorption [C]BIH ads. avg. pore width 4v/A [ Correlation coefficient [7] Cumulative surface area [T Total surface area
[ClParameter 3 BJH des. avg. pore width 4/A
B o b Horvath-Kawazoe e NLDFT Advanced PSD
[C10-H ads. ava. pore width 4v/a [ Maximum pore volume [] Average pore hydraulic radius [ Total pore area
[C]DH des. ava. pore width 4v/A Pl Meon pore i Bl Total pore volume
[E] Avg. pore width adsorption 5
[] Ava. pore width desorption
[Z]Manopartide Size -
| w1 =l peell— 4
| N
i More... ’ 1

=

The selected items display as graph variable selections in Reports > Regression Report and
graph selections in Reports > Control Chart. If report options for NLDFT Advanced PSD are
required, click More.
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REGRESSION REPORT FOR PHYSICAL ADSORPTION

Reports > Regression Report

Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Regression Report

Field or Button Description

Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in the
sample files.

Recalculate archived Use to have archived SPC values recalculated ensuring any changes
SPC results [check box] | made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warning message can be safely disregarded.

When this option is selected, this message will display:
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Regression Report (continued)

Field or Button

Description

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

/

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

Samples [button]

Select additional sample files to add to the report.

Save as Default [button]

Click to save selected report options as default report settings.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title

Select and enter a report title to appear on the report header.

[check box]
Tabular report Generates a tabular report of the included samples. A tabular report
[check box] contains the numeric values contributed by each sample.

X- and Y-Axis Variable
[drop-down box]

Use to designate the x- and y-axes variables. The variables in the
drop-down lists are those selected in the Reports > SPC Report
Options window. Use these options to plot the regression of up to
three y-axis variables against the x-axis variable.

/

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Control Chart Report for Physical Adsorption

CONTROL CHART REPORT FOR PHYSICAL ADSORPTION

Reports > Control Chart

Generates a Statistical Process Control (SPC) chart report which plots the changes in a statistic.

nnnnnnnnnnnn

Control Chart Report

Field or Button

Description

Graph [n] [button]

Defines the y-axis of each graph.

Gas Adsorption Control Chart Graph 1 Options

Y Axis
Statistic:  None

Autoscale

Center Line Limit Lines

(@) None @) None

(O Mean O +and-
(OEntered (OEntered

From:  -10,000.0000 To: 10,000.0000

Statistic. Displays the SPC variables selected on the Reports >
SPC Report Options window. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis label.

Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

Center Line. Displays placement options for the center line in the

graph. Select Entered to specify placement of the line or Mean to place
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Control Chart Report (continued)

Field or Button

Description

the center line at the calculated mean value for the selected samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low limit
fields with appropriate values.

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warning message can be safely disregarded.

/ If this recalculation option is enabled and sample files from

When this option is selected, this message will display:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

If Do not show me this message again is selected, the mes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sampile file is recalculated.

Report [button]

Generates the report.

Samples [button]

Select additional sample files to add to the report.
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Control Chart Report (continued)

Field or Button Description
Show graphic Use to show a graphic on the report header.
[check box]

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated

report.
Show report title Select and enter a report title to appear on the report header.
[check box]
Tabular report Generates a tabular report of the included samples. A tabular report
[check box] contains the numeric values contributed by each sample.
X Axis Order by Select the order in which x-axis statistics are placed. Sort by:
[group box]

Time. Time the files were analyzed.
File name. Alphanumeric order.
Date. Date the files were analyzed.

Minutes. Minutes elapsed from the first file placed on the list, which is
the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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INTERACTIVE REPORTS

When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1.

When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

« alinear plot and log plot of the data collected during analysis
« asummary of the analysis giving a single total pore volume and surface area

[
Isotherm sk
Me d 34 cm3 Id: o’
g
3 " a,-—e—-ﬁ“e"
e P
Isotherm Summary
ume: 0.621096 cm3/g
at sure: 0.984812751
%ﬂ’ Maxi idth: 1,282.550 A
% single tion
g ume: 0.630482 cm/g
a at sure: 0.995425753
§ Jaxi pore width: 4,196.700 A
g Single point surface area: 209.7479 m¥g
E » atrelative pi sure: 0.212851443
° ﬁ——’@ﬁ——eﬁ—e'ﬁe—e}—@-ww
[ cose | [otherm  +] [ Preview |
2. Toview the plots in either relative or absolute pressure, select either the Relative Pressure or

Absolute Pressure option.
To view the reports selected for generation during the analysis, click Preview.
From the drop-down list at the bottom of the window:

« change the option presentation of the sample information window to either Basic or
Advanced to modify certain file parameters, or
« select another plot from the list and edit the data contained in the plot.

When ranges are edited, the changes are reflected immediately in the plots and the summary
data displayed in the window. Some editing options are:

« Drag the blue bars to increase or decrease the range of data included in the plot.
« Editthe Isotherm Linear Plot to include or omit the data point from the BET plot.

« Right click to display a popup menu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular format.

Click Save.
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MICROACTIVE REPORTS

MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easy way to investigate and manipulate analysis data using a variety of
reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and log
plot of the data collected during analysis are displayed as well as a summary of the analysis giving
the total pore volume. Numerous reports are accessible from a drop-down menu.

When areport is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are also
displayed. Plots may be edited by selecting the data points or data point range to be included in the
plots and modifying the parameters. When a report is edited, the results are immediately reflected in
the plots and summary data.

Log in to your customer portal to access MicroActive Report Tutorials.

EVALUATE REPORT RESULTS

Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ static volumetric physical adsorption
analyzers and suggests ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

» Viewing the Validation Report

Inspecting the Isotherm Plot
 Evaluating the Isotherm Tabular Data Set
« Reviewing Reduced Data
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VIEW THE VALIDATION REPORT

The Validation report shows whether the data collected during an analysis are within typical ranges.
Select the types of reports to include by selecting the report in the Validation Report Options window.

Lo sl
Isotherm o
BET
Langmuir
Freundlich
Temkin
t-Plot
f-Ratio Method
BJH Adsorption
BIJH Desorption
D-H Adsorption
D-H Desorption
Horvath-Kawazoe
DFT Pare Size
DFT Surface Energy
Dubinin
MP-Method

OK Cancel

When a selected report is generated, if errors occur, a message is displayed across the top portion of
the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type | isotherm, then the plot is best shown on a logarithmic pressure axis so that
details of the low pressure region are revealed. Data in this region are important particularly for
micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical process
being monitored. The philosophical question of whether or not these suspected extraneous data
points should be removed from the raw data is not considered here, but it may be appropriate to
exclude an outlier from reduced data. Too many outliers can cause the integrity of the total data set
to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under reasonable
conditions and using reasonable parameters. For example, confirm that the free space values
reported are typical for the sample holder and bath in use. A problem with either ambient or analysis
free space values may indicate a free space measurement error and affect all calculations of quantity
adsorbed.

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.)

1) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P.and Orr, C., (1997).
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EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/Py = 0.05to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than

0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of this
level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result. The
solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate that
a gas different from the adsorptive was used in determining P, that the level of the cryogen fell too
far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular and
graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.!)

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the analyzer
model and pressure range employed. The quality of the results depends on the quality of the
isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.2 )

PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be reviewed
to assure that they agree with experimental conditions. These parameters can be changed and the
experimental data recalculated if an error is discovered or if exploring an alternate value is desired.
Analysis condition values used in the calculation of quantity adsorbed can be changed also. These
are typically the manually entered free space(s), nonideality correction factor, and bath temperature.

1) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
2) Most of the information in this article is extracted from Analytical Methods in Fine Particle

Technology, Webb, P. and Orr, C., (1997).
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The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger?) provide a comprehensive review of
such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them by
converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension 7, contact angle between solid and liquid phase @, molar volume
of the adsorbate 7, gas constant B, and sample temperature T" are treated as one constant, the
adsorbate property factor A expressed by:

2+ cos 6

A=—%F

using which, the Kelvin equation?) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new value
for the factor A, or A can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those of
the default values. The first is the inside stem (neck) diameter of the sample holder, and the second
is the hard-sphere diameter of the adsorptive molecule. The sample holder inside diameter is
available from the documentation provided with it or is measurable. Information on hard-sphere
diameters of molecules may be obtained from handbooks.

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation3) , the
Dubinin affinity coefficient, or Astakhov exponent?4) | the default values as provided by the software
generally are adequate. A search of the technical literature is required if the analysis involves a gas-
solid system other than that covered by the default values.

1) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577 (1967).
2) Thomson, W., Phil. Mag. S., 42, 448 (1871).

3) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).

4) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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Ei micromeritics"“ Evaluate Report Results

The t-Plot method plots quantity adsorbed (Va) against thickness (t) derived from a thickness
equation, and the Dubinin transform plots quantity adsorbed against log(P/Pg)n. All of these data
reduction methods were first proposed for specific applications. The user must make a judgment as
to the applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis must
be applied only over the linear range and within the range of application. Fitting a regression line to
surface area transformation plots should yield a correlation coefficient of 0.9999 or better and for
t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may be
that either no linear range exists within the pressure range of validity, or that solutions derived from
the regression line of the linear range are intuitively incorrect, that is, they have no relevance to the
physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also assumes
that the gas is more strongly attracted to the surface than to other gas molecules. The typical range
of BET C-values is from about 5 to well over 100. Values much less than 5 imply that the gas-to-gas
affinity is competing with the gas-to-solid affinity which conflicts with the basic assumptions of BET
theory. C-values much greater than 100 indicate very strong attraction for the surface or preferential
adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally spaced
points. In the case of indications of poor conformance to the BET model, the Langmuir data
reduction method should be examined.

DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive involved
is divided between pore-emptying and film-thinning processes and is accounted for totally. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If
the thickness curve used is too steep, ultimately it will predict a larger increment of adsorptive for a
given pressure increment than is actually observed. The algorithm must stop since a negative pore
volume is nonphysical. Accumulated error results in the calculation of a too large volume of (possibly
nonexistent) small pores if the thickness curve used underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

« After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
« The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
« Allreports contain a header displaying file statistics.

Generated
tabs B lsothern Tsbuds Repart [ I [ lsathem Log Abschte Pt | L Repar
E micromeritics”
Butane at Room Temperature Blank Tune AN
unit Sensi 103 ;
Graphic
Header s uoe No-1Pentane VaporPort 1 |
- N
o -
Carbon wih Pertane Por 151 - List box
Title
stared: o050z 150 Anayis Adsorpve: 105 =
Roitie Avsolte satrton
Data displa
Protaus (57 Frosaus (2) Pressue (2)
(graph or text)\ o N
seszion0
ooomnss oot 0093 0129
Toolbar
Coomnror  oougres  o2oms 023
Coouniwo  oomeri o301 o258
Coouned  ooussoor  oasenr o350
Cooorass  0ouaiost  oseres 023
Coouigs  oones  oore 0338

If configured, the report header can also contain a graphic and/or a title.

« Tabular and graphical reports contain sample and analyzer statistics such as analysis date/time,
analysis conditions, etc.

« The headers contain notes of sample file changes occurring after analysis.

« Summary report headers contain the same information as tabular and graphical reports with the
exception of notes.
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Report Features and Shortcuts

REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

Isotherm Tabult Repot _[sother BET Tabulor Report_BET Transiom Flot

mibsaPel T
[Mi micromeritics’
\"2/g Alumina

Edit
Copy header as text

Report Header Shortcuts

Field or Button Description

Copy header as text Use to copy the report header as text. Text is copied to the clipboard
and then can be pasted into other documents.

Edit Use to edit the report title and/or graphic in the report header.
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[M] micromeritics’

REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in the Reports list box,

then click Show.

—_—m—
Isatherm Tabular Report | sothem Linear Plot | lsotherm Log Plot | Isatherm Linear Absolute Plot | Isothemn Log Absolute Plot | Langmuir Reports —_—
- Reports
[Mi micromeritics® st Tt Report
Butane at Room Temperature Blank Tune Analysis Isotherm Linear Plot
|| 1sothermLog Plot
Unit 1 Port 1 Serial# 103 Page 1 " ||| 1sotherm Linear Absolute Plot
Isatherm Log Absolute Plot
Sample: Activated Carbon Tube N9-1 Pentane Vapor Port 1 || Langmur Reports \
Operator: JCH \
Submitter: Micromeritics — i
File: G Mctivated Carbon with Pentane Port 1.SMP LlSt bOX
Started: 9712012 9:02:15 AM Analysis Adsorptive: nC5 |
Isotherm Tabular Report =
Relative Absolute Quantity Elapsed Time  Saturation DefauitSiye
Pressure (pip®) Pressure (kPa)  Adsoroed (hmin) Pressure (kPa)
(mmolig) L
64.5210440
0.000028641 0.0017218 0.09633 01:2¢
0.000031957 0.0020651 0.19476 0207 * TOOIbar
0.000042791 0.0027652 029286 0235
0.000061390 0.0039671 039016 02:56
0.000089904 0.0058097 048817 03:10
0.000130036 0.0084031 058184 03:23
0.000183132 0.0118342 0.67592 03:35
0.000252591 0.0163227 076884 03:45
0.000338086 0.0218475 0.86085 0354
0.000443475 0.0286578 095172 04:02
0.000567694 0.0368850 1.04053 04:10
0.000713793 0.0461261 112806 0417
0.000883942 0.0571212 121394 04:26
0.001076657 0.0695747 129798 04:36
0.001205022 0.0837438 138041 04:42
0.002608163 0.1685422 172473 04:56 il

Report Toolbar

Field or Button

Description

Default Style [button]

Specify default report parameters for fonts and curve properties.

Delete [button]

Deletes the selected report in the Reports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button]

Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button]

Displays the Print window for report output.

Reports [group box]

Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using the Hide button.

Show [button]

Displays the selected or hidden report in the Reports list box.

Z For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Report Features and Shortcuts

TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts

require right clicking on the column to be modified.

Summary ; Enver | Tabular Report | Cum, Vel ve Size | Inc. Vel vs Size | Dk Val. vs Size 1 | Cum. Area vs Size | Loa Diff, Vol. vs Size 1 | Velume Seair * | »

[Mi micromeritics®
MICROMERITICS INSTRUMENT CORPORATION

AutoPore Serial # 370 Port 22 Page 1

CMutoPoredatalexamplestROCK SMP

LP Analysis Time: 5/11/1998 10:02:34 AM Sample Ma
5/11/1998 11:07:05 AM Stem Volume Us¢
111412016 10:45:19 AM Show Neg. |
00010 A1.0DN.ON. Carectinn Tul

Tabular Report

Pressure Pore Diameter  Pore Volume  Pore Volume:
(psia) (nm) (mUg) (mLig)

160 11303546 0.0000 0.0000
210 8632390 0.0003 0.0003
308 58736.92 0.0010 0.0013
108 4432532 0.0009 0.0022
558 3238338 0.0012 0.0035
7.08 2554938 0.0013 0.0048

255 2115184 0.0015 0.0063
1054 1716330 0.0026 0.0088
13.04 1387142 0.0052 0.0140
1474 1227243 0.0030 0.0170
16.02 1120045 0.0021 0.0191
2001 9039.95 0.0046 0.0237
2051 281871 0.0005 0.0242

Tabular Report Shortcuts

Field or Button Description

Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. Click Font to
modify font attributes.

Move column Right click the column to be moved. Select Move column on the short-
cut menu and select Left or Right for the move.

Rename column Right click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. Select Resize column on the short-
cut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

tons on page 2 - 3.

For fields and buttons not listed in this table, see Common Fields and But-
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7 About Reports

[M] micromeritics®

GRAPH FEATURES AND SHORTCUTS

Right click in the graph area to display graph report shortcuts.

v Include report
Enable overlays

Select overlays...

Autoscale all axes

Reset axis limits to initial setting
Show curve

Edit curve
Edit axis
Edit legend
Edit title

Copy graph
Copy data

Graph Shortcuts

Field or Button

Description

Autoscale all axes

Returns the report to full view after using the zoom feature.

Copy graph

Copies the graph to the clipboard. It can then be pasted into other soft-
ware programs.

Edit axis

Use to edit the selected axis properties.

Auis Properties

S

Title

Scale
@) Linear
©) Logarithmic

Autoscale minimum

Autoscale maximum

Gridines: Major:

Minar:

ok

Tide  Relative Pressure (p/p°)

[ tnvert Scale

0

0.84

Dotted

Mone

ancel

Title font...
Scale font...

Grid lines. Use to change how to display major / minor grid lines.

Scale. [group box]

« Autoscale minimum/maximum. [check box] To manually specify
minimum / maximum autoscale, deselect the option and enter the

7-20
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Ei micromeritics“ Graph Features and Shortcuts

Graph Shortcuts (continued)

Field or Button Description

new amount in the text box.
« Invert scale. [check box]Use to invert the scale.

« Linear/Logarithmic. [selection] Select the option to scale the
graph as linear or logarithmic.

« Scale font. [button] Use to modify the font for the scale label.
Deselect Use default font to enable font options.

Title. [text box] Use to edit the selected axis label.

Title font. [button] Use to modify the font for the selected axis label.
Deselect Use default font. Select new font attributes for report data.
Enable Use default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Curve Properties x

style
Curve
Interpolation | Akima Spline ~ Color...

Point style: | Flus v [use default thickness

Pen Style Solid ~ 1

Histogram
Use default fill style

Solid

Color. [button] Click to change the curve color.

Curve. [group box] Use to change the interpolation, point style, and
pen style for the selected curve. These options are disabled if Use
default fill style is selected in the Histogram group box.

Histogram. [group box] Enabled only if Histogram is selected in the
Style drop-down list. Use to specify the type of fill, fill color, and label
position for the selected curve.

Label. [drop-down box] Select where the graph point labels will
display (left, right, center, etc.) on the SPC report.
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Graph Shortcuts (continued)

Field or Button Description

] |
Graph | ]
labels

N

Isotherm

2

LI e e e T LI e e
0.0 01 0.2 n.281 0.4 0.5 08 07 03 09

Style. [drop-down box] Use to select another style for the collected
data curve.

Title. [text box] Use to change the title of the selected curve.

Use default thickness. [check box] Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text box.

Edit legend Use to change the legend location and font.
Legend Properties (eS|
[ ) Do not show
e
@ Left
() Right
() Bottom
[ OK ] [ Cancel ]
Edit title Select to change the report title.
Enable overlays If overlays have been selected, this option displays (or hides) the over-
lays.
Include report When selected, places a checkmark to the left of the report in the

Select Reports list box on the Report Options tab.

Reset axis limits to ini- | Removes the cross-hair and returns the graph back to the initial set-
tial setting ting.
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Graph Shortcuts (continued)

Field or Button Description

Select overlays... Displays the option to select files to overlay onto the active graph. To
view the overlays, click Enable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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AXIS CROSS-HAIR

Left click on the graph to view the cross-hair coordinates.

Axis cross-hair

BET Surface Area Plot
o ALUMINA REFEREMCE 004/16816/00 C1 + Mot Fitted

T T T T T T T T T T T T
0.0000 0.0002 0.00031 3] 0.0004 0.0006

Relative Pressure (pip™

ZOOM FEATURE

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the

graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal view,
right click in the graph and select Autoscale all axes.
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Graph Features and Shortcuts

GRAPH GRID LINES

Options > Graph Grid Lines

X-Axis

Linear Scale: Major [ Minar

Logarithmic Scale: Major [ Minar
f-Axis

Linear Scale: Major [T Minor

Logarithmic Scale: Major [~ Minor
Grid Line Styles

Major: () Solid @ Dotted

Minor: () Solid @ Dotted

Use to select how grid lines appear on reports. This menu option is not available if using Restricted

option presentation.

Graph Grid Lines

Field or Button Description

Grid Line Styles Select if the major and/or minor grid lines should appear as solid or dot-
[selection] ted lines.

X-Axis | Y-Axis Select major and/or minor lines to display in reports for the logarithmic
[selection] and linear scales. Deselect this option to remove the grid lines.

tons on page 2 - 3.

/ For fields and buttons not listed in this table, see Common Fields and But-
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GRAPH AND SAMPLE OVERLAYS

Use the graph overlay functions to compare multiple graph options. Graphical lines are differentiated
by the use of varying colored symbols outlined on a legend. Overlays may be generated in two ways:

« Multiple Graph Overlays. Overlay two different types of graphs from one sample.
« Multiple Sample Overlays. Overlay graphs of the same type with that of the current plot.

/ This feature is available only when using Advanced option presentation. Go to Options
> Option Presentation > Advanced.

GENERATE PORE SiZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physical adsorption applications can produce graphical results for a
sample material's pore size distribution:

G Seeal
T ee also:
E‘ ‘-|"I

;_L? il « BJH Adsorption/Desorption Report Options on page 8 - 6
o DFT Pore Size Report Options on page 8 - 12
o Dollimore-Heal Adsorption/Desorption Report Options on page 8 - 18
o Horvath-Kawazoe Report Options on page 8 - 33

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

« Import ASCII text data. Data can be imported from an ASCI| text file into the interactive graph.
The ASCII text file must follow certain rules.

« Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

« Copy data. Used to copy data sets.

« Paste data. Used to paste data sets.

« Edit Imported Data. Used to edit data sets.

Display Imported Data. Used to hide or show the imported data.
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IMPORT ASCII TEXT DATA

ASCII text file format rules

« The header must consist of one line to include title, two unit specifications, and distribution type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g

o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

« The data must be in two columns and should be separated by a comma or white-space.
« The data lines must be ordered so that pore dimensions are monotonically increasing or decreas-

ing.

Sample ASCII Text File

silica alumina bjh (A, cm3/g, cumulative)

456.657 0.0133559
444.847 0.0546427
429.168 0.0869924
425.419 0.119721
419.629 0.132681
360.634 0.156611
340.859 0.197672
326.601 0.233092

Window appearance will vary depending on the selected report. This function can be performed on
samples files with a Complete status or during an analysis.

1.
2.

Create the ASCII text file using the proper format as indicated above.

In the analyzer application, go to File > Open. Select a sample file to overlay graphs on to.
Click Open (or double-click the file name).

Right click in the graph area and select Edit imported data.

In the Select Imported Overlays window, if the ASCII text file does not display, click Import to
locate the file. Select the ASCII text file in the Select Imported Overlays window, then click
OK. If an error message will display instead, verify that the .TXT file format is in the correct
format.

To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports on the next page.
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OVERLAY PORE SizE DISTRIBUTION DATA USING COPY/PASTE

1.

W

Open a source sample file and a target sample file; both should have a Complete status. The
report will open to the interactive reports window.

In the source sample file, right click on the graph and select Show Curve. Deselect any dif-
ferential curve data to hide them in the graph.

Right click in the graph area again and select Copy Data.

Change to the target sample file, right click the graph, and select Paste data. The graph now
displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves. To
show or hide individual curves, right click the graph and select (or deselect) Display imported
data.

Ensure that all parameter fields are set appropriately, then click Paste.
To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

PRINT PORE SiZE DISTRIBUTION OVERLAY DATA IN REPORTS

1.

2.

o,

Open the sample file containing the overlay data and select Advanced from the drop-down list
at the bottom of the window.

Click the Report Options tab.

In the Selected Reports list box, select the cumulative, differential, or incremental intrusion
graph to show the imported distribution data, then click Edit (or double-click the selected
report).

In the Overlay drop-down box, select Imported.

Click OK to close the window.

Click Preview on the Report Options tab. Click Print in the reports toolbar section to display
print options.
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Overlay Multiple Sample Files

OVERLAY MULTIPLE SAMPLE FILES
To overlay the same type of graph on multiple samples:

1. Goto File > Open.

2. Selecta .SMP file, then click Open. If the Isotherm plot displays, select Advanced from the
drop-down list at the bottom of the window to display the tabbed window view.

3. Click the Report Options tab.

4. Inthe Selected Reports list box, highlight a report then click Edit. Use the following table to

complete the process for the selected report.

(=] 3 =
Sample Degas Analysis Report
Description Conditions Conditions Options
Report options: | Report Options ~ |
Show report title | |
Show graphic Graphic
miclogo.emf ‘ Browse...
Height: 0.250 |in Width: 2,000 |in
Selected Reparts:
= e _Dsummary A
Overlays... \, Edit.... I [ T=otherm
Apply thermal transpiraﬁci‘\ c -
\ Edit...
Inside diameter of sample il
9-53 [ OtFlot
[Jalpha-5 Method
[ lf Do oo
( [WEJH Adsorption ]
= :
= -
[(Joclimare-Heal Adsorption
[[JDclimareHeal Desorption v
Save As Close Advanced v Preview
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If overlaying this type of Then...
report...
a. Onthe Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click
Options to the right of the selected plot.
b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
o Isotherm and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.
c. Onthe Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. Click OK.
d. Continue to Step 5.
« Alpha-S Method
o BET Surface Area
« f~Ratio Method a. On the pop-up window, select Overlay samples. Verify
« Freundlich other fields. Click OK.
o Langmuir Surface Area b. Continue to Step 5.
« t-plot
o Temkin
a. Selectthe report variable from the Selected Reports group
« BJH box, then click Edit.
« Dollimore-Heal b. Click the down arrow on the Overlfayfield, then select the
« MP-Method Samples option. Verify other fields. Click OK.
c. Click OK again.

5. Onthe Report Options tab, click Overlays.
6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files

box to the Selected Files box:

Plot Overlay Sample Selection

Available Fies:

Fie Name

000-002.5MP

Add

7. Click OK.
8. Toview the report, click Preview.
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Plot Overlay Sample Selection

Field Description

Status [drop-down box] | Select the status of files to be combined.

Look in [button] Click the Browse icon to change the file folder location.

Available Files Lists files that meet the selected criteria. Select the files to be com-

[selection] bined, then click Add. The selected files are moved to the Selected
Files list box.

Selected Files Lists the files selected to be combined. Click OK to combine the files.

[selection]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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IMPORT ASCII PORE DISTRIBUTION DATA

Import an ASCII Text File using Graph Shortcuts

hoDN =

Create an ASCll text file. See Manually Enter Data on page 3 - 5.

Open a report with a Complete status.

Select a pore-size distribution report from the drop-down list at the bottom of the window.
Right click on the graph and select Edit imported data on the shortcut menu.

If the ASCII text file does not display on the Selected Imported Overlays window, click Import.
Locate and select the file, then click Open. Header information from the ASCI| text file will
appear in the Select Imported Overlays window. Select the entry, then click OK. If an error
message appears, verify that the .TXT file format is correct.

To hide or show imported data, right click in the graph area and use the Display imported data
option on the shortcut menu.

Copy/Paste an ASCIl Text File using Graph Shortcuts

ok wN =~

Create an ASCll text file. See Manually Enter Data on page 3 - 5.

Copy the ASCII text data to the clipboard.

Open areport with a Complete status.

Select a pore-size distribution report from the drop-down list at the bottom of the window.
Right click on the graph and select Paste data on the shortcut menu.

To hide or show imported data, right click in the graph area and use the Display imported data
option on the shortcut menu.

Copy/Paste Graph Data from Another Graph

a bbb

Open a source pore distribution data report with a Complete status.
Right click on the graph and select Copy Data on the shortcut menu.
Open the target pore distribution data report.

Right click on the graph and select Paste Data on the shortcut menu.

To hide or show imported data, right click in the graph area and use the Display imported data
option on the shortcut menu.
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Ei m icl‘omer‘itics“ Report Examples

REPORT EXAMPLES

HORVATH-KAWAZOE DIFFERENTIAL PORE VOLUME PLOT

[M] micromeritics’
Y Zeolite, N2 @ 77.35 K, 004/16844/00

43AP2020 Plus ASAP2020 Plus Page 1
Serial # 3075 Unit1

Sample: Y-Zeolite N2
Operator:
Submitter:
Bar Coda:
File: C:\ASAP2020 Plusidataly-zeolite-000-114.SMP

Started: 7/29/2014 1:10:56 PM Analysis adsorptive; N2
Completed: 7/30/2014 1:39:43 PM Analysis bath temp.. 78.850 K
Reporttime: 8/4/2014 2:17:48 PM Thermal correction: Yes
Sample mass: 01207 g Warm free space: 27.9791 cm® Entered
Cold free space: 855290 cm® Equilibration interval: 30 s
Low pressure dose: 0.13384 mmalig Sample density. 1.000 g/cm®

Automatic degas: Yes

Comments: Lot HY-102
Isothermal jacket, nofiller rod. Final degas done on sample port. Free space measured in separate analysis.

“ote: Analysis Conditions Maodified During Analysis

—— Y-Zeolite N2

o
=

Smoothed dy/fdw (crm™g nm)

=1
n
L

| s

o4ttt T T T T T T T T
0.0 0.1 0.2 0.3 0.4 05 0.6 07 0.8 0.9 1.0 1.1 1.2
Pore Width (nm)
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[M] micromeritics®

7 About Reports

ISOTHERM LOG REPORT

[N micromeritics®
Y Zeolite, N2 @ 77.35 K, 004/16844/00

ASAP2020 Plus ASAP2020 Plus Page 1
Serial # 3075 Unit1
Sample: Y-Zeolite N2
Operator:
Submitter:
Bar Code:
File: C\ASAP2020 Plus\dataly-zeolite-000-114 SMP
Started: 7/29/2014 1:10:56 PM Analysis adsorptive: N2
Completed: 7/30/2014 1:39:43 PM Analysis bath temp. 78.850 K
Reporttime: 8/4/2014 21748 PM Thermal correction: Yes
Sample mass: 0.1207 g ‘Warm free space: 27.9791 cm® Entered
Cold free space: 855290 cm® Equilibration interval: 30 s
Low pressure dose: 0.13384 mmolig Sample density: 1.000 g/icm®
Automatic degas: Yes

Comments: Lot: HY-102
Isothermal jacket, no filler rod. Final degas done on sample port. Free space measured in separate analysis.

Mote: Analysis Conditions Modified During Analysis

Isotherm Log Plot
—+— Y-Zeolite N2 - Adsorption

| -

B
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[M] micromeritics’

Isotherm Tabular Report

ISOTHERM TABULAR REPORT

Automatic degas: Yes

Comments: Lot HY-102

[Mi micromeritics
Y Zeolite, N2 @ 77.35 K, 004/16844/00

ASAP2020 Plus ASAP2020 Plus Page 1
Serial # 3075 Unit 1
Sample: Y-Zeolite N2
Operator:
Submitter:
Bar Code:
File: CAASAP2020 Plus\dataly-zeolite-000-114.SMP
Started: 7/29/2014 1:10:56 PM Analysis adsorptive: M2
Completed: 7/30/2014 1:39:43 FM Analysis bath temp.. 78.850 K
Reporttime: 8472014 2:17:48 PM Thermal carrection: Yes
Sample mass: 0.1207 g Warm free space: 27.9791 cm® Entered
Cold free space: 85.5290 cm?® Equilibration interval: 30 s
Low pressure dose: 0.13384 mmollg Sample density. 1.000 glcm®

Isothermal jacket, nofillerrod. Final degas done on sample port. Free space measured in separate analysis.

Mote: Analysis Conditions Modified During Analysis

Isotherm Tabular Report

0.000169574 0.0167131

Re|ative Ahbsolute Quantity Elapsed Time  Time Between Saturation
Pressure (p/p®) Pressure (kPa)  Adsorbed (h:min) Points (min)  Pressure (kPa)
(mmolig)

0.000000379 0.0000374 016089 01:33 0093 98 6415445
0.000000748 0.0000737 032188 02:29 0056 098.5841762
0.000002107 0.0002076 048270 03:24 0055 98 5437579
0.000004872 0.0004300 064328 04:16 0052 98.5320515
0.000009019 0.00038584 0.80340 05:05 0049 938.5096136
0.000014358 0.0014145 096301 05:55 0050 98 5161479
0.000020608 0.0020305 112242 0644 0049 98.5262870
0.000027523 00027124 128173 07:31 0047 98 5478999
0.000034883 0.0034383 1.44122 08:15 0044 98 5664367
0.000042604 0.0042003 1.60092 08:53 0038 958.5895143
0.000050740 0.0050027 176120 09:28 0035 98.5963171
0.000058894 0.0053071 1.92138 10:04 0036 938.6039255
0.000067104 0.0066175 208141 10:40 0036 98.6143251
0.000075401 0.0074352 224125 11:15 0035 098.6093938
0.000083640 00082472 24012 11:52 0037 98 6028595
0.000091982 0.0090674 256077 12:29 0037 98.5779104
0.000100342 0.0093896 272038 1305 0036 98 5584377
0.000108362 0.0106771 288335 13:42 0037 085322024
0.000116805 0.0115079 3.04630 14:18 0036 938.5217464
0.0001255749 00123729 320924 14:55 0037 98 5261487
0.000134742 0.0132750 337218 15:31 0036 098.5218847
0000146134 0.0143988 353512 16:07 0036 985312183
0.000157082 0.0154792 369808 16:42 0035 098.5421630
98 5592352

386101 177 0035
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7 About Reports

[M] micromeritics®

OPTIONS REPORT

[N micromeritics’
Y Zeolite, N2 @ 77.35 K, 004/16844/00

ASAP2020 Plus ASAP2020 Plus Page 1
Serial # 3075 Unit1
Sample: Y-Zeolite N2
Operator:
Submitter:
Bar Code:
File: CIASAP2020 Plus\dataly-zeolite-000-114. SMP
Started: 7/29/2014 1:10:56 PM Analysis adsorptive: M2
Completed: 7/30/2014 1:39:43 PM Analysis bathtemp.: 78.850 K
Reporttime: 8/5/2014 7:35:34 AM Thermal correction: Yes
Sample mass: 01207 g Warm free space: 27.9791 cm® Entered
Cold free space: 855290 cm® Equilibration interval: 30 s
Low pressure dose: 0.13384 mmaolig Sample density: 1.000 g/icm®

Automatic degas: Yes

Comments: Lot HY-102

Note: Analysis Conditions Modified During Analysis

Sample Information

Sample Tube

Sample:
Operator:
Submitter:

Bar Code:
Mass type:
Empty tube:
Sample + tube:
Sample mass:
Density:

Type of data:
Instrument type:
Original instrument type:
Comments:

Sample tube:

Warm free space:
Cold free space:
Non-ideality factor:
Lse isothermal jacket:
Use filler rod:

Vacuum seal type:

Isothermal jacket, no filler rod. Final degas done on sample port. Free space measured in separate analysis.

Y-Zeolite N2

Calculated

36.9063 g

37.0270¢g

0.1207 g

1.000 gicm®
Automatically collected

Lot HY-102
|sothermal jacket, nofiller rod. Final degas done on
sample port. Free space measured in separate analysis.

Sample Tube
1.0000 cm®
1.0000 cm®
0.0000620
Yes

Mo

Seal Frit
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[M] micromeritics’ 8 Selected Reports

8 SELECTED REPORTS

/ To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

Log in to your customer portal to access MicroActive Report Tutorials.

ADVANCED REPORT OPTIONS

g[fl\l See:

=0/ Advanced Reports - Python Module on page I - 1

MicroActive ASAP 2020 Operator Manual 8-1
202-42804-01 (Rev-)— Feb 2019


http://www.micromeritics.com/Customer-Login.aspx

8 Selected Reports

[M] micromeritics®

ALPHA-S METHOD REPORT OPTIONS

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the
quantity adsorbed at a relative pressure of 0.4.

£ Alpha-s Method =8 =R ==
Reference Isotherm
[ Open...
Relative Alpha-5 [ savess.. J
Pressur
k) [ insert
1 0.000000001] 0.0001 e
| clear
[ aopend |
Ref. surface area:
T 0.0000 Mg
Select Range for Alpha-5 Fit
0.0000 o 1,000.0000
Select Reports
[#] Tabular report
[#] Alpha-S plot
"] Overlay samples
To
Autoscale x-axis 0 1.000C
(V] Autoscale y-axis 0.00000 4461477
Select Pressures Included in Report
Pressures...
Enter strictly increasing relative pressures up to @ maximum of 10
oK Cancsl

One predefined curve is located in the Reference file directory. Use the table buttons to enter relative
pressure and the alpha-s values.

Alpha-S Method Reports

Field or Button

Description

Open [button]

Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.

Pressures [button]

Use to select a pressure range for report calculations and points for

exclusion from calculations.

Quantity | Excude

Adsorbed

(mmol/a)
131239
137385
1.43247)
145755
1.53535
1.59265
1.6%880)

rrrrrrrr

4362097

7.3755024

rrrrrrrr

S|
b

nossas1457
S
e
b
e

1
2

3 28736074
4 12.35138%
s 14.8089733
s

7

s

s

173061878
13.5402298

1.70122|
17550
181455
187374

Enter a value between 0.000000000 and 1.000000000.

Include Al

Exclude Al

100000000000

~ Calaulation pressure ran

Mi 000000000 | P/P°
Maximums 1.000000000 | P/P*

ge

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the

8-2
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Ei micromeritics“ Alpha-S Method Report Options

Alpha-S Method Reports (continued)

Field or Button

Description

calculations used to generate the report, select Exclude.
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used to
calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot datain graph format.

« Autoscale x-axis. The x-axis field shows the relative pressure.

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.
« Overlay samples. Use to overlay sample files on the plot.

Tabular Report. Use to have a tabular report of data generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MicroActive ASAP 2020 Operator Manual
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8 Selected Reports

[M] micromeritics®

BET SURFACE AREA REPORT OPTIONS

o e )

Select Pressure Range for BET Fit

0049202733 o
Select Reports
[¥] Tabular report

BET Transform plot

[] overlay samples

From

Autoscale x-axis
Autoscale y-axis

[¥1BET Isotherm plot
[] Overlay samples
Autoscale x-axis

Autoscale y-axis

Select Pressures Induded in Report

0313199105 PIP°

Enter a value between 0.000000000 and 1.000000000.

Cancel

The BET calculation obtains the sample surface area value by determining the monolayer volume of
adsorbed gas from the isotherm data. BET uses a multilayer model.

BET Reports

Field or Button

Description

Pressures [button]

This option is available when the sample file has a status of Analyzing
or Complete. Use to enter a range of pressure points to be included in
the report or to modify table values for pressure points.

Absalute Relativ Quantty | Excud

rrrrrrrrrrrrrr dsorbs

(P2) P (mmol/g)
1 +ge20978| oosmsedzs|  1aizsm| [
2 73755024 o.o7a1sze01|  1a7ses| [
: oa7ze074| oosezerer|  14se7| [
. 2361384 011057 14878 []
s e e R |
s 17.306187| _0.173767776|  1.5925) []
7 18402 o1992ss2)  vesss0| [
s 2.39031%8| 02245078 1.om2| [
s 24820017 o0.29920026)  1.7550| [
10 27.3504691| 0.274815744)  1.81455| [
1| maisuse| oomseizws|  veraa [

[use Interpolation

Enter a value between 0000000000 and 1.000000000.

1

2 0.125000000 | Delete
3 0.200000000 =
4 0.275000000 -

s 0.350000000 | Append

[ ssmem] i
0.312116350 | PP°

Indude All

Exclude All

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

MicroActive ASAP 2020 Operator Manual
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Ei micromeritics“ BET Surface Area Report Options

BET Reports (continued)

Field or Button Description
Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolation must be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range | Enter values to indicate the fitted pressure range.
for BET fit [text box]

Selected Reports BET Isotherm plot. Uses BET monolayer volume and constant to
[group box] produce an isotherm.

« Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

« Overlay samples. Use to overlay sample files on the BET isotherm
plot.

BET Transform plot. Use to generate a traditional BET surface area
plot used to determine monolayer volume and BET C constant.

» Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the relative pressure for BET.

« Autoscale y-axis. The y-axis field shows BET transformation.

« Overlay samples. Use to overlay sample files on the
BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports

[M] micromeritics®

BJH ADSORPTION/DESORPTION REPORT OPTIONS

The BJH calculation determines the mesopore volume/area distribution, which accounts for both the
change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for both BJH Adsorption Report
Options and BJH Desorption Report Options are identical unless otherwise specified.

/

An incomplete pore distribution may be generated if a thickness curve selection is not a
good match for the sample being analyzed.

[mi g1 Adsorption Report Options

=

Thickness Curve
O Reference
() Kruk-Jaroniec-Sayari

Pores

Minimum BJH width:

Maximum BIH width:

17.000 |&

3,000.000 |&

() Halsey (

Fraction of pores open at

both ends:

0.00 ]

(® Harkins and Jura
(O Broekhoff-de Boer

Cumulative Reports

(O carbon Black STSA

©Larger

Edit...
Adsorptive Options

BIH Correction
OStandard
OKruk'Jammeosayam

(@) Faas

I:‘Smwth differentials

Select Reports

Z‘BJH Tabular Report
[w]Cumulative Pore Volume
[] dV/dwe Pore Volume
:‘dv/dlug(wj Pore Volume Edit...
Cumulative Pore Area
[ |dA/dv Pore Area
[]da/diog(w) Pore Area

Select Pressures Included in Report

Pressures...

oK

N

Osrde | BJH Adsorption
option only

Adsorptive...

Cancel

BJH Adsorption/Desorption Reports

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinations may be specified.
8-6 MicroActive ASAP 2020 Operator Manual
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Iml m icromeritics“ BJH Adsorption/Desorption Report Options

BJH Adsorption/Desorption Reports (continued)

Field or Button

Description

= Dubinin Adsorptive Options = |[=E @

Affinity
Adsorptive Coeffident
(beta)

0.33000

z &
44

0.26700

o
(=]
~

4

0.46100
0.00000
0.00000
0.00000
0.00000

@y Do s N R

l

0.00000

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected type
will display in the report header.

Faas. Good for statistical thickness curves.
Kruk-Jaroniec-Sayari. Good for reference thickness curves.

Standard. Uses original BJH models.

Cumulative Reports

Larger. Use to report the total volume found in pores larger than the

[group box] current pore size.
Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores

to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that all
pores are closed at one end. Occasionally, a percentage of pores may
be open at both ends causing disagreement in the adsorption and
desorption data or in the values for total volume and total BJH pore
volume. Enter the fraction of pores open at both ends to compensate
for this error.
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8 Selected Reports

[M] micromeritics®

BJH Adsorption/Desorption Reports (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

aaaaaaaaa

00ooooooooo §

CCCCCC

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

8-8
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Iml m icromeritics“ BJH Adsorption/Desorption Report Options

BJH Adsorption/Desorption Reports (continued)

Field or Button Description

[= Entered t-Curve [o@] =

e
Pressure @ Insert

0.000000001 1.0000 eeis

o) o

To import values from an existing thickness curve (. THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or atab.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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8 Selected Reports [Mj micromeritics’
BJH PLot OPTIONS
fofe =]
Plot curve Plot points
X-Axis
() Linear (@ Logarithmic
Autoscale 10.0 | & 10.0 | &
Y-Axis
Variable: [Curnulati\«'e Pore Area ']
Qverlay: [None v]
[¥] Autoscale 0.000 | ke 1,000,000

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then

click Edit.
BJH Plot Reports

Field or Button

Description

Autoscale [check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically. Autoscale means that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box]

Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box]

Overlay. Select an option to overlay onto the current report.

Variable. Select a variable.

tons on page 2

/ For fields and buttons not listed in this table, see Common Fields and But-

-3.
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[M] micromeritics’

BJH Adsorption/Desorption Report Options

BJH TABULAR REPORT OPTIONS

Esmn Adsorption Tabular Report El@
Tabular data defined by
(7 Fixed pore size table
@ Collected points Table...

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

BJH Tabular Reports

Field or Button

Description

Collected points
[selection]

Use to include all relative pressure points collected. Refer to the
Columns button below.

Columns [button]

Select the data types to include in the report. Column [n] indicates the
column order and data contents for the report.
X

Column 1: | Width Interval

Column 2: | Average Width
Column 3: | Incremental Pore Volume
Column 4 | Cumulative Pare Volume
Column 5: | Incremental Pore Area

Column &: | Cumulative Pore Area

OK Cancel

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table to
modify the fixed pore size table. Refer to Table and Columns buttons
elsewhere in this table.

Table [button]

The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore size
table is selected.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

/
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8 Selected Reports Ei “'Iicr't‘.,I"I'Iel"iticﬁim

DFT PORE Size REPORT OPTIONS

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

= e =]

Type: DFT ~
Geometry: St ~

Model: v

Regularization: 0,00000 ~ 0.20000  []Version 2 deconvolution

Select Reports

-

[AIsatherm Table

[v|Cumulative Area Graph

[|Incremental Area Graph Edit...
[CJda/dw Area Graph
[Z]da/dioa(W) Area Graph
[]Cumlative Volume Graph
[“lIncremental Volume Graph

Select Pressures Included in Report

Pressures...

OK Cancel

DFT Pore Size Reports

Field or Button Description

Geometry Select the pore shape.
[drop-down box]

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

X

Absolute Relat Quantity Exdude | ~ essure range

T e | e [ cowoomms] i
T ssezosr] oowsernzs| iz LI . o
2 7.3755024| _0.074152801 v373ss| [
E 9.8735074|  0.099261497] 1a3247] [
4 12.3513845 _ 0.124189567) 14788 [
s 148088733 0.148779443 1s3s3s] [
s 7.30s1878| 0.173767776|  1sszes| [
7 19.8402248| _ 0.199258182| 1e4ss0 [
B 22.3403148| _ 0.224445978 1122) [
B 24.8202017| _ 0.249280026 175560 [ o
10 27.3504691|  0.274815744| 181455) [ Exclude Al
1 | eisess| oasserss] v O |,

o

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.
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Ei micromeritics’ DFT Pore Size Report Options

DFT Pore Size Reports (continued)

Field or Button

Description

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relative weight for the
smoothing during deconvolution. Larger values produce more smooth-

ing.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and click Edit. The Log Goodness of Fit and Goodness of
Fit graphs cannot be edited.

Plat Type Autoscale Dplons
& Curve o | AUtDSCalE XA
il o Butnscale y-mos
Crerlay Differential Surface Area
hoce Range
From To
(=3 Careel

Autoscale Options. Use to autoscale the x-axis and/or y-axes.

Axis Range. From/To fields are enabled when Autoscale options are
not selected. Enter the starting and ending values for the x- and/or y-
axes.

« X-axis. Shows the pore size.
« y-axis. Shows the area.

Overlay. Select an overlay for the report.

Plot Type. Select the method for data display.
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DFT Pore Size Reports (continued)

Field or Button Description
Classical. Model based on the Kelvin equation and thickness for
determining the pore size distribution. See DFT Models on page F -

1.

Type [drop-down box]

DFT. Model based on the density functional theory.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

DFT SURFACE ENERGY REPORT OPTIONS

_ S Iso:
;}% ee also
___-'°_r_::®' DFT Pore Size Report Options on page 8 - 12

The DFT Surface Energy report contains the results of surface energy distribution analyses.

=0 B

Type: DFT -
Model: [ -
Regularization: | 0,00000 - 0.20000
Select Reports

[¥|Tabular Report

[7]Isotherm Table

[¥|Cumulative Area Graph e

[¥|Incrementsl Area Graph

[7]dA/d(Energy) Graph

[¥/]Log Goodness of Fit Graph

[7]Goodness of Fit Graph
Select Pressures Included in Report
Cance

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.
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Iml micromeritics“ Difference Method Report Options for Chemical Adsorption

DIFFERENCE METHOD REPORT OPTIONS FOR CHEMICAL ADSORPTION

The Difference Method Report and the Sinfelt Method Report windows are identical unless
otherwise specified.

[ o s

Select Reports
7] Analysis summary
7] Analysis V|Repeat VIDifference

7] Tabudar report

IPlot data
7] Analysis VIRepeat 7| Difference

Overlay samples

] Autoscale x-axis
] Autoscale y-axis

¥IPlotcurve  [¥IPlot points

Select Pressures Included in Report

oK Cancel

The y-intercept quantity adsorbed (Q) is used for several calculations in the Difference and Sinfelt
reports. This value can be determined in two ways. If one point is selected, Q is the quantity
adsorbed for that point.

Difference Method. The repeat isotherm data are subtracted from the primary isotherm. Qg is the
y-intercept of a straight line through the difference data.

Sinfelt Method. Both the primary and repeat isotherms are fitted to a straight line. Qg is the
difference between the y-intercepts of the fit lines.

Difference and Sinfelt Reports

Field or Button Description
Analysis summary Analysis. Generates a summary of the following for the first analysis:
[selection] « Percent metal dispersion

« Metallic surface area
« Volume adsorbed

o Slope

« Correlation coefficient

Difference. Generates a summary of the differences between the
following information for the first and repeat analyses:

« Percent metal dispersion
« Metallic surface area
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[M] micromeritics®

Difference and Sinfelt Reports (continued)

Field or Button

Description

« Average difference volume

Repeat. (Sinfelt report only). Generates a line fit plot for the secondary
analysis.

Plot data [selection]

Analysis. Includes a line fit plot for the primary analysis.

Autoscale x-axis / Autoscale y-axis. Select to have the x- and/or
y- axes automatically scaled. The application uses the highest values
collected during analysis as the ending points for an axis range. X-axis
shows the pressure. Y-axis shows the quantity of gas adsorbed.

Difference. Plots the difference between the analysis and repeat
analysis lines.

Overlay samples. Overlays data from the current sample with that of
other samples. Click Overlays on the Report Options window to
choose other sample files.

Plot curve and Plot points. Use to specify how to plot data. Plot data
as a curve, points, or both.

Repeat. Includes a line fit plot for the secondary analysis.

Pressures [button]

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

E—— . w——
‘w(ssm( Quantity | Repeat | Quantity | Excude.
| A =
|t oty
= =)

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Selectto exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.
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Iml micromeritics“ Difference Method Report Options for Chemical Adsorption

Difference and Sinfelt Reports (continued)

Field or Button Description
Tabular report [selec- Select to have a report of the pressure points generated.
tion]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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DoLLIMORE-HEAL ADSORPTION/DESORPTION REPORT OPTIONS

[N See also:

% f% BJH Adsorption/Desorption Report Options on page 8 - 6 for additional
information on field and buttons for this report.

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

= EV

PPPPP

Minimum Pore wi idth: 17.000 | &

Maxmum Fore widths A
Cumnulative Reports

@targer (O Smaller
Adsorptive Options
Euo Adsorptive...

[] smooth differentials

oK Cancel

Dollimore-Heal Adsorption/Desorption Reports

Field or Button Description

Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinations may be specified.

E Dubinin Adsorptive Options EI@
Affinity
Adsorptive Coefficient
(beta)
3 |co2 - 0.46100
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Dollimore-Heal Adsorption/Desorption Report Options

Dollimore-Heal Adsorption/Desorption Reports (continued)

Field or Button

Description

Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box]

Enter the minimum and maximum diameter (radius or width) of pores
toinclude in the BJH reports.

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

aaaaaaaaa

l00oooooooog §

CCCCCC

Enter a value between 0.000000000 and 1.000000000.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials

Use to smooth all differential calculations, thus eliminating variations

[check box] in the differential computation caused by noise in the input data.
Thickness Curve Select the thickness curve, then click Edit to modify the values in the
[group box] equation for the selected curve. The Frenkel-Halsey-Hill thickness

curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.
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Dollimore-Heal Adsorption/Desorption Reports (continued)

Field or Button Description

[= Entered t-Curve [o@] =

e
Pressure @ Insert

0.000000001 1.0000 eeis

o) o

To import values from an existing thickness curve (. THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or atab.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Iml m icromeritics“ Dollimore-Heal Adsorption/Desorption Report Options

DoLLIMORE-HEAL PLOT OPTIONS

i
_ See also:
e
;_-'{i:’c‘?f BJH Plot Options on page 8 - 10
foE ]
Plot curve Plot paints
X-Axis
() Linear (@) Logarithmic
[V] Autoscale 10.0 | to 10.0 | &
Y-Axis
Variable: [Cumulaﬁve Pore Area ‘]
Overlay: [None v]
[¥] Autoscale 0.000 | to 1,000,000 | mz/g

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot Report

Options.
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DoLLIMORE-HEAL TABULAR REPORT OPTIONS

i
See also:
&)
= Y9 BJH Tabular Report Options on page 8 - 11

\

(===
Tabular data defined by

(| Fixed pore size table

(@) Collected points Table...

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.
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DUBININ REPORT OPTIONS

The Dubinin method provides pore volume distributions for microporous materials by making use of
an expression for the adsorption potential.

i Dubinin Report Options [E=n e
Report Type Fitted Relative Pressure Range
["IRadushkevich Radushkevich: to

[~ Astakhov
Optimize exponent

Astakhov: 0.000100 | to 0.050000

2.0000 Adsorptive Options

Adsorptive...

Select Reports

Dubinin Tabular Report
|_[Transformed Isotherm Edit...
|_|dv/dw Pore Volume

Select Pressures Included in Report

Pressures...

oK Cancel

Dubinin Reports

Field or Button Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-
ives and their values are shown. Up to eight adsorptive and adsorbate
property factor combinations may be specified.
= Dubinin Adsorptive Options E‘E]@
Affinity
Adsorptive Cog;ﬁt:)ent
L 0.33000
z 0.26700
o S——T
s ] oo
s -] ooww
R
s <] oo
Fitted Relative Pres- Enter the minimum and maximum limits for Radushkevich or Astakhov
sure Range relative pressures included in the line fit.
[group box]
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[M] micromeritics’

Dubinin Reports (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

aaaaaaaa

dddddddd

10000000000

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Report Type
[group box]

Select report types. If Astakhov is selected, either select Optimize expo-
nent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Dubinin Report Options

DUBININ PORE VOLUME REPORT OPTIONS

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list

box, then click Edit.

This option plots differential pore volume as a function of pore width.

= Dubinin dV/dw Pore Volume Options E‘E‘@
Plot curve
Plot points
[Tl overlay samples
Autoscale x-axis 0.0 | to 1.0 |4
Autoscale y-axis 0.0000 1,000.0000 |crmdfg
Dubinin Pore Volume Reports
Field or Button Description

scale y-axis [check box]

Autoscale x-axis / Auto-

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.

Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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DUBININ TABULAR REPORT OPTIONS

In the Dubinin Report Options window, highlight Dubinin Tabular Reportin the Selected Reports list
box, then click Edit. Column [n]indicates the column order and data contents for the report.

[= Astakhov Tabular Report Column Options |EHEH§|
Column 1: [Absoluhe Pressure v]
Column 2: [Relaﬁve Pressure v]
Column 3: [Quanﬁty Adsorbed v]
Column 4: [Log Quantity Adsorbed v]
Column 5: [Log (©°/o)*n v]
Column &: [dvfdw Pore Volume v]

Log (p°/p )*n. The value for [n] is the optimized exponent if Optimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n]is the entered exponent value.
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Ei micromeritics’ Dubinin Report Options

DUBININ TRANSFORMED ISOTHERM PLOT OPTIONS

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

= Dubinin Transformed Isotherm Plot Options =0 @
[Tl overlay samples
Autoscale x-axis 0.000000 1.000000
Autoscale y-axis -1.35052 1.64948

Dubinin Transformed Isotherm Plot Reports

Field or Button Description

Autoscale x-axis / Auto- | Select an option to have the x- and/or y-axes scaled automatically.
scale y-axis [check box] | Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.

Overlay Samples Use to overlay sample files on the plot.
[check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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F-RATIO METHOD REPORT OPTIONS

The ~Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

[= f-Ratio Method =3
Reference Isotherm
Select Reports
Tabular report
[¥] fPlot
[Tl overlay samples
From To
Autoscale x-axis 0.000000000 || 1.000000000
Autoscale y-axis 0.0000 1,000.0000
Select Pressures Induded in Report
f-Ratio Reports
Field or Button Description
Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.
x
Absolute Relat Quantity | Exdude | ~ erange
"o Topy | i [ 00000000 Jie®
E [m] 5 o
e e i [ roomomnlow
3 9.8735074| _0.099261497] 143247 1
4 123613846 0.124180567 148788 L[]
s 14.8089733| 0.148779449 153535 OO
3 17.3051878| _0.173767776 15925 1
7 19.8402248| 0.199258182| 1eass0| 1
s 22.3403148| 0.224445978 10122 [
B 24.8202017| 0249280026 17sse0| 1 s
0 | 27.350491| oomsisrs|  sesess| 1 Excude Al
1 | messess| omsies| sem O |,
o
Enter a value between 0000000000 and 1.000000000.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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f-Ratio Reports (continued)

Field or Button Description

Reference isotherm Browse to select a sample file to use as a reference for the isotherm.

[group box] Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

Selected Reports Tabular Report. Use to have a tabular report of data generated.

[group box]

f-Plot. Use to generate a normalized isotherm.

« Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

« Overlay samples. Use to overlay sample files on the f-plot.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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[M] micromeritics®

FREUNDLICH REPORT OPTIONS

The Freundlich Isotherm is an empirical isotherm used to model low-pressure adsorption data. It can
also be applied to model some micropore isotherms. In the Selected Reports list box, highlight

Freundlich, then click Edit.

[E=EcH 5| = mon
Caleulati
[] specify monolayer capadty F‘\jr:: Analysis [ Sperity the monalyer capaity.
D | Repeat Analysis Gt
Select Reports DI =me
SclectReparts
[¥] Tabular repart clectteper
[ Tasuar report
Freundlich Transform plot
B . ; |#|Freundlich Traneform plot
Owverlay samples
From To [T (werlay sampes rrom o
(LIRS 2 = [¥] Autoszalz x-axis 2 13450
Autoscale y-axis 2.6495 ] Autoszalz y-anis 26455
[ Freundiich Tsotherm plot |~ |Freundiich Isetherm plat
Overlay samples Erom To Uverlay sampes From To
Autoscale x-axis 0.
Autoscale y-axis 44.61477
Sclect Prassurcs Induded in Repart
Select Pressures Induded in Report
Physical Adsorption Chemical Adsorption
Freundlich Reports
Field or Button Description

Difference. Plots the difference between the analysis and repeat
analysis lines.

First Analysis. Includes a line fit plot for the primary analysis.

Repeat Analysis. Includes a line fit plot for the secondary analysis.

Calculations [group box] | Select from the various calculation options.
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Freundlich Reports (continued)

Field or Button

Description

Pressures [button] [3

Use to select a pressure range for report calculations and points for
exclusion from calculations.

'~ Calalation pressure range

Mirimum; 1000000000 | P/
Maximums 1.000000000 | P/P*

Quantity | Exdude
)
(mmol /g)
| oo e

7.3755024|  0.074152801| 137386

9.8736074| 0099261407 1.43247)
12.36138%| _0.124189567] _1.48783|
14.8089733| _0.148779449|  1.53535|
17.3061878| _0.173767776| __ 1.59265|
19.8402298| 0.199258182]  1.64880)
223%03148| 0204445978 170129
248202017| 0.249280026| 175560
27.350%91| 0.274815744 181455
29.8154199| 0299612489 187374

oo |ufo|n|s|w|n

Include Al

Exclude Al

100000000000

o

Enter a value between 0.000000000 and 1.000000000.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Pressures [button] [&

Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Selectto exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.
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[M] micromeritics®

Freundlich Reports (continued)

Field or Button

Description

Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.

« Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

« Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

« Overlay samples. Use to overlay sample files on the Freundlich iso-
therm plot.

Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.

« Autoscale x-axis. The x-axis field shows the absolute pressure.

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

« Overlay samples. Use to overlay sample files on the Freundlich
transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Horvath-Kawazoe Report Options

HORVATH-KAWAZOE REPORT OPTIONS

The Horvath-Kawazoe method plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

[Mi Horvath-Kawazoe Report Options

L= E ]

Pore Geometry

(@) slit (original H-K)
(O Cylinder (Saito-Foley)

() sphere

() entered

["] Apply Cheng-Yang correction

"] smooth differentials

Select Reports

[«]H-K Tabular Report
[#] Cumulative Pore Volume
[]dv/dw Pore Volume

Select Pressures Included in Report

Pressures...

OK

Interaction Parameter

(@ Computed
2.84e-43 erg-cm”™4

3.400e-43

Properties...

Edit...

Cancel

Horvath-Kawazoe Reports

Field or Button

Description

Apply Cheng-Yang cor-
rection [selection]

Use to apply the Cheng-Yang correction to the pore size analysis. This
correction substitutes the Langmuir equation of state for Henry’s Law
in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display the
Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties window
is edited.

Entered. Calculates using the value entered in the text box.

Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.
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[M] micromeritics®

Horvath-Kawazoe Reports (continued)

Field or Button

Description

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Properties [button]

Click to view or edit the constants describing the physical properties of
the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in the Diameter and Diameter at zero energy
text fields may be edited.

« Density. Enter the density per unit area of the sample. *

« Description. Select the name of the sample used in the analysis.

« Diameter. Enter the diameter of the sample atom.

- Diameter at zero energy. Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 x diameter.

« Magnetic susceptibility. Enter the magnetic susceptibility of the
sample. *

« Polarizability. Enter the polarizability of the sample. *

Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If using
Entered, only the values in the Diameter and Diameter at zero energy
text fields may be edited.

« Density. Enter the density per unit area of the adsorptive. *
« Diameter. Enter the diameter of the gas phase atom.
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Horvath-Kawazoe Reports (continued)

Field or Button Description

« Diameter at zero energy. Enter the diameter of an atom at zero
interaction energy: (2/5)1/6 x diameter.

« Magnetic susceptibility. Enter the magnetic susceptibility of the
adsorptive. *

« Mnemonic. Selectthe mnemonic of the adsorptive gas in use.

« Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports Select the types of reports to generate. Highlight the report, then click
[group box] Edit to modify report parameters.

Smooth Differentials Use to smooth all differential calculations, thus eliminating variations in
[selection] the differential computation caused by noise in the input data.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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HORVATH-KAWAZOE PLOT OPTIONS

f See al
[~ ee also:
L

X 5% BJH Plot Options on page 8 - 10 for additional information on fields and buttons for
this report.

\

= Horvath-Kawazoe Cumulative Pore Volume Options E =] @
Plot curve Plot points
X-Axis
Autoscale 0.0 | ke 10| &
Y-Axis
Variable: [Cumulaﬁve Pore Volume ']
Overlay: [dv/dw Pore Volume > ]
Autoscale 0.0000 | to | 1,000.0000 | crm3fg

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

HORVATH-KAWAZOE TABULAR REPORT OPTIONS

(= HK Tabular Report Column Options | = || & |[s£3]
Column 1: [Absolute Pressure v]
Column 2: |Relative Pressure -]
Column 3: [ guantity Adsorbed ~|
Column 4 [pore Width ~|
Column 5: [ cumulative Pore Volume -]
Column 6: | 4y jdw Pore Volume -]

Highlight H-K Tabular Reportin the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.
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ISOTHERM REPORT OPTIONS

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

[ isotherm Report Options = == [ 1sotherm Report Options E@
Select Reports Tabular Options
[¥] Tabular report Weight % [Eahe
/| Linear piot | opters... /| Elapzed tme =
] Tene between puints Analysis Plot curve
Logarithmic plot Repeat analysis Plot points
Linear Absohute pk Plat Options [“] overlay samples
] Plot adsarption s
Logarithmic Absolute plot : Hotods )
[¥#]Plot desorption @ Linear  (7) Logarithmic
[T Pressure Compesition plot t 7| Plot overlays From To
Quantity Adsorbed Autoscale x-axis 0,0000000 || 133.3224000
@ Per gram Per BET Surface Area Per other Surface Area Autoscale y-axis 0.00000 446.14774
x —
Physical Adsorption Chemical Adsorption
Isotherm Reports
. D . t.
Field or Button escription

Autoscale [check box] [g Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Options [button] [ Click to display related linear plot options. All plot windows contain
identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.
Plot Data [check box] [#] | Select each option to include in the final report.

Plot Options [group box] | Select the types of isotherm to plot.
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Isotherm Reports (continued)

Field or Button Description
Quantity Adsorbed Select how to report the quantity adsorbed.
[group box] [d

« pergram (cm3/g) STP
« per BET Surface Area (cm3/m?2) STP or mmol/g
« per other Surface Area (cm3/m2) STP or mmol/m?2

Selected Reports Select each option to include on the final report. Click the Options

[group box] [& button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options Select the options to include on the report.

[group box] [d

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure

composition.
Tabular Report Select to include tabular data in the report.
[group box] [«
X-axis [group box] [« Indicate if the x-axis should be in linear or logarithmic format.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

MicroActive ASAP 2020 Operator Manual

8-38 202-42804-01 (Rev -) — Feb 2019



Ei micromeritics’ Langmuir Report Options

LANGMUIR REPORT OPTIONS

The Langmuir calculation determines the surface area of a sample by relating the surface area to the
volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

[ Langmuir Surface Area Report Options L= LE S| 23 Langmuir Repor Options == Eem
Select Pressure Range for Langmuir Fit Caleulstions
] First Arnalysis = ;
ey 01350240 1P i | uissocatve Chemsorpton
] Repeat Anaysia
[ bifferenze
Select Reports
sdectReports
V] Tabular report
] Tanular redort
7] Langmui Transform plot
¥ Langmuir Transform piot
Querlay samples
From To [ overlay samples
7] Autoscale x-ais 0.000000 D.133322 From T
] Autoscale y-ais [¥] Autoscale xexis 0.0000000 | | 123 3224000
[¥] Autoszale y-ade 0000 | [ 298830158
Langmui Isotherm plot
TLangmur isotherm Clot
ay samples
From L) Uverlay sancles
Fom T
Autoscale xeaxis 03000000 | 133 3224000
Autoecale y-sxi 000000 1€, 11771
Select Pressures Induded in Report
Select Pressures Induded inReport
Pressures...
Piessur s,
Enter 2 value between 0.0000000 and 133.3224000.
e —

Langmuir Reports

Field or Button

Description

Calculations [group box] [

Select one or more of the calculation options to be used for
analysis.

Pressures [button] [®§

Use to enter a range of pressure points to be included in the
report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and
maximum pressures to be used in the pressure table.

Exclude All. Selectto exclude all pressure points in the
table.

Include All. Select to include all pressure points in the table.
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Langmuir Reports (continued)

Field or Button Description

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.

Pressures [button] [d This option is available when the sample file has a status of
Analyzing or Complete. Use to enter a range of pressure
points to be included in the report or to modify table values for
pressure points.

Calculation pressure range. Enter the minimum and
maximum pressures to be used in the pressure table. To
exclude a point from the calculations used to generate the
report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use
the table or interpolated data. This option is available for BET
and Langmuir reports only.

Select Pressure Range for Enter values to indicate the fitted pressure range.
Langmuir fit [group box]

Select Reports [group box] Langmuir Isotherm Plot. Uses the Langmuir monolayer
volume and constant to produce an isotherm.

» Autoscale x-axis. Linear x-axes begin at zero. The x-axis
field shows the absolute pressure for Langmuir.

« Autoscale y-axis. The y-axis field shows the quantity of
gas adsorbed.

« Overlay samples. Use to overlay sample files on the Lang-
muir isotherm plot.
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Langmuir Report Options

Langmuir Reports (continued)

Field or Button

Description

Langmuir Transform Plot. Use to generate a traditional
Langmuir surface area plot used to determine monolayer
volume constant.

Autoscale x-axis. Linear x-axes begin at zero. The x-axis
field shows the absolute pressure for Langmuir.

Autoscale y-axis. The y-axis field shows Langmuir trans-
formation.

Overlay samples. Use to overlay sample files on the Lang-
muir transform plot.

tons on page 2 - 3.

/ For fields and buttons not listed in this table, see Common Fields and But-
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MP-METHOD REPORT OPTIONS

The MP-Method Report Options provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go to Options

> Units to specify the unit.

[5i MP-Method Report Options E@
Thickness Curve Select Reports
(@ Harkins and Jura []MP Tabular Repart
[[]cumulative Fare Volume
Opalsey [ dv/dw Pore Volume B
[]cumulative Pore Area
Edit... []da/dw Pore Area
Select Pressures Included in Report
Pressures...
OK Cancel
MP-Method Reports
. D . .
Field or Button escription

Pressures [button]

Use to select a pressure range for report calculations and points for
exclusion from calculations.

— T Cauiaton presare ange
== Gy | omora)
e[ e e

S e

sho009720| 0079w Lwsss

S e

e e o

e e

Quantity
Adsorbed

000000000 | P/P°

Indude All

o @[~ o fon|s]u|n -

Exclude Al

lDOoO0ooooooog

=

Enter a value between 0.000000000 and 1.000000000.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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MP-Method Reports (continued)

Field or Button Description

Select Reports Select the reports to generate. Highlight the report, then click Edit to
[group box] modify report options.

Thickness Curve Select the thickness curve, then click Edit to modify the values in the
[group box] equation for the selected curve.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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MP-METHOD PLOT REPORT OPTIONS

In the MP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

= MP-Method dV/dw Pore Volume Options [ = |[ & |[23]
Plot curve Plot points
X-Axis
Autoscale 0.0 | ¢ 10| &
¥-Axis
Variable: [dv/dw Pore Volume 'I
Overlay: [None - I
Autoscale 0.0000 | to | 1,000.0000 | cm¥fo-&

MP Method Plot Reports

Field or Button

Description

Overlay [drop-down box]

Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box]

Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box]

Autoscale. Use to have the y-axis autoscaled or enter beginning and
ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and But-

/

tons on page 2 - 3.
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MP-METHOD TABULAR REPORT OPTIONS

In the MP-Method Report Options window, highlight MP Tabular Report in the Selected Reports list
box, then click Edit. Column [n]indicates the column order and data contents for the report.

r
E MP Tabular Report Column Options \ = H =] || 2 \
Column 1: Pore Hydraulic Radius Interval
Column 2:  Average Pore Hydraulic Radius
Column 3; [Incrememal Pare Volume V]
Column 4: [Curnulaﬁve Pare Volume "]
Column 5: [dld[dw Pore Wolume ']
Column &: [Inn'ernemal Pore Ares "]

/ The MP Method reports hydraulic radius only. If Pore size in diameter is selected on the
Unit Selection window, pore size in radius will be reported.
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NLDFT ADVANCED PSD REPORT

The NLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option and more. The NLDFT report compares two sample files. The models that can be
selected are restricted to only those models which have the same analysis temperature and analysis
gas as the sample file that is open. For instance, if the sample file was analyzed with N2 at

77 degrees Kelvin, then only the N2 DFT models at 77 degrees Kelvin will be available in the Mode/
drop-down list.

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data points,
choice of model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used the
same sample material as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The advanced
DFT calculation takes the data from both sample files and combines all this data into a more accurate
calculation of the pore size distribution. More accurate means getting the pore distribution at smaller
pore sizes (a few Angstroms) as well as larger pore sizes (one thousand Angstroms).
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NLDFT Advanced PSD Report

using the Select button. A second model must also be selected. Use the options next to

/ To make a successful Advanced calculation, a second sample file must be selected

the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isotherm will appear in the isotherm plot
(lower right) as well as a second curve-fit. As the selection of points is adjusted, the DFT
editor will recalculate the PSD results and also recalculate the two model curve fits.

Lo ek

000-025
Geometry: sit

Model [

No file selected,

siit Select.

Reguiarizaton: [ 000000 - 0.20000

EREEEEER:
28 g

elect Pressures Incuded in Report

Pressures...

T

NLDFT Advanced PSD Reports

Field or Button

Description

Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box]

Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user) is
selected, enter a number in the text box giving a relative mass for the
smoothing during deconvolution. Larger values produce more

smoothing.

Select Reports
[group box]

Use to select the second sample file.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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To run the NLDFT report:

1. Goto File > Open. Select a sample file with a Complete status, then click Open.

2. Inthe drop-down list at the bottom of the window, select NLDFT Advanced PSD. Graphs for
the first sample file display and the sample description shows as the first group box title in the
upper right corner of the window.

First selected
o= sample file

Cumulative Pore Volume vs. Pore Widih

| —

Second
selected
— sample file

a. Selectthe Geometry and Model from the drop-down lists for the first sample file.

b. To selectisotherm data points for calculation for the first sample file, ensure the option to
the left of the first sample file description is selected. Slide the two blue bars on the iso-
therm graph to select data points. Without a second sample selected, the report will per-
form a single model DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, click Select to locate and open the second
sample file with a Complete status. Graphs for the second sample file display and the sample
description will display as the second group box title in the upper right corner of the window.

a. Selectthe Geometry and Model from the drop-down lists for the second sample file.

b. To selectisotherm data points for calculation for the second sample file, ensure the option
to the left of the second sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Data are automatically calculated for both sample
files.

c. Click Edit to make any necessary modifications to the second sample file.
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Cumulative Pore Volume vs. Pore Width © Sample: carbon 1012 with CO2 @0C.
n 2 L
= i & 3 oSk (co2@273 Carbon, NpFT
i j*’* £
g s
8 % Vs amoe: C-1012 Ntrogen miropore 77K
5 i t
/j £ U R | | T
& ﬁ P ans Mo (2 @77 on Carbon Sit Pores by MLDFT ]
0. ! 1
] ® = .
4 SR R T
AN |
it
2

Goodness of Fit vs. Regularization Isotherm
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OPTIONS REPORT

Physical Adsorption

Lists the conditions used to perform the analysis— such as:

« Adsorptive properties

« Analysis conditions

« Analysis method

» Degas conditions

« Free space

« Saturation pressure (P) and temperature

/ Options reports cannot be edited.

Chemical Adsorption

Produces a printed report of a predefined collection of sample file parameters. If Automatically
collected is selected in the Type of Data group box on the Sample Description tab, the following
information is reported:

« Task Summary. Lists conditions specified for each task selected.

« Analysis Task Options. Details conditions specified for the analysis task.

« Experiment Log. Identifies actual conditions under which each task transpired.

« Leak Test Results. Identifies outgas rates and the outcome for each leak test performed.

SAMPLE LOG REPORT
This report provides information on:
« Manual control operations performed during analysis.

« Information entered using Add Log Entry on the sample file editor.
« Warnings and/or errors which occurred during analysis.
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SINFELT AND DIFFERENCE METHODS FOR CHEMICAL ADSORPTION

The Difference Method Report and the Sinfelt Method Report windows are identical unless
otherwise specified.
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SUMMARY REPORT OPTIONS

The Summary Report for physical adsorption analyses provides a condensed summary of selected
data results.

‘Summary Report Options [E=nEon =

Dubiin Radushesih

9] Moncayer cpacity

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/p° field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Summary Report

Field or Button Description

Item [n] [selection] Use to enable the first Pass/Fail item. Until the Summary Reportis
selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

Pass/Fal Options
Pore Volume
Adsorpton total

Surface Area
© Single-point 8ET

Mut-point BET

© D+ desorption avg.
pore width (4V/4)

S A: Single-point BET. Use to enable Pass/Fail [n] inthe ltem [n]
group box.
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Summary Report (continued)

Field or Button Description

Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper/Lower, enter operator instructions to be
displayed if a failure is encountered.

Select All / Deselect All | Selects (or deselects) all options.
[button]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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T-PLOT REPORT OPTIONS

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves to
be a valuable way of characterizing complex mixed materials.

1 -5t Repert Optons =

SelectReperts
[7] Tabudar report.

|t
[Tl overiay sanples

7] Actosc:
V] avtosc:

Seisct Pressures Induded inRport

Precauree..

t-Plot Reports

Field or Button Description
Fitted thickness range Enter the minimum and maximum thicknesses (in angstroms or nano-
[text box] meters) to include in the thickness curve. Go to Options > Units to
specify default units.
Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.
L omea] ] e EM o e
e e e O
s 14.8089733|  0.148779449 1s3s35) [
B3 17.3061878| _0.173767776 1se2es| [
7 19.8402248|  0.199258182] 1e4s0| [
8 22.3403148|  0.224445978 1m122) O
B 24.8202017| _ 0.249280026 v7sss0) 1 Include All
0 27.3504691|  0.274815744| 181955 O Exclude Al
1 29.8154199|  0.29961248% 1.87374] E .
Cancel

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from the
calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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t-Plot Reports (continued)

Field or Button

Description

Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.

« Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.
« Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

= Entered t-Curve = @ ][=]
Name: User-Defined
1 0.000000001] 1.0000 e
[ cear
(L Append |
Open... |
Save As... |
[« ] Cance
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t-Plot Reports (continued)

Field or Button

Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated by
a space or a tab.

t-Plot [check box]

Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the -plot.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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Temkin Report Options

TEMKIN REPORT OPTIONS

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly

with increasing coverage.

(=== 7] Specify monolayer capacity
Specfy monolayer capacity.
0446 heat of adsorption at
Select Reports
Selact Reports. Tabular report
[ Lo repert Temkin Transform plot
| Transform plot | overlay samples
L= From Te Autoscale x-axs
V] Autoscale x-axis 2.01493 Autoscale y-axis
[ Temkin Isotherm plot
Tekin Esotherm plot Overlay samples
° From Te
Select Pressures Included in Report
Select Pressures Induded in Report
Pressures...
= =
o
Physical Adsorption Chemical Adsorption
Field or Button Description

Calculation [group box]

Select one or more of the calculation options to be used for analysis.

Pressures [button] [g

Use to select a pressure range for report calculations and points for
exclusion from calculations.

== T = s of
,,,,,,,,,,,,,, o
&Pa) /%) (mmol fg)
2 07597 o0seoras| 13z LI
2 7.3755024| _ 0.074152801 v37ss| [
3 9.8736074|  0.099261497| 143247 [
4 123513846 0.124189567] vas7es| [
s 14.8089733|  0.148779449 1s3s35) [
s 7.3061878| 0.173767778|  wsees| ]
7 19.8402248|  0.199258182] 1e4s0| [
8 22.3403148|  0.224445978 1m122) O
B 24.8202017| 0.249280026 17sse0| [
10 27.3504691|  0.274815744| 181455 [
1 | msisess| oosseisss| isrrel O |
e
e

Calculation pressure range

Mirimum; 1000000000 | P/
Maximums 1.000000000 | P/P*

Include Al
Exclude Al

Calculation pressure range. Enter the minimum and maximum

pressures to be used in the pressure table.To exclude a point from the

calculations used to generate the report, select Exclude.
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
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Temkin Reports (continued)

Field or Button Description

Pressures [button] [& Use to enter a range of pressure points to be included in the report or
to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

Exclude All. Selectto exclude all pressure points in the table.
Include All. Select to include all pressure points in the table.

Line fit pressure range. Enter the minimum and maximum
pressures for line fit.
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Temkin Reports (continued)

Field or Button Description
Select Reports Tabular Report. Generates a tabular report of the included samples.
[group box] A tabular report contains the numeric values contributed by each

sample.

Temkin Isotherm plot. Overlays the Temkin isotherm with the
analysis data.

« Autoscale x-axis. Linear x-axes begin at zero. The x-axis field
shows the absolute pressure.

« Autoscale y-axis. y-axes begin at zero. The y-axis field shows the
quantity of gas adsorbed.

« Overlay samples. Use to overlay sample files on the isotherm plot.

Temkin Transform plot. Plots a linear form of the Temkin transform
plot.

« Autoscale x-axis. The x-axis field shows the logarithm of pressure
(In).

« Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

« Overlay samples. Use to overlay sample files on the transform
plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface cov-
erage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter the monolayer capacity of the sample.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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VALIDATION REPORT OPTIONS

This report allows data to be examined by the analysis program to determine if the results are within
typical ranges. If the data for any reports selected for validation are determined to be out of range, a
warning will display and suggestions are given for corrective action. This information is detailed in the
report and plotted on the graph as a unique plot symbol.

(o] ]

"

[ 1sotherm

[“|eeT

[ Langmuir

[ Freundiich

[ Temkin

[ tPlot

[] fRatio Method
["]BIH Adsorption
|:| BJH Desorption
[71DH Adsorption
[ D+ Desorption
[T Horvath-Kawazoe
|:| DFT Pore Size
["|DFT Surface Energy
[~ bubinin

71 MP-Method

m
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9 DIAGNOSTICS

Unit [n] > Diagnostics

Use to display diagnostic readings, start and schedule diagnostic tests, and open saved diagnostic
reports. Each test generates a file to the default directory name and path of ...\...\Service\userdiag
unless another directory name was specified. These reports can be sent to a Micromeritics Service
Representative for examination.

START DIAGNOSTIC TEST

Unit [n] > Diagnostics > Start Diagnostic Test

Provides a method to start a diagnostic test immediately. Upon completion of the diagnostic test, the
file is saved as a .REP file which can be retrieved by going to Reports > Open Report and

selecting the report file.

Test to run unattended on a weekly basis. These tests check for system leaks and

/ It is recommended to schedule the Analysis Manifold Leak Test and the P Port Leak

require no operator intervention.

The Py Port Leak Test should only be run if the Psat tube is attached. If a vapor source is
attached, this test should not be run.

[E=REcE ]

Opesator: Sequence:
Comments

Start Diagnostic Test

Field or Button

Description

Comments [text box]

Displays comments from the selected diagnostic test.

Estimated time (min.)

Approximate time for test completion.

File [group box]

Shows a status bar of steps complete once the test begins.

Next [button]

Starts the next test.
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Start Diagnostic Test (continued)

Field or Button Description

Operator [text box] Enter information to identify the person running the service test.
Repeat [button] Repeats the selected diagnostic test.

Report after test Automatically generates reports to the selected destination when the
[check box] testis complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SCHEDULE DIAGNOSTIC TESTS

Unit [n] > Diagnostics > Schedule Diagnostic Tests

Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A separate
list of tests is saved for each of the possible test frequencies. Tests are categorized and flagged as
requiring intervention or not. If tests requiring intervention are scheduled, the operator has the option
of omitting the tests if the operator does not respond within a specified time after an initial prompt is
displayed and before the test is started. Events are logged in the analyzer log for all starting, ending,
and omitted tests.

Schedule Diagnostic Tests

Test Frequency
Once (Today)

) Daiy
DWeekly  Day: sunday

Start test sequence if instrument is idle any time between

00:00:00 + and 00:00:00

Avaiable Tests: [ st o i — v [ Insert

Test Sequence

File Identification Est. Time (min.) Intervention Regq.

Marked tests require operator intervention to run.
[T skip these tests if the operator does not respond within | 15 minutes,

Schedule Diagnostics Test Frequency

Field or Button Description

Available Tests Select one or more tests to run unattended.
[drop-down box]

Insert [button] Inserts the selected test in the Available Tests drop-down list.

Skip these tests if the Check this option if any test requiring operator intervention should be
operator does not omitted if the operator does not respond within the specified time.
respond within [n]
minutes [check box]

Start test sequence if Enter a from and to time for an unattended test to begin if the instru-
instrument is idle any ment is idle at any time during the entered time frame.

time between 00:00:00
and 00:00:00 [text box]

Test Frequency Select how often the test is to run unattended.
[selection]
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Schedule Diagnostics Test Frequency (continued)

Field or Button

Description

Test Sequence
[group box]

Provides the test file identification and estimated run time. A
checkmark in the /ntervention Required column indicates that operator
intervention is required.

To remove a test from the sequence, select the test, then click Delete.

To add a test to the test sequence, highlight a row in the Test
Sequence box, select a test from the Available Tests list, then click
Insert.

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

DIAGNOSTIC TEST REPORT

Unit [n] > Diagnostics > Diagnostic Test Report

Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, and monthly. Diagnostic test report files have a .SVT file extension and are stored in the

...\Service directory.
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Save Files for Problem Diagnosis

SAVE FILES FOR PROBLEM DIAGNOSIS

Unit [n] > Diagnostics > Save Files for Problem Diagnosis

Use to compress pertinent diagnostic information into a single zip file. This file can be sentto a

Micromeritics Service Representative for problem resolution.

Save Files for Problem Diagnosis |

L

Follow these instructi

iructions to send the problem description and
problem files to Micromeri Support:

Customer Supp

1. Complete all fields on this s The Comments field is
us tion th ful to the

not connected

ostics-[date] zp is created.
\\\\\ presse ation from this screen, the
fles) you added, and other system fies.

5. Click Save,

From a computer with internet connection, go to
http:/techsupport. micromeritis. comportal to access the
Micrameritics Customer Suppart Center,

7. Either logn or register
8. Click the Requests tab,

9. Click the New Request button and complete all fiekds on the
eeeee

10. To attach the zipped file, cick the Attach Fil(s) ink and select
the Diagnostics-[date] 2ip fle

11. Click the Add request button to submit the problem request.

12, Retur to the portal to track the progress of the problem
solution.

Email address:

Include Fies:

oK

] [ Concel

1. Complete the form. A default file named Diagnostics-[date].zip is created unless another file
name is specified.

NOoOORA®N

Click the Requests tab.
Click New Request, then complete all fields.

To attach the zipped file, click the Attach File(s) link, then select the Diagnostics-[date].zip file.
Click Add Request to submit the problem request.

Return to the portal to track the progress of the problem solution.

When the file is saved, log in to the customer portal.

Save Files for Problem Diagnostics

Field or Button

Description

Comment [text box]

Enter information that would be helpful to the Micromeritics rep-
resentative. If the computer is not connected to the internet, complete
this field. If the computer is connected to the internet, this information
can be completed on the Micromeritics Customer Support portal.
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[M] micromeritics®

Save Files for Problem Diagnostics (continued)

Field or Button

Description

Include Files Add. Click to select additional files to send with this problem diagnosis.
Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

Clear. Click to clear all files from the Include Files box.
Save As [button] Click to specify the name and location of the compressed file. Make a

note of the file name and location. This file will need to be sent to your
Micromeritics representative for problem resolution.

Micromeritics rep-
resentative [text box]

Enter the name of your Micromeritics representative. This information
will remain on the window each time files for problem diagnosis need
to be submitted (can be modified as necessary).

User Information
[text box]

Enter information for the person to be contacted by a Micromeritics rep-
resentative. This information will remain on the window each time files
for problem diagnosis need to be submitted (can be modified as neces-

sary).

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

SHow ALL READINGS

Unit [n] > Diagnostics > Show All Readings

The Show All Readings window displays the calibrated and nominal readings of all sensors in the

system.
o=
sssssssss
Sl les) e A
e
Pressges [ | Po:  759.10 mmHg
1000 mmHg: 760.00 mmHg
10 mmHg: 7.6000 H Vacuur
0.1 mmHq 0.076000 H facuum: 12 pmHg
P 759.10 H
mmmmm Te ratures
mmmmmmmmmmm Manifold Temperature: 29873 K
2984 K
S Z2
rifold Temperatur °c 08.1 K
10.0 Kjmin
Physical Chemical
Adsorption Adsorption
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10 CALIBRATION

/ Service Test Mode is required for this test. See Service Test Mode on page 12 - 8.

A calibration file was created specifically for the analyzer and included with the accessories. It is not
necessary to recalibrate the system unless it seems out of calibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

CALIBRATE FURNACE RESISTANCE

Unit [n] > Calibration > Furnace Resistance C

Calibrate Furnace Resistance @

Furnace resistance: E ohms

Warning: Changing the calibration information will affect
the performance of the instrument. Only qualified service
personnel should do this.

0K ] [ Cancel

Enter a value between 3.0 and 3.9,

Calibrating the furnace resistance will affect the performance of the instrument. Only
qualified service personnel should perform this operation.

Use this feature to calibrate the furnace resistance. Enter the ohms, then click OK.
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CALIBRATE PRESSURE ZERO

Unit [n] > Calibration > Pressure Zero

This procedure evacuates the system and zeroes the pressure transducers. This calibration should
only be performed by qualified service personnel. In order to perform this procedure, sample tubes
must be attached to each port.

The system automatically zeros the transducers before an analysis begins. Therefore, this
procedure may not need to be performed unless operating the system in manual mode. If Include P
transducer is selected, the P port will be evacuated and the transducer zeroed with the analysis
manifold transducers.

fol[ OS]

Warning: Changing the calibration information will
affect the performance of the instrument. Only
qualified service personnel should do this.
Incdude Po transducer
Press the start button to evacuate the system and
then zero the pressure transducers.

Start Cancel
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LoAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File

Use to load a previously saved calibration file.

Itis recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration file,
a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each
time a new one is created.

/ Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from File menu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension
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11 HARDWARE

CoLD TRAP OPTION

CoLD TRAP DEWAR INSTALLATION

;;ih See also:

___{__f:@_ Dewar Precautions on page 6 - 1

A Cryogens can cause frostbite injury. Wear safety glasses and insulating gloves when
handling cryogens.

Cold trap dewar
hanging bracket

Dewar cover with
holes for cold trap
tubes

Cold trap
dewar

1. Fill the cold trap dewar with a cryogen (such as liquid nitrogen) to approximately 2 in. (5 cm)

from the top.
2. Place the cold trap dewar below the cold trap tubes and gently slide the dewar up around the

cold trap tubes.
3. Hang the bracket on the top of the dewar onto the bracket behind the cold trap tubes.

4. Theinsulated dewar cover has a slot and two holes for the cold trap tubes. Gently open the
slot and slide the dewar cover around the two cold trap tubes.
5. Hang the safety shield around the cold trap dewar.
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CoLD TRAP TUBE INSTALLATION

/ Port
. ~—— O-ring
“~~Connector nut

Glass tube
A/

./

1. Remove the cold trap connector nut and O-ring.

2. Place the cold trap connector nut and O-ring on the cold trap tube.

3. Slide the cold trap tube up around the metal tube and secure it with the O-ring and connector
nut.

MicroActive ASAP 2020 Operator Manual
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FURNACE

CHEMICAL ADSORPTION PORT ASSEMBLY

Bracket mounting
holes

Valve / fan connector

Sample thermocouple
connector

Gas flow meter connector

[
-
o
.

L

1. Locate the two bracket mounting holes on the elevator panel. If there are screws in the mount-
ing holes, remove them.

2. Position the chemical adsorption port assembly behind the P tube and align the two holes on
the back of the furnace assembly shelf with the two mounting holes on the elevator panel.

3. Insert thumb screws into the mounting holes. Turn the screws clockwise and tighten with a
flat-blade screwdriver.

Chemical adsorption
port assembly

Mass
spectrometer
connection S:Ir\lgti}crftatr?
port
Bracket /
mounting
screws

Connect to sample
thermocouple port

[ PN

Connect to
gas flow meter port

4. Attach the fan cable to the Valve / Fan port. If connecting the electronic trigger signal to a mass
spectrometer, the Mass Spec Interface Cable (part number 202-60815-00) should be used. It

MicroActive ASAP 2020 Operator Manual 1-3
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has a 25 pin D connector for the mass spec electronic trigger signal in addition to the valve and
fan signals.

5. Attach the sample thermocouple cable to the Sample Thermocouple port.
Ensure that the exhaust port is properly connected to safely exhaust hazardous gases.
7. Attach the gas flow tubing to the Gas flow meter port.

o

ATTACH THE FURNACE

nace for cooling. The air pressure should be well regulated and adjustable at pressures

/ A supply of dry, clean, house / compressed air should be available to attach to the fur-
less than 20 psig at the outlet.

1. Place and center the furnace on the elevator.

2. Insertthe furnace power cable into the power connector. Twist the power cable to lock into
place.

3. Connect the furnace thermocouple plug to the Thermocouple connector.
4. Connect the cooling gas tube to the Cooling Gas connector.

Furnace assembly

Cooling gas connector

Thermocouple connector

Power connector

5. Connect a hose from the house / compressed air supply to the furnace cooling gas inlet loc-
ated on the side panel of the analyzer.

Ensure the supply gas is set at 5 psig (35 kPag). If the pressure is below 3 psig (20 kPag) or
above 10 psig (70 kPag), the furnace controller may not be able to control the stability of
ramping, or may be unable to cool the furnace within a reasonable amount of time.

Do not allow the pressure to exceed 20 psig (140 kPag). Pressures higher than 20 psig
may cause the internal tubing fittings to fail.
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6. Connect an exhaust hose to the Exhaust Hose port on the right side panel. The exhaust must
vent safely to an exhaust hood or other venting system.

HEATING MANTLE INSTALLATION

A Ensure there is no isothermal jacket installed on the sample tube. The heating mantle
will melt the isothermal jacket.

Power connector and
thermocouple
connector

Heating mantle
clip

1. Ensure no isothermal jacket is installed on the sample tube.

2. Insert the mantle thermocouple and the mantle power plug into the underside of the analyzer
front panel.

3. Place a heating mantle over the sample tube bulb and secure the mantle in place with a
mantle clip.
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MASS SPECTROMETER INSTALLATION

The mass spectrometer is attached to a bracket that rigidly installs on a Micromeritics chemical
adsorption analyzer.

1. Directly above the outlet side of the sample tube connector are two black rails which permit
flexibility in the position of the connector. Remove the two screws holding the outer rail and
replace it with the bracket.

2. Slide the hose of the mass spectrometer into the cylindrical cavity of the bracket and secure in
place by tightening the clamp around the cavity.

3. The small gas conducting capillary coming from the center of the larger hose connects into the
system through a port in front of the larger hose. Remove the fitting by unscrewing it and set
the plug aside.

4. The connecting capillary can be either of glass, stainless steel, or of glass protected by a
plastic tube. Insert the capillary through the fitting and place an appropriate ferrule on it. Screw
the fitting into the port.

5. Tighten the fitting securely.

SAMPLE TUBE INSTALLATION

See:

Sample Tube Installation on page 6 - 16
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12 TROUBLESHOOTING AND MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Log in to your customer portal to access error messages. Parts and accessories can be found online
at www.Micromeritics.com.

Elevator cannot be raised or lowered.

Cause: Elevator is stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Analysis valves cannot be operated.

Cause A: Circuit opened by circuit breaker.

Action A: Reset breaker (depress Breaker button) located on the right side of the instrument
beneath the tray cover. See Analyzer Components for ASAP 2020 on page 1 -
1. If the circuit breaker trips (pops out), call your Micromeritics Service Rep-
resentative.

Cause B: Cable from computer to the instrument is loose.

Action B: Ensure the cable is seated properly.

Vacuum pump gurgles continuously.

Cause A: Sample tube or cold trap tube O-ring or fitting loose.
Action A: Tighten fitting. Replace O-ring.

Cause B: Sample tube cracked.

Action B: Replace with new sample tube.

Cause C: No sample tube loaded on a selected port.

Action C: Install plug or empty sample tube.

Cause D: Gas inlet valve open while vacuum valve open.
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Action D:

On the schematic, right click on the open valve and select Close.

Vacuum gauge shows reading above 20 mmHg, even after extended pumping through
unrestricted valve with analysis or degas ports closed.

Cause A: Vacuum pump oil is low, causing ineffective evacuation.
Action A:  Add or change vacuum pump oil. Add oil to proper level according to oil level window.
Cause B: Cold trap obstructed by condensation.
Action B: Clean the cold trap tube. See Clean the Cold Trap Tube on page 12 - 12.
Cause C: Filterin portbeing used is dirty.
Action C: Replacefilter in port. See Replace Port Filters on page 12 - 14.
Cause D: Leakin vacuum plumbing.
Action D: Check and tighten all connections in vacuum plumbing, including cold traps.
Cause E: Vacuum pump powered off or unplugged.
Action E: Check pump power plug and power switch.
Cause F: The alumina in the oil vapor trap is holding moisture.
Action F: Replace or dry the alumina. Log in to your customer portal to access the Vacuum
Pump Guide.
Cause G: Filterin port being used is dirty.
Action G: Replace filter in the port. See Replace the Analysis Port Filter on page 12 - 14.
Cause H: Dry forepump needs to be serviced.
Action H: Replace the diaphragms.
12-2 MicroActive ASAP 2020 Operator Manual
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GUIDELINES FOR CONNECTING GASES

« Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Using gas line extenders
on gas cylinders located in remote areas may degrade gas quality and reduce pressure. Gas lines
are typically five to six feet long. Place the cylinders close enough to allow for proper connection at
the analyzer inlet.

« Use aretaining strap (or other appropriate tether) to secure the gas cylinder.

« Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as those
with a herringbone covering, but the line may be coated internally with a polymer.

« Long gaslines, such as those used with gas cylinders placed in remote areas, must be evacuated
for an extended period of time to remove ambient gases. When possible, avoid placing gas cyl-
inders in remote locations. It is always best to have gas cylinders located near the analyzer.

« Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling
gas lines. This will help avoid confusion when maintenance is required.

« Label the gas line at the analyzer inlet for proper identification and maintenance.

« Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

» Ensure the gas cylinder is closed before connecting to the analyzer.

To use oxygen, the analyzer must be equipped with an oxygen-compatible vacuum
pump that uses Fomblin® (or a suitable equivalent) pump oil or a dry forepump. Failure
to use the proper vacuum system could result in hazardous conditions, including fire and
personal injury.
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REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. When working with hazardous
gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may

be required.
Low pressure gauge High pressure gauge
Gas cylinder
Gas regulator shut-off valve

shut-off valve

Copper tubing \

Brass reducer

e Regulator
fitting connector nut
Regulator control
knob
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DISCONNECT THE DEPLETED GAS CYLINDER

1.

2.

Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

Disconnect the gas line from the regulator. Gas will be vented from the line. Itis not necessary
to disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately
with one of the same type.

Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be ven-
ted from the regulator.

Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

Close the regulator by turning the control knob counter-clockwise.

Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the
regulator from the cylinder.

Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and move
the cylinder to an appropriate location.
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CONNECT A GAS CYLINDER

Regulator Pressure Settings

Analyzer Series Gauge should indicate
3Flex 15 psig (103 kPag)
AccuPyc 25 psig (172 kPag)

ASAP 15 psig (103 kPag)
AutoChem 15-18 psig (103 - 124 kPag)
AutoPore 50-60psig (345 - 404 kPag)
Gemini 15-18 psig (103 - 124 kPag)
TriStar 15-18 psig (103 - 124 kPag)

Move the replacement cylinder close to the analyzer and tether it into place.

1.

Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder. Place the protective cap in a secure location. It will be needed to recap the gas cyl-
inder when it is depleted and replaced.

Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

Check for leaks at the high-pressure side of the regulator and in the connector.

a. Turn the regulator control knob fully counter-clockwise.

b. Slowly open the gas cylinder shut-off valve, then quickly close it.

c. Observe the pressure on the high-pressure gauge for approximately one minute:

« Ifthe pressure is stable, proceed with the next step.

« Ifthe pressure decreases, tighten the regulator connector nut until it becomes stable.
If the pressure does not remain stable, remove the regulator and clean all contacts at
the regulator connection, then reinstall the regulator.

Purge the air from the lines.

/ Purge the regulator before proceeding to prevent contamination of the analysis gas sup-

ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust the Pressure Control knob to approximately 5 psi.

12-6
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5. Set
a.

S0 o000

6. Ifth

Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both
gauges read approximately zero.

Close the regulator Shut-off valve to stop gas flow.

Reconnect the gas line to the regulator.

Use two 7/16 in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench fit-
ting steady and the other to tighten the connector nut.

the analyzer pressure.

Turn the Regulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure. See Regulator Pressure Settings on the previous page.
Open the regulator Shut-off valve.

Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.

Close the gas cylinder Shut-off valve.

Close the gas cylinder valve.

e gas line to the instrument inlet was previously disconnected, reconnect it now.

SET THE GAS FLOW RATES FOR CHEMICAL ADSORPTION

1. Install a chemical adsorption sample tube with filler rod on the sample port.

Do not touch the quartz sample tube with your fingers. Finger moisture and grease will
contaminate the quartz. At high temperatures, the contaminated quartz will disintegrate.

2. Openvalves 1 and 9 and allow the sample tube to evacuate for at least 10 minutes to eliminate

any

outgassing.

3. Backfill the manifold and sample tube with helium.
4. Opentheinletport, CS,5,7,9, and X.

5. Use the regulator pressure control knob to set flow on the internal flow meter to approximately
60 to 80.

6. Close inlet port.
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OIL-BASED VACUUM PUMP

Log in to your customer portal to access the Vacuum Pump Guide.

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trained Micromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If amenu item is grayed out, it is usually an indication that Service Test Mode is required.

|

Warning: Entering service mode enables options
that may cause damage to the instrument.
Proceed only under the direction of a qualified
service representative.

Password

oK | | Cancel

To exit Service Test Mode, go to Options > Service Test Mode and deselect the Service Test
Mode option or close the application.

12-8 MicroActive ASAP 2020 Operator Manual
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PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency

Clean the analyzer As required or every 6 months

Lubricate elevator screw As required or every 6 months. Use a light coat
of lithium grease.

Check analysis port dewar Weekly

Replace sample tube O-ring As required or every 3 months

Replace port filters Every 30 days

Replace vacuum pump exhaust filter* Annually (heavy use may require more frequent

maintenance)
Inspect and change vacuum pump fluid* As required or every 3 months

Replace alumina in oil vapor traps* (if As required or every 3 months
installed)

Replace diaphragm(s) in vacuum pump Every 12 months

(oil-free pump only)**

Clean cold trap tube As required or every 3 months
Calibrate manifold temperature sensor Every 12 months

Calibrate system volume Every 12 months

Check analyzer outgassing rate Every 6 months

Test analyzer for leaks As required or every 12 months
Perform reference material analysis As required or every 3 months
CryoStat See Preventive Maintenance for the Cry-

oStat on page D - 8

* Qil-based vacuum pumps only.

** After about 12 to 18 months of operation, the diaphragm(s) in the pump will wear out and
become completely inoperable. To prevent any instrument downtime due to an inoperable
pump, it is recommended that you have the diaphragm(s) replaced by a Micromeritics Ser-
vice Representative every 12 months.

MicroActive ASAP 2020 Operator Manual
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CHECK AND CLEAN THE DEWAR

A When handling dewars, follow the precautions outlined in Dewar Precautions on
page 6 - 1.

Always handle glass dewars with care. Any product incorporating a vacuum is a poten-
tial safety hazard and should be treated with caution. If in doubt, contact your safety
officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port dewar. Particles
or deposits exceeding 1/4 in. in depth may jam between the bottom of the sample tube and the
bottom of the dewar, causing the dewar not to raise fully. Accumulations of fine particles impede
liquid nitrogen circulation around the bottom of the sample tube. This causes the sample
temperature to be slightly higher which, in turn, can cause pore volume measurement errors in those
samples exhibiting high isotherm slope above 0.97 relative pressure. Accumulated ice is likely to melt
and form a pool of water in the dewar if all liquid nitrogen evaporates. The water must be removed,
otherwise it will solidify when liquid nitrogen is added and could press on the bottom of the sample
tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the dewar after each use. Clean
on a weekly basis.

1. Remove the dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitrogen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to burst.

3. Rinse the dewar with warm water to melt any remaining ice accumulation which may remain.
Dry thoroughly.
4. Replace the dewar.

MicroActive ASAP 2020 Operator Manual
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CLEAN THE ANALYZER

The exterior casing of the analyzer may be cleaned using a clean cloth dampened with isopropyl
alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive

cleaner.

Do not allow liquid to penetrate the casing of the analyzer. Doing so could resultin
damage to the unit.

« Do not allow liquid to penetrate the casing of the analyzer. Doing so could resultin

damage to the unit.
« Use only a mild detergent in water to clean safety shields. The use of isopropyl alco-

hol can damage the shield surface.

MicroActive ASAP 2020 Operator Manual 12-11
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CLEAN THE CoLD TRAP TUBE

A Cold Trap option is available. Parts and accessories can be found online at
www.Micromeritics.com.

Oil vapor from the vacuum pumps accumulates in the cold trap.

/ If the high vacuum pumep is installed, wait for it to completely stop (approximately 10

minutes).

oD~

® N oo

Remove the vacuum pump panel.

Disconnect the vacuum pump power cord from its power source.

Open the instrument schematic.

In the sequence of P[n] (port the gas is connected to), PS, 5, 7, and 1, right click each analysis
valve and select Open. Allow the pressure to stabilize until around atmospheric. Close the
valves in the same order as opened. This step fills the analysis vacuum section before dis-
connecting.

Open the degas schematic.

Right click degas valve D5 and select Open.

Right click degas valve D7 and select Open.

Allow the pressure to stabilize until around atmospheric. Close valve D7 and D5. This step fills
the degas vacuum section before disconnecting.

Remove the connector nut from the glass tube and inspect the O-ring. Replace the O-ring if it
is cracked or worn.

® !"_@i

10. Carefully slide the glass tube down over the metal tube and remove the glass tube.

11.

Rinse the tube with acetone; then dry the tube.

12. Reinstall the cold trap tube ensuring the O-rings are in place.

12-12
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13. Repeat the previous steps for the other cold trap.
14. Reconnect the vacuum pump power cord.
15. Replace the vacuum pump access panel.

ENABLE MANUAL CONTROL

Unit [n] > Enable Manual Control

]_:g{r_\_ See also:
.FE’ ‘-I |

- ‘_rfcﬂg' Show Instrument Schematic on page 2 - 19

Use to enable the manual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left of Unit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go to Unit [n] > Show
Instrument Schematic.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If the
elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.
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PORT FILTERS

Replace Port Filters

A porous metal filter is located in the analysis port and in each degas port. If afilter on a degas port is
contaminated, the contaminant may adsorb atmospheric gases when the port is not plugged with
either a sample tube or plug, resulting in extended degassing time for samples on that port. Using a
contaminated filter on the analysis port may extend the time required to achieve a vacuum at that
port and the contaminant may also adsorb or desorb during analysis, affecting the analysis results. A
contaminated filter on the analysis port may be detected by a leak test (if the contaminant outgasses)
or by a free space reading much lower than normal.

Replace the Analysis Port Filter

A porous metal filter is located in each analysis port. Using a contaminated filter on an analysis port
may extend the time required to achieve a vacuum at that port. More importantly, the contaminant
may adsorb or desorb during analysis, affecting the analysis results. A contaminated filter on an
analysis port may cause a leak test to fail (if the contaminant outgasses) or cause a free space
reading to be much lower than normal.

/ Before replacing a port filter, ensure that the port valve is closed. Observe the analysis
system schematic to verify valve status.

/ To avoid analysis problems, the new filter and O-ring must be clean. Wear gloves when
performing this task. Do not touch the parts with bare hands.

1. Remove the dewar and sample tube (or plug).
2. Close the sample valve.
3. Use awrench to remove the sample tube fitting from the analyzer.

MicroActive ASAP 2020 Operator Manual
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Sample tube
fitting

O-ring

Filter

4. Remove and replace the filter and O-ring. If the O-ring and filter are stuck in the port, use a fin-
gernail or plastic instrument to remove them. Using a metal instrument may scratch the seal-
ing surface, causing a leak.

5. Reinstall the analysis port fitting. Securely tighten with a wrench to prevent leaks during evac-
uation.

Replace Chemical Adsorption Exhaust Port Filter

) O-ring

Y
v Filter

T

Fé=

b/
I

L S

R— ; Filter holder
%’_‘_’____ TI

, 5
A -

Exhaust port
filter
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1. Use a9/16 in. wrench to loosen and remove the filter holder from the exhaust port block

2. Remove the filter and O-ring by pushing them out from the opposite end of the filter holder.

3. Clean the filter holder and filter in acetone or alcohol. If necessary, replace the filter and
O-ring.

4. Reassemble the filter, O-ring, and filter holder.

5. Reinstall the assembly in the exhaust port block.

MicroActive ASAP 2020 Operator Manual
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Replace Degas Port Filter

/ To avoid degassing problems, the new filter and O-ring must be clean. Do not touch
them with bare hands.

1. Use a wrench to remove the degas port fitting, filter, and O-ring.
2. Replace the filter and the O-ring.

3. Carefully reassemble the sample tube fitting, filter, O-ring, and manifold connector. Hand
tighten, then tighten with a wrench.

REPLACE THE PSAT TUBE O-RING

Psat port
\ O-ring
Connector nut \ jg/
i

)
)

/)
Al

7 Po tube with

| /isothermaljacke1
[ |

Turn the connector nut counter-clockwise to loosen.

Pull the connector nut downward.

Gently pull the Psat tube downward to remove it from the Psat port.

Remove the O-ring from the Psat tube and replace with a new one.

Insert the Psat tube into the Psat port.

Slide the connector nut up to the Psat port and turn the connector nut clockwise to tighten.

o0k wN =
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REPLACE THE SAMPLE TUBE O-RING

Itis important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

Sample tube
fitting

e

Connector nut

Sample tube

O

/ Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

1. Carefully remove the dewar from the elevator. Take care not to bump the sample tube bulbs
with the dewar during this process. Place the dewar aside.

2. Hold the sample tube firmly with one hand and loosen the sample tube connector nut by turn-
ing counter-clockwise.

Do not allow the sample tube connector nut to drop onto the sample tube bulb as it may
break the tube.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp
the sample tube with both hands.

4. Remove the O-ring from the top of the sample tube and replace it with a new one.
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H
¥

O-ring

1 00—

Ferrule

Connector
nut

/ If the O-ring remains inside the sample port, use a pair of tweezers or needle-nose pliers
toremove it.

5. While holding the connector nut in place, slide a new O-ring over the sample tube, about
1/4 in. from the top of the tube.
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O-ring
(1/4 in. from top)

Isothermal
jacket

6. Afterthe new O-ringis in place, insert the sample tube back into the sample port until it is fully
seated.
7. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting

(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise, hand
tighten the connector nut to the sample connector.
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POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

Power ON the equipment in the following order:

1. Computer, monitor, and printer
2. Analyzer

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print manager
will print. If a power failure occurs and an uninterruptible power supply (UPS) is not attached
to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer
3. Analyzer

RECOVER FROM A POWER FAILURE

The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected during
the analysis will still be present, but the analysis should be restarted in order to produce complete
results.
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A Atomic Weights and Cross Sectional Areas

A ATomic WEIGHTS AND CROSS SECTIONAL AREAS

Atomic Weights and Cross-sectional Areas for Selected Metals

Metal Symbol Atomic Weight Cross-sectional Density (g/ml)
(g/mole) Area (sq nm)

chromium Cr 51.996 0.0635 7.19
cobalt Co 58.933 0.0662 8.9

copper Cu 63.54 0.0680 8.96
gold Au 196.967 0.08696 18.9
hafnium Hf 178.490 0.0862 13.3
iridium Ir 192.220 0.0769 22.4
iron Fe 55.847 0.0613 7.89
manganese Mn 54.938 0.0714 7.43
molybdnum Mo 95.940 0.0730 10.22
nickel Ni 58.710 0.0649 8.9

niobium Nb 92.906 0.0806 8.57
osmium Os 190.220 0.0629 22.6
palladium Pd 106.400 0.0787 12.02
platinum Pt 195.090 0.0800 21.45
rhenium Re 186.2 0.0649 21.02
rhodium Rh 102.905 0.0752 12.1

tuthenium Ru 101.070 0.0613 12.4
silver Ag 107.868 0.0869 10.5
tantalum Ta 180.947 0.0800 16.6
thorium Th 232.038 0.1350 11.7
tin Sn 118.710 0.1082 4.54
tungsten W 183.850 0.0741 19.3
vanadium \Y 50.942 0.0680 6.11

zirconium Zr 91.220 0.0877 6.51
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B CALCULATE FREE SPACE VALUES FOR MICROPORE
ANALYSES

Many microporous materials, such as zeolites and activated carbons, trap and hold helium in their
complex pore structures for many hours after being exposed to helium. Helium trapped in
micropores can interfere with the analysis at low pressures, causing an “S”-shaped curve at the
lower end of the isotherm. For this reason, it is recommended that you enter the warm and cold free
space volumes when performing micropore analyses, therefore avoiding exposure of the sample to
helium. Two techniques can be used for determining warm and cold free-space values.

The first method is to perform a short analysis on the sample after partial degassing (one pressure
point with no incremental dosing), but prior to final sample preparation. Measure the free space
during this analysis. The measured free space values will be printed on the report and may then be
entered into the sample file after more thorough sample preparation.

The second method requires prior tests using empty tubes that will be employed later for the sample
analyses. The measured free space data can be used thereafter on every analysis performed using
these sample tubes. This small initial investment of time will save considerable time later. Perform an
empty tube analysis on each sample tube you intend to use for micropore analysis. Measure the free
space of each sample tube, taking only one pressure point

1. Create a sample tube file from each empty tube test.

2. Usethe Load from Sample File button to read in the measured free space from the empty
tube tests.

3. Inthe sample file for the sample analysis, pick the appropriate sample tube from the sample
tube list.

4. Enter the mass and density of the sample.
5. Choose Calculate in the free space options in the analysis conditions.
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C CHEmIcAL ADSORPTION METHODS

Preparation steps for standard methods of chemical adsorption have been developed over a number
of years and are recommended starting points for creating other methods.

/ For each method, the recommended vacuum set point is 5 mmHg; the recommended
temperature increase rate is 10 °C per minute.

Method 1 * Prepares the sample for carbon monoxide as the analysis gas.

Method 2 * Prepares the sample for hydrogen as the analysis gas.

Method 3  Prepares the sample for oxygen as the analysis gas; usually used with silver.
Method 4  Prepares the sample for hydrogen-oxygen titration.

* Requires repeat analysis

Samples are evacuated to the vacuum set point and evacuation continues for the specified time.

« Flow (soak). Ramp up to the specified temperature, and then continue flowing (soaking) for the
specified time.

« Time. Total time below the vacuum set point that the sample spends at the specified temperature
or pressure.
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METHOD 1 - CARBON MONOXIDE ANALYSIS OF PLATINUM

Preparation:

Rate of temperature increase = 10 °C per minute
Vacuum set point = 10 umHg
Task No. Action Ramp Rate | Temperature Time
(°C / min) (°C) (Minutes)
1 Evacuate, helium backfill 10 110 30
2 Flow hydrogen 100 10
3 Flow hydrogen 10 400 30
4 Evacuate, no backfill 400 30
5 Evacuate, no backfill 10 35 60
6 Leak test, outgas rate 35 —
limit=10 pmHg/min

7 Evacuate, no backfill 10 35 20

Analysis:

Requires repeat analysis.

Gas: Carbon monoxide

Temperature: 35°C

Heat rate: N/A

Equilibration interval: 10 sec

Relative target tolerance: 5.0%

Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes

Fast evacuation: No

Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min
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Free space: Measure

Incremental dosing: No

Line fit: Enabled for all pressure points

Pressure table (mmHg): 200, 250, 300, 350, and 400
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METHOD 2 - HYDROGEN ANALYSIS

PLATINUM

Preparation:

Rate of temperature increase 10 °C per minute

Vacuum set point = 10 umHg
Task No. Action Ramp Rate Temperature Time
(°C / min) (°C) (Minutes)
1 Flow helium 10 200 10
2 Evacuate, no backfill 100 10
3 Flow hydrogen 10 400 30
4 Evacuate, no backfill 400 30
5 Evacuate, no backfill 10 35 60
6 Leak test, outgas rate 35 —
limit =10 pmHg/min

7 Evacuate, no backfill 10 35 10

Analysis:

Requires repeat analysis.

Gas: Hydrogen
Temperature: 35°C
Heat rate: N/A
Equilibration interval: 10 sec
Relative target tolerance: 5.0%
Absolute target tolerance: 5.0 mmHg
Repeat analysis: Yes

Fast evacuation: No
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Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min (experience may indicate the need for a longer evac time)
Free space: Measure

Incremental dosing: No

Line fit: Enabled for all pressure points

Pressure table (mmHg): 200, 250, 300, 350, and 400

PALADIUM

Preparation:

Rate of temperature increase 10 °C per minute

Vacuum set point = 10 umHg
Task No. Action Ramp Rate Temperature Time
(°C / min) (°C) (Minutes)
1 Evacuate 10 100 30
2 Flow oxygen 100 5
3 Flow oxygen 10 350 30
4 Evacuate 350 15
5 Evacuate 10 100 15
6 Flow hydrogen 100 5
7 Flow hydrogen 10 350 120
8 Evacuate 350 30
9 Evacuate 10 35 30
10 Analysis 35
C.5 MicroActive ASAP 2020 Operator Manual
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Analysis:

Gas: Hydrogen

Temperature: 100°C

Heat rate: N/A

Equilibration interval: 10 sec

Relative target tolerance: 5.0%

Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes

Fast evacuation: No

Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min

Free space: Measure

Incremental dosing: No

Line fit: Enabled for all pressure points

Pressure table (mmHg): 120, 155, 190, 225, and 260
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NICKEL

Preparation:

Rate of temperature increase

10 °C per minute

Vacuum set point = 10 umHg
Task No. Action Ramp Rate Temperature Time
(°C / min) (°C) (Minutes)

1 Evacuate 10 100 30
2 Evacuate 10 450 5
3 Flow oxygen 450 120
4 Evacuate 450 30
5 Evacuate 10 35 30
6 Analysis 35

Analysis:

Gas: Hydrogen

Temperature: 35°C

Heat rate: N/A

Equilibration interval: 10 sec

Relative target tolerance: 5.0%

Absolute target tolerance: 5.0 mmHg

Repeat analysis: Yes

Fast evacuation: No

Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min

Free space: Measure

Incremental dosing: No
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Line fit: Enabled for all pressure points
Pressure table (mmHg): 100, 150, 200, 250, and 300
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METHOD 3 - OXYGEN A

Preparation:

Rate of temperature increase

NALYSIS OF SILVER

= 10 °C per minute

Vacuum set point = 10 ymHg
Task No. Action Temperature Time *
(°C) (Minutes)
1 Evacuate 100 30
2 Flow oxygen 100 10
3 Ramp temperature while flowing oxygen 170 10°C/min
4 Hold temperature while flowing oxygen 170 60
5 Evacuate 170 30
6 Flow hydrogen 170 60
7 Evacuate temperature < 10 mmHg 170 30
8 Analysis 170
*Time for evacuation is the number of minutes below set point at the specified tem-
perature. Time for gas flow is the number of minutes at the specified temperature.

Analysis:

Gas:
Temperature:
Line fit:

Repeat analysis:

Pressure table (mmHg):

Oxygen

170 °C

Enabled for all pressure points
No

40, 67,93, and 120
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METHOD 4 - HYDROGEN-OXYGEN TITRATION
PLATINUM

Preparation:

Rate of temperature increase = 10 °C per minute
Vacuum set point = 10 umHg

Analysis:

Gas: Hydrogen

Temperature: 35°C

Heat rate: N/A

Equilibration interval: 10 sec

Relative target tolerance: 5.0%

Absolute target tolerance: 5.0 mmHg

Repeat analysis: No

Fast evacuation: No

Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min

Free space: Measure

Incremental dosing: No

Line fit: Enabled for all pressure points
Pressure table (mmHg): 75,110, 240, 170, and 200
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PALLADIUM

Preparation:

Rate of temperature increase 10 °C per minute

Vacuum set point = 10 umHg
Task No. Action Ramp Rate Temperature Time
(°C / min) (°C) (Minutes)
1 Flow helium 10 200 10
2 Evacuate, no backfill 100 10
3 Flow hydrogen 10 400 30
4 Evacuate, no backfill 400 30
5 Evacuate, no backfill 10 35 30
6 Leak test, outgas rate 35 —
limit =10 pmHg/min
7 Evacuate, no backfill 10 35 10
Flow hydrogen 35 10
Evacuate, no backfill 10 35 10
10 * Flow Air 35 2
11 Evacuate, no backfill 35 10

* Use clean, dry air or 2%, 5%, or 10% O in helium or argon.
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Analysis:

Gas: Hydrogen

Temperature: 35°C

Heat rate: N/A

Equilibration interval: 10 sec

Relative target tolerance: 5.0%

Absolute target tolerance: 5.0 mmHg

Repeat analysis: No

Fast evacuation: No

Unrestricted evac pressure: 30 mmHg

Evacuation time: 30 min

Free space: Measure

Incremental dosing: No

Line fit: Enabled for all pressure points

Pressure table (mmHg): 120, 155, 190, 225, and 260
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D CRYOSTAT

A CryoStat is an available option. Parts and accessories can be found online at
www.Micromeritics.com.

Unit [n] > Enable CryoStat

CRYOSTAT OPERATING INSTRUCTIONS

The cryostat provides automatic analysis temperature control over a wide range of sub-ambient
temperatures.

« Read and fully understand this entire section prior to carrying out operations on the
system.

« All system components must be powered ON in the sequence provided in this sec-
tion.

« Pay attention to all local safety systems and requirements and consider the specifics
of the experiment when operating the system.

1. Prior to starting any analysis on the system, ensure the following:

o Goto Unit [n] > Enable CryoStat and ensure a checkmark displays to the left of the
menu option. A checkmark indicates the item has been selected and disables the elevator
during an analysis when using the cryostat.

« The cryostat is correctly mounted and held firmly in place by the metal retaining bands.

« Release the brake on the cryostat cradle and move the system upwards to check that the
sample well and the analyzer sample port is correctly aligned.

« Check that the vacuum connection, helium connection, and wired connections to the com-
pressor and temperature controller are in place and correctly fitted.

2. Prepare the samples:

« Samples can be prepared in-situ using the analyzer heating mantle (if the heating mantle
fits with the cryostat installed). This will depend on the type of heating mantle used.

« The cryostat can be prepared to run analyses in the DOWN position while the samples are
being prepared. Leave the insulating cover for the cryostat sample well in place while
doing this.

3. Turnon the helium supply and adjust the rotameter to scale position 55. This corresponds to a
flow rate of approximately 5 ml/min. See Rotameter Scale Readings on page D - 3.

4. Allow the helium to purge the sample well for fifteen minutes. This purge procedure removes
water vapor from the sample well and prevents water vapor from freezing when the system is
in use at sub-ambient / cryogenic temperatures.

5. Open the degas port 2 valve to the cryostat to ensure a good vacuum inside the cryostat
vacuum jacket.
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6.

7.

10.
11.
12.
13.

14.

15.

Power ON the compressor — first switch the circuit breaker to the UP position and then power
ON the analyzer. The compressor will now start to pump.

Press the ALL OFF button to power ON the temperature controller. Set the required tem-
perature on the temperature controller or in the analysis application. If using the temperature
controller, refer to the temperature controller manual supplied by the manufacturer.

Create a sample file (see Create Sample Files on page 3 - 2). There are settings specific to
physical adsorption analyses using a cryostat in Analysis Conditions on page 4 - 5.

With the sample tube in place, preparation completed, and the tube cooled to ambient tem-
perature, slide the insulating cover up so that the cover fits snug against the mouth of the
raised cryostat.

When prompted by the analyzer application, raise the cryostat.

Allow the sample to thermally equilibrate before starting the analysis.

When prompted by the analyzer application, lower the cryostat.

If the sample tube is to be removed, go to Unit [n]> Enable Manual Control and pressurize
the sample tube to 760 mmHg at ambient temperature. See Enable Manual Control on
page 12 - 13.

Weigh the sample after analysis and enter the sample weight into the sample file. See
Determine the Sample Mass on page 6 - 8.

The cryostat can now be used to analyze another sample at the same temperature or change
the set point temperature. It is recommended that the cryostat remained powered ON unless
left unused for a long period of time. If it is necessary to power OFF the cryostat, set it to ambi-
ent temperature and allow it to come up to room temperature.

INSTALL SAMPLE TUBE FOR THE CRYOSTAT

See:

Sample Tube Installation on page 6 - 16

Sample tubes for the cryostat are installed in the same manner as the sample tubes for the analyzer.
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Rotameter Scale Readings

ROTAMETER SCALE READINGS

The rotameter scale corresponds approximately to flow rates:

........

Adjustment
knob |

Rotameter Scale to Flow Rate

Scale Reading Flow Rate (ml/min)

65 5.8
55 5

45 4.3
35 3.3
25 25
15 1.8
5 1.3
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REMOVE THE CRYOSTAT FROM THE ANALYZER

To run a normal analysis, the cryostat must be removed.

Move the cryostat to the DOWN position.

Place the brake in the bottom position.

Remove the 1/8 in. nylon helium tube.

Close degas port 2 valve.

Remove the 1/4 in. flexible stainless steel evacuation hose at the degas port.

Remove the large hose clamps and lift the entire cryostat off the cradle.

Lay the assembly on an adjacent bench so that other hoses do not need to be disconnected.

Close the helium purge supply, power OFF the compressor, and turn OFF the temperature
controller.

© N Oh®N =

It is not necessary to remove the carriage assembly from the analyzer, however, the spe-
cial safety shield (supplied with the cryostat kit) should be used. This shield has been
modified to reach over the cryostat panel and hook onto the analyzer.
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TROUBLESHOOTING THE CRYOSTAT

Frost or ice accumulates around the outside of the cryostat in the area of the sample well

Cause: Theinternal vacuum is degrading and must be re-evacuated.

Action: Effective re-evacuation can be done only when the cryostat is warm, such as after an
analysis. It is recommended that the vacuum pump always remain powered ON.

Elevator tries to rise

Cause: Analysis program is not set to enable the cryostat.

Action: Inthe analysis program, go to Unit [n] > Enable CryoStat and ensure that this
option is selected. Failure to do so will cause the P port to be evacuated and the elev-
ator will try to rise.

Valve motor in cryostat cold head does not start when the compressor starts

Cause A: Cold head cable is not connected.
Action A: Stop the compressor. Connect the cable.
Cause B: Open circuit in the cold head cable.

Action B: Disconnect the cold head cable. Check each conductor for continuity. Replace the
cable if necessary.

Cause C: Defective valve motor.
Action C: Contact your Micromeritics Service Representative.
Cause D: Blown fuse in the compressor's electrical box.

Action D: See the manual supplied by the compressor manufacturer.

Valve motor in cryostat cold head hums but does not start

Cause A: Valve disk has stalled.

Action A:  Check the operating pressures on the compressor. Contact your Micromeritics Ser-
vice Representative.

Cause B: Defective valve motor.
Action B: Contact your Micromeritics Service Representative.

Cause C: Open circuit in the cold head cable.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



D CryoStat [M] micromeritics’

Action C: Disconnect the cold head cable. Check each conductor for continuity. Replace the
cable if necessary.

Valve motor on the cryostat cold head runs but there is no cooldown

Cause A: No insulating vacuum.

Action A: Check the vacuum system for operation and leaks.

Cause B: Gas line couplings are not fully engaged.

Action B: Ensure all couplings are fully engaged and torqued.

Cause C: Gas lines are connected incorrecitly.

Action C: Reconnect the gas lines. See the manual supplied by the compressor manufacturer.
Cause D: Compressor output is inadequate.

Action D: Troubleshoot the compressor. See the manual supplied by the compressor man-
ufacturer.

Shroud is sweating or abnormally cold

Cause: Loss of insulating vacuum.

Action: Check the vacuum system for operation and leaks.

Abnormally noisy operation after a sustained period of five to fifteen minutes

Cause A: Incorrect compressor pressures.

Action A: Troubleshoot the compressor. See the manual supplied by the compressor man-
ufacturer.

Cause B: Contaminants in the gas.

Action B: Perform Gas Cleanup and Recharging procedure on the cold head, compressor, and
the gas lines. See the manual supplied by the compressor manufacturer. Contact
your Micromeritics Service Representative.

Intermittent operation

Cause: Compressor is cycling on and off.

Action: Troubleshoot the compressor. See the manual supplied by the compressor man-
ufacturer.

Temperature is cycling
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Cause:

Action:

Contaminated gas is causing a cold head freezing-thawing cycle.

Perform Gas Cleanup and Recharging procedure on the cold head, compressor, and
the gas lines. See the manual supplied by the compressor manufacturer. Contact
your Micromeritics Service Representative.

Sudden loss of refrigeration capacity

Cause A:
Action A:
Cause B:
Action B:

Loss of insulating vacuum.
Check the vacuum system for operation and leaks.
Compressor malfunction.

Troubleshoot the compressor. See the manual supplied by the compressor man-
ufacturer.

Slow loss of refrigeration capacity

Cause A:
Action A:
Cause B:
Action B:
Cause C:
Action C:

Small insulating vacuum leak.

Leak check and repair the vacuum system.

Worn seals in the cold head.

Contact your Micromeritics Service Representative.
Cold head is leaking.

Contact your Micromeritics Service Representative.
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PREVENTIVE MAINTENANCE FOR THE CRYOSTAT

The preventive maintenance procedures can be located in the documents supplied by the cryostat

manufacturer.
Maintenance Required Frequency
Cold head Every 13,000 hours
Compressor (absorber) Every 30,000 hours
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CRYOSTAT CALIBRATION

The cryostat temperature reading does not necessarily reflect the temperature at the sample. The
discrepancy is large enough to cause significant differences between data taken with a cryogenic
bath and data taken with the cryostat set to the temperature of the bath.

One solution is to modify the voltage-to-temperature curve stored in the temperature controller so
that the reading accurately reflects the temperature of the sample. This option requires additional
interaction with the temperature controller to download, upload, and select the voltage-to-
temperature curves. However, this is straightforward with the Lakeshore controller and their Curve
Handler software.

REQUIRED ITEMS

o An ASAP 2020 analyzer equipped with an installed Micromeritics cryostat unit.
« A selection of adsorptives to cover the temperature range to be calibrated — such as nitrogen,

argon, methane, ethane, and propane. Choose adsorptives whose saturation pressure is less
than 800 mmHg at the measurement temperatures.

« The Lakeshore Curve Handler software (free download): http://www.lakeshore.-
com/products/Pages/curvehandler.aspx.

« An empty sample tube for the Micromeritics gas adsorption analyzer being used.

« A spreadsheet application — such as Microsoft Excel. Knowledge of how to load a .TXT file con-
taining tabular data into a spreadsheet application is beneficial.

CALIBRATION PROCEDURE

Goto Unit [n] > Show Instrument Schematic and lower the elevator.

Go to the Unit [n] menu. Ensure there is no checkmark to the left of Enable CryoStat.
Install a blank sample tube into the gas adsorption analyzer.

Raise the cryostat and lock it in place following the general cryostat procedure.

Set the cryostat to the required temperature. On the LakeShore temperature controller, press
SETPOINT, enter the temperature (in kelvin), then press ENTER.

a bbb
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Measured Probe signal Setpoint
temperature voltage button

Settemperature| |Enterbutton

6. Wait until the cryostat reaches the entered temperature. The time varies depending on how
big the temperature jump is. For example, going from 200 K to 215 K may take 15 to 20
minutes; going from 298 K to 77 K might take 90 minutes. Once the cryostat has reached the
operating temperature, record the set temperature, the measured temperature, and the cryo-
stat signal probe voltage.

7. Create a sample file to measure saturation pressure.
In Analysis Conditions:

a. Select the adsorptive to be used.
b. Select the Absolute pressure dosing option.

c. Enterthe pressure settings shown in the Pressure Settings for ASAP 2020 table
below.

d. Click Dosing and enter the dosing settings in the Dosing Options for ASAP 2020
table shown below. Click OK to return to the Analysis Conditions window.

e. Click Equilibration. In the table, enter an absolute pressure of 1,000.00000 and equi-
libration interval of 5. Click OK.

Pressure Settings for ASAP 2020

Starting Pressure (mmHg) | Pressure Increment Ending Pressure
(mmHg) (mmHg)
Line 1 0.000000 100.000000
Line 2 100.000000 980.000000
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Dosing Options Settings for ASAP 2020

Field Enter...

Absolute pressure Tolerance 5.000 mmHg

Relative pressure tolerance 5.0%

Low Pressure incremental dose mode Select this option

Dose amount 20.0000 cm3/g STP

Equilibration Delay Minimum. 0.00 h
Maximum. 999.00 h

Maximum number of decants 6

8. Once the analyzer is set up and the temperature for the first data point has reached equi-
librium, start the analysis defined by the sample file. The analyzer will dose the sample tube
with 20 cm3/g STP of adsorptive . Once the tube pressure reaches the adsorptive saturation
pressure, the generated isotherm will climb straight up. Take several points at this saturation
pressure, then pause the analysis and set the cryostat to the next temperature.

Once the cryostat has reached the set temperature and has equilibrated a few minutes, record
the cryostat temperature and the probe signal, then resume the analysis. Perform this cycle for
the number of temperature points required for the adsorptive being used. Typical isotherms
are shown below. Note that the temperature labels are for clarity and are not a part of the
normal report.

Additional adsorptives will allow the calibration to be extended. A set of local fits may be
needed to cover a wide temperature change.

Depending on the selected adsorptive, a warning message may be given indicating that
950 mmHg is not the saturation pressure for the temperature being used. This is a nor-

mal message and will not interfere with the experiment. Click OK and continue with the
analysis.

analysis window. To terminate the analysis, click Cancel, then wait a few seconds and

ﬂ These analyses will not end and will have to be terminated manually by stopping the
click Cancel again (do not double-click the Cancel button).

The analysis will end abruptly with adsorptive in the sample tube. The sample tube must
be manually evacuated before the cryostat is lowered.

Manually close all valves. Open values 2, 7, and 9 in that order. Once the pressure in the
sample tube is less than 300 mmHg, open valve 1.

The cryostat can be lowered once the sample tube has been completely evacuated.
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This saturation pressure data can either be read from the graph or an isotherm report can be made
and the saturation pressure read from the report:

o Repan s BL gen A SMP [E=R 8o ==
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9. Place the data in table format using a spreadsheet application such as Microsoft Excel.

Temperature and Saturation Pressure Values

Set Tem- CryoStat Signal Probe| Measured Sample Tube
perature (K) | Temperature Voltage Saturation Temperature
(K) Pressure (K)
(mmHg)
65 64.999 1.04878 137.833 65.317
67.5 67.498 1.04474 206.334 67.778
70 69.999 1.04066 301.792 70.294
73 72.996 1.03572 454217 73.239
73 72.996 1.03572 456.148 73.271
Nitrogen 73 72.998 1.03571 452.139 73.239
75 75.002 1.03240 584.063 75.189
75 75.002 1.03245 587.793 75.240
77 76.993 1.02896 743.094 77.165
77 76.995 1.02897 742.343 77.156
78 78.002 1.02737 832.533 78.165
140 139.999 0.91437 111.175 142.470
Ethylene 145 144.999 0.90456 168.125 147.470
150 150.000 0.89477 245.617 152.350
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Set Temp Cryostat temperature setting, in kelvin.
CryoStat Temperature Temperature reported by the temperature controller.

Signal Probe Voltage Signal probe voltage reading.

Measured Saturation Equilibrium pressure measured by the instrument when the isotherm
Pressure is vertical.

Sample Tube Sample tube temperature calculated from the measure saturation
Temperature pressure using NIST’'s REFPROP program (bundled with the Micro-

meritics applications).

H 2: nitrogen: Saturation points (at equilibrium) o || @) 2

Liquid | Yapor | Liguid | Vepor | Liguid | Vapor
Temperature | Pressure| Density | Density | Enthalpy| Enthalpy | Entropy | Entropy
® {mmHg) | (kg/m?) | (kgim?) | fkdikg) | (edfkg) |(kdkgK)| (kJikgK)

75.037 57300 | 81651 | 35555 | 12676 | 75345 | 27724 | 5.4658
75.497 E07.00 | 81445 | 3.7492 | -12582 | 75713 | 27848 | 54542
76.472 68400 | 810058 | 41852 | -12383 | 76479 | 28108 | 54302
76664 700.00 | 809.21 | 42753 | -12343 | 76626 | 28159 | 54255
76.957 72500 | 80789 | 44159 | -122.83 | 76854 | 28237 | 54185
772594 751.00 | 80654 | 45617 | 12223 | 77081 | 28315 | 54114
77663 788.00 | 80468 | 47687 | -121.33 | 77391 | 28423 | 54017

[==0 el =2 I Y P R

Screenshot from REFPROP software

The spreadsheet data can be graphed in the REFPROP spreadsheet program. Plot the
REPROP to determine temperature versus the Cryostat reading. Fit the data points:

Temperature Correlation
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Additional adsorptives will allow the calibration to be extended. The following graph contains
data for nitrogen combined with data from ethane:
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D CryoStat
Temperature Correlation
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10.

Cryostat Reading (K)

The REPROP determined sample tube temperatures, combined with the signal probe
voltages read from the LakeShore controller are then used to construct a cryostat calibration

curve.

The LakeShore Curve Handler program (shown below) is used for this operation. (See the
LakeShore Curve Handler manual for communications information.) Connect the cryostat to

the computer via an Ethernet connection.

T o e Mew Curve

A
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CryoStat Calibration

11. Click Connect to establish communication with the LakeShore Temperature Controller.
Once communication is established, all the calibration curves in the LakeShore Temperature

Controller will be listed.

i EE.

Ho%

gles
“nn

DT-670-adj

Hakin

12. The ColdEdge Cryostat/LakeShore Model 336 Temperature Controller uses the DT-670
silicon diode as the temperature sensor according to ColdEdge Micromeritics Interface
Owner’s Manual. Select the curve for the DT-670 temperature probe. Click Save As and save
the DT-670 curve with a different name (i.e., DT-670-xx). Note that all calibration curves are
stored as ASClII files in the Documents library with the file extension .curve. There will be a

DT-670.curve file and a DT-670-xx.curve file.
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Sensor model : oT-670
serial sumber: STaNDAR
pata Formar: 2

serPoint Limit: +500.000
Measurement (volts) Ten
7. 964 e -02 5. 0300E+D
9, 057 00:0e -02 5. DD00E+D2
1.10240:0-04 4. 21 JD00e+02
1. 365600 -01 4. 795000e+02
1. 791 800 -01 4. 61 5000e+02
2. 653000€ -01 4. 255000e+02
3. 495200 -01 1. eQ00E+02
4, 52E000e -01 1. 460000E+02
5.133000e-01 3. 200000 +02
5. 631 300e-01 2. GRS000E+D2
6. 07E500e -01 2. 7 000E+02
6. 487 200 -01 2. G10D00E+02
6. BES4 e -01 2. 440000E+02
7. 225100 -01 2. 2B0000E+02
7. 53534 000 -01 2.1 3 D00E+O2
7. BEOON{E -01 1. GRSOO0E+D2
8. 170200€ -01 1. B4 5000E+02
8. 4454 00€ -01 1. 715000e+02
8. 695E00E -01 1. 555000E+02
8. 932300 -01 1. 480000 +02
9. 144 70dE -01 1. 37 5000E+02
9. 343600€ -01 1. 27 5000E+02
9. 520000€ -01 1. 180000E+O2
9. 701 30 -1 1. 0S)Q00E+O2
9. BEOT e -01 1. 60S000E+O2
9. SRS 00E -01 9. 350000+ 01
1. 010640E«00 E. 70:0000E+O1
1. 021 250€«00 E. 10:0000E + 01
1. 031670€«00 7. S000E+O1
1. 041 BG0E «00 6. G000E + 01
1. 051620« 00 E. 30:0000E + 01
1. 0627 70E«00 & BL0000E+O1
1. 0747 206400 4 GOO00E +01
1. 0911 B0E 00 1. BT OO00E + 01
1. D9E0H0E«00 1. 5T 0000E+01
1. 1000 406 00 1. 330000E 01
1. 103530600 1. 1200008 + 01

o
(woltsmelvind

(K}

13. The LakeShore Curve Handler instruction manual provides several methods of entering user
created calibration. The following process uses a file copy of a modified version of the DT-670
curve previously saved.

14. Produce a modified calibration curve by applying the fit from step 8 to the temperatures in
DT-760 curve.

15. Start the LakeShore Curve Handler program and establish communication with the

LakeShore Temperature Controller.
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I — DT-670

16. Click Open and select the modified D T-670-xx.curve. Place this curve in the first empty bin.
User curve bins start at Number 21.

17. The new curve should now be able to be loaded into the LakeShore Curve Handler program.
Click the User’s Curve tab in the lower left side of the window.

DT-670-adj

Habin

18. Note in this example the modified curve DT-670-xx.curve is in bin 22 (left column) and the
curve is displayed on the right. The values should be reviewed and any changes made. Click
Save if changes have been made. Click Write to load the new curve into the LakeShore Tem-
perature Controller. Exit the LakeShore program.

19. To select the new curve, on the temperature controller, press the Input command (key 7),
select the Input channel (usually A), use the arrows to navigate to the curve menu, press
Enter, then select the curve. Use curve 22 in this example. Press Enter once more, then
press Escape. The new, modified curve is now in place. More details can be found on page 52
of the LakeShore Model 336 Temperature Controller User's Manual.

The table below shows the effect of the new curve:
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Temperature and Saturation Pressure Values
Set Cryostat Measured Uncalibrated Calibrated % Error
Temp | Temperature Saturation Sample Tube | Sample Tube | (Calculated
(K) (K) Pressure Temperature | Temperature Vs
(mmHg) (K) (K) Uncalibrated)
73 72.997 473.450 73.553 73.250 -0.414
75 74.996 615.020 75.603 75.215 -0.517
77.3 77.002 786.618 77.648 77.029 -0.804

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019



[M] micromeritics’ E Data Logging

E DATA LOGGING

The ASAP 2020 has the added capability to collect, access, and use real time transient data
(pressures, temperatures, quantities adsorbed, etc.) during adsorption and desorption
measurements. Data are collected every half second. Data logging can also be performed from a
Smart VacPrep degasser attached to the analyzer. Log in to your customer portal to access

This document provides :

« installation instructions for the PuTTY client and outlines how to access and use the data file, and
« installation instructions for Python components and outlines how the captured data can be
handled using Python scripts.

INSTALL THE PUTTY CLIENT

PuTTY is an open source SSH and telnet client that can be used to access the transient data output
by the analyzer. No additional Micromeritics application is required. The PuTTY .exe file runs directly
from a desktop shortcut. Download the PuTTY application using the following URL (only save the
putty.exefile):

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

To connect to the analyzer:

1. Inthe ASAP 2020 application, go to Unit [n] > Unit Configuration and make a note of the
analyzer IP address.

=

Volume Calibration Configuration
System Lower Reference  Date
60.0000 450000 250000  Uncalibrated

APD Calibration
Manifold temperature: Uncalibrated

ftware Versions \ I P
address

Demo Boot Block
ntroller: oo appication
lication:  asap 2020 Plus Version 1,02

Manifold transducer offset:
Uncaiibrated

Manifold transducer scale:

Uncaiibrated
10 mmiHg transducer offset: Uncalbrated
Uncalbrated
”‘t Baot Demo v1.00

Uncalibrated
nealbral N Degas Demo App v1.00

Uncalibrated

Po transducer offset:

Uncalibrated

Po transducer scale:
Uncalibrated

Vacuum: Uncalibrated

Cavesit, ]
oK.

2. Inthe PuTTY Configuration window:
a. Enterthe analyzer IP address (from Step 1) into the PuTTY application.
b. Enter 54000 in the Portfield.
c. Select Raw as the connection type.
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ﬁ PuTTY Configuration

P

Category:

[=)- Session
. " Logding
[=)- Terminal
i i Heyboard
Bell
Features
Window

Basic options for your PuTTY session

Specify the destination you wart to connect to
Host Name for IP address) Port

Connection type:
@ Raw () Telnet (7) Rlogin (0) SSH (7 Serial

- Aopearance Load, save or delete a stored session
- Behaviour
Translation Saved Sessions
-- Selection
i - Colours -
Defautt Settings
[=- Connection Load
Prongy
- Rlogin
SSH
< Serel Close window on exit:
) AMways () Never @ Only on clean et

3. Tosave the settings (optional):

R

Speciy’

Basic options for your PUTTY session

want to connectto

Host Name (or IP address) Fot

a. Inthe Category box, select Session > Logging.
b. Inthe Session logging group box, select All session output.

c. Inthe Log file name group box, click Browse to select the destination and enter a .txt file
name. It may be helpful to name this file the same as the sample file to be analyzed.
4. Click Open to start collecting the data.

g The PuTTY application can be started before the ASAP 2020 analyzer starts collecting
data — it will be waiting until data output from the analyzer begins.
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Access the Data Log File

ACCESS THE DATA LOG FILE

The text file created in the previous section (Step 3c) contains the transient data and can be
accessed using any means that accepts tab separated values — such as: Notepad, Microsoft Excel
(or other spreadsheet software), or programming languages that read .txt or .xls files — such as
MATLAB, Octave, and Python. MATLAB has the xIsread() function and Octave has the textread()

function.

DATA FILE COLUMN DESCRIPTIONS

When the data file is viewed in a spreadsheet program, the following columns display:

ASAP 2020 Data File Column Descriptions

Physical Adsorption

Chemical Adsorption

Manifold pressure (mmHg)
Manifold volume (cm?)

Manifold temperature (K)
Elapsed time (ms)

Analysis temperature (K)
Ambient free space (cm?® STP)
Analysis free space (cm® STP)
Quantity dosed (cm® STP)
Quantity adsorbed (cm?® STP)
Sample valve open? (1 = open, 0 =
closed)

Number of data points taken
Current pressure table index
Last data point elapsed time (ms)

OZ=Zr=x

STP)
Last data Po (mmHg)

U

Last data point quantity dosed (cm® STP)
Last data point quantity adsorbed (cm?

ZSr Xc

—~TOMMOOw>

Manifold pressure (mmHg)
Manifold volume (cm?)

Manifold temperature (K)

Elapsed time (ms)

Analysis temperature (K)

Free space (cm?®STP)

Quantity dosed (cm?® STP)
Quantity adsorbed (cm?® STP)
Sample valve open? (1 =open, 0 =
closed)

Number of data points taken
Current pressure table index

Last data point elapsed time (ms)
Last data point quantity dosed (cm?® STP)

Last data point quantity adsorbed (cm?
STP)
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INSTALL PYTHON COMPONENTS
To operate Python to view real time data, three components should be installed in the following
order:

1. Install PYTHON
o Download URL: https://www.python.org/downloads/

« Download Python version 3.2 or later
Depending on the computer operating system, download file versions may vary, however, the
.msi file should be compatible with computers that operate the ASAP 2020 analyzer.

2. Install NumPY (for numerical functions)
o Download URL.: http://sourceforge.net/projects/numpy/files/NumPy/1.6.2/
« Download file: numpy-1.6.2-win32-superpack-python3.2.exe
NumPY contains numerous numerical functions and libraries needed to properly handle the
transient data extracted from the .txt file collected during an analysis. NumPY version 1.6.2
should be download to be compatible with the installed version of Python.

3. Install MatPlotLIB (for graphical display of the data)
« Download URL: http://www.Ifd.uci.edu/~gohlke/pythonlibs/#matplotlib
» Download file: matplotlib-1.2.1rc1.win32-py3.2.exe
MatPlotLIB version 1.2.1 is compatible with NumPY from Step 2.
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[M] micromeritics’ Sample Python Code

SAMPLE PYTHON CODE

The following code was used to produce the data in this section. This is basic code for viewing
transient data. More detailed scripts can be created to compare pressure or quantity adsorbed
between ports, generate a separate figure for each port, etc. Contact Micromeritics’ applications
specialists to discuss and support creating custom scripts for individual applications.

import numpy as np
import matplotlib.pyplot as plt

myFile = 'carbon.txt'
data = np.genfromtxt (myFile, skip header=2, skip footer = 1)

# Time (minutes)
x=datal[:, 3]
x = x/1000/60

# Manifold pressure (mmHg)
y=datal:,0]

plt.plot (x,y, 'ko")

plt.ylabel ('Pressure (torr)"')
plt.xlabel ('time (minutes)')
plt.show ()

Sample Code Explanation

import numpy as np
import matplotlib.pyplot as plt

Importis needed to load the modules containing functions to be used — in this case, numerical and
plotting functions. Coding is easier if abbreviations such as np and plt are used.

myFile = 'carbon.txt'
data = np.genfromtxt (myFile, skip header=2, skip footer = 1)

MyfFile is a variable name for the .txt file to be read. As long as the .txt file and the script file are in the
same directory, the script file can run automatically by double-clicking the script file after the correct
file has been hard-coded.
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The genfromtxt() function allows for the text file to be converted into a numerical matrix. The skip_
header setting allows for the first 2 rows of data to be excluded from the matrix. As shown in the
following figure, the first row of data is ASCII art created by the PuTTY program, and the second row
of data are the column labels — neither of which are numerical data. The skip_footer setting is
needed because, when the .txt file is read in real time, the entire last row of data may not be
complete. This causes problems for creating the matrix and needs to be excluded. This means that
the last half-second of data is not displayed when the data are viewed in real time.

File _Fdit Format View Heln
= —— PUTTY 1og 2013.03.20 13:52:35 mremmmmnmmmnmnmmrm A
01 Man Tmp Time msec Sml Press sml vol SmlTprt SmiTamb smiTanl sSmivwrm smivcld smiQtotal
e - 7 - - = = -
3 20 318.141 12503436 33.858860 32,8751 318.141 298.000 77.243 8.7520 28.7111  5.4058
20 318.140 12503937 33.858468 32.8751 318.140 298.000 3 87520 28.7111  5.4058
21 318.141 12504438 33.860375 32.8751 318.141 298.000 3 8.7520 28.7111 5.4058
21 318.140 12504939 33.857608 2. 51 8.140 298.000 3 8.7520 28.7111 5.4059
24 318.141 12505440 33.856757 32,8751 318.141 298,000 38,7520 28,7111 5.4059
33 3181141 12505941 33.858051 32.8751 318.141 298.000 3 87520 28.7111  5.4059
39 318.141 12506442 33.855361 32.8751 318.141 298.000 3 8.7520 28.7111 5.4060
45 318.141 12506943 33.859719 32.8751 318.141 298.000 3 8.7520 28.7111 5.4058
50 318.142 12507444 33.856569 32,8751 318.142 298,000 38,7520 28,7111 5.4059
55 318.141 12507945 33.858093 32,8751 318.141 298.000 3 87520 28.7111  5.4059 Exclude the
58 318.142 12508445 33.858620 32.8751 318.142 298.000 3 87520 28.7111  5.4058 .
61 318.143 12508947 33.860833 32.8751 318.143 298.000 3 8.7520 28.7111 5.4058 f"’st tWo rOWS
64 318.141 12500448 33.859203 32,8751 318.141 298.000 3 8.7520 28,7111  5.4058
65 318.141 12509949 33.858824 32,8751 318.141 298.000 3 87520 28.7111  5.4058
68 318.141 12510450 33.858203 32.8751 318.141 298.000 3 87520 28.7111  5.4059 of data
69 318.142 12510951 33.857045 2. 51 8.142 298.000 3 8.7520 28.7111 5.4059
69 318.143 12511452 33.853973 32.8751 318.143 298.000 3 8.7520 28.7111 5.4080
1143 12511953 33.854884 32,8751 318.143 298.000 38,7520 28,7111 5.4060
3181142 12512454 33.855488 32.8751 318.142 298.000 3 87520 28.7111  5.4060
318.142 12512955 33.855403 32.8751 318.142 298.000 3 8.7520 28.7111 5.4060
318.142 12513456 33.855701 32.8751 318.142 298.000 3 8.7520 28.7111 5.4080
318.141 12513957 33.859983 32,8751 318.141 298,000 38,7520 28,7111 5.4058
7 3181142 12514458 33.854918 32.8751 318.142 298.000 3 87520 28.7111  5.4060
7.5070 318.141 12514959 33.854527 32.8751 318.141 298.000 77.243 8.7520 28.7111 5.4060
7.5070 318.142 12515460 33.854978 32.8751 318.142 298.000 77.243 8.7520 28.7111 5.4060 -
’

Sample of Transient Data

# Time (minutes)
x=datal[:, 3]
x = x/1000/60

Data File Column Descriptions on page E - 3identifies the columns of data recorded. The fourth
column of data contains time in milliseconds, however, the first index in Python is O; therefore,
data[:, 3] captures all of the rows (:) in the fourth column.

plt.plot (x,y, 'ko")

plt.ylabel ('Pressure (torr)"')
plt.xlabel ('time (minutes)')
plt.show ()

The above code shows the syntax for plotting. The label ko’ indicates filled black circles.
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CHEMICAL ADSORPTION TEMPERATURE RAMP DATA

ASAP 2020 data can be captured during chemical adsorption analyses by connecting to port 54200
(see Data Logging on page E - 1). Time and sample temperature are sent every half second
when the external trigger is set to ON. This is typically done during a flowing preparation temperature
ramp. The data columns are

A. Time(s)
B. Sample temperature (°C)

The External Trigger in the analyzer application must be enabled for this data to be available.

« Tomanually set the trigger go to Unit [n] > Enable Manual Control, right click the External Trig-
gericon and select ON. The box is dark when enabled.

« Enable the Set external trigger box in a Preparation Flow Task in the Analysis Conditions to col-
lect temperature data that is synchronized with an external mass spectrometer or other detector
to be started by the external trigger signal.
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[M] micromeritics’ F DFT Models

F DFT MoDELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physical adsorption were quite simple,
both conceptually and mathematically, for very practical reasons — hand computations were
required. Today we can explore complex models that describe adsorption systems on the atomic
scale of size and sub-picosecond time frame. This is not because scientists are smarter, but because
of available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS

Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (V,,,), and the molar intensity of the
gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules with
each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters for the
effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the microscopic
properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size,
the pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded over
time. In this situation, the pressure falls rapidly from its initial value and gradually approaches a
steady reading, called the equilibrium pressure. The amount adsorbed corresponds to the
quantity of gas effectively removed from the gas phase by the solid surface. A graph that plots
amount adsorbed versus equilibrium pressure is called an adsorption isotherm.
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Under such conditions, the argon atoms that randomly enter the pore space feel the presence of
the solid surface as the action of an external attractive force (the dispersion forces or Van der
Waal’s forces) and spend more time near the surface. As a result, the space near the surface
acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a function
of pressure and the molecular properties of the components of the system, then a model could
be constructed for the adsorption isotherm for the system. Modern physical chemistry provides
several ways to calculate this distribution. All these methods are based on the fundamental
thermodynamic law that such a system adopts a configuration of minimum free energy at
equilibrium. Also needed is a description of the pairwise interaction energy between atoms, U(s),
commonly given by a Lennard-Jones potential:

U(s) =4e(5)"? — (3)°
where

€ = a characteristic energy of the adsorptive,
o = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MoLECULAR DYNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are calculated
over time at very short intervals. This method takes into account both the forces acting between the
gas particles themselves and those acting between the gas particles and the atoms of the simulated
surface. As the simulated particles collide with each other and with the surface, the average
concentration of particles in the space near the surface is calculated; this calculation yields the
amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are simple,
the number of calculations required for a system of even a few hundred particles is astronomical and
challenges even the fastest computers.
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MoNTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the system.
The system is “equilibrated” through a process of randomly selecting one particle and conditionally
moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and another
particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated, and a
random number between zero and one is generated. If the generated number is smaller than the
probability of the event, then the move is accepted; otherwise, another particle is selected and the
process is repeated. This process continues until the average total energy of the system no longer
decreases; at this point, average configuration data are accumulated to yield the mean density
distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical way
to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION

Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer calculations.
Because the density functional theory provides accuracy and a reduced number of calculations, it is
the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated by a
distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of
constant density; its chemical potential! ) is determined by the pressure of the system using well-
known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).
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As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory describes
the thermodynamic grand potential as a functional of the single-particle density distribution;
therefore, calculating the density profile that minimizes the GPE yields the equilibrium density profile.
The calculation method requires the solution of a system of complex integral equations that are
implicit functions of the density vector. Since analytic solutions are not possible, the problem must be
solved using iterative numerical methods. Although calculations using these methods still require
supercomputing speed, the calculation of many isotherm pressure points for a wide range of pore
sizes is a feasible task. The complete details of the theory and the mathematics can be found in the
papers listed under DFT Model References on page F - 17.

The following graphs and accompanying text illustrate the results of using density functional theory to
predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Density (particle A-3)
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Figure 1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise distribution
of adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area
under the profile curve represents the amount adsorbed per unit area at this pressure. The positions
of the maxima are separated by a distance determined by the size of the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the
integral over the profile. Repeating this calculation over a range of pressures yields the adsorption
isotherm for the model. If the value of H is very large, the isotherm obtained corresponds to that of an
external, or free, surface. If H is smaller, a range of pressures is reached where two minima exist for
the grand potential, showing the presence of two metastable phases having different density
distributions but the same chemical potential. The phase with the lower GPE is the stable one. As the
pressure is increased, a point is reached where the other phase becomes the stable one. This phase
transition reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the
critical pore-filling pressure. This pressure is analogous to the condensation pressure predicted by
the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms. The
inset shows the density profiles for the corresponding points of the isotherm.
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Figure 2. Model Isotherm for Argon at 87.3 K in a 40 A Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to
the surface.

« Inset a shows the profile corresponding to point a on the isotherm where the surface is about half
covered.

« Atpoint b, the first layer is so full that it is more favorable for atoms to start a new layer.

« Atpoint ¢, athird layer is forming. Point ¢, for this size slit, is the critical pore-filling pressure. In
inset ¢, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or
5 molecular diameters from the surface.

« Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of
the pore, indicating a phase transition.
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F DFT Models

Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point ¢. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores are
shown. ltis clear that pore size is uniquely characterized by a corresponding critical pore-filling
pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.
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Figure 3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale for
pressure.
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Figure 4. Model Isotherms in the Micropore Size Range of Pore Width Argon on Carbon at
87.3K
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Pores of 4 A width, barely larger than the argon atom (3.38 A), fill at pressures below 1 millitorr.
Pores below 15 A fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit

Substrate: Carbon (graphite)

Category: Porosity

Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been calculated
to serve as kernel functions for the characterization of porous solids from adsorption data. The model
isotherms are stored in binary format files. These models assume a slit-like pore geometry. The pore
size range from 4.0 to 4000 A is covered in 91 classes in a geometric progression. The class intervals
are rounded to the nearest 0.02 molecular diameters. A model for the free or external surface is
included to account for unfilled pores. Each of the 92 model isotherms has been calculated at 181
pressure points from near 1x 1 0% to near 1.00 relative pressure.

These models are identical to those supplied with the original DOS version of DFT software. Some
slight difference from the DOS results may be noted when they are applied to the same data due to
improvements in the deconvolution algorithm and better regularization of the current software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K

Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page F - 17 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the micropore
region. If the sample solid contains small mesopores, the isotherm data should be truncated (using
the Select Data Points window) to a suitably low relative pressure to avoid trying to fit this region;
mesopore filling reports as a large area of low energy in the calculated distribution of adsorptive
potential.
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The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder

Substrate: Oxide

Category: Porosity

Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 A and the AR model from 3.8
to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the Accur-
ate Pore Size Analysis of MCM-41 and Other Silica-Based Mesoporous
Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 - Cylindrical Pores — Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity

Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference samples
of montmorillionite. The construction method for the hybrid models was analogous to that described
in the first reference below (Jaroniec et al,1999). The additional references add additional theoretical
details as well as examples of the application of the model to pillared clay catalysts. This model
reports pore widths from 3.8 to 387 angstroms.

References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V', Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of a
Pillared Interlayered Clay (PILC) from a Hybrid Density Functional Theory
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C02 - DFT Model

Geometry:
Substrate:
Category:
Method:

(DFT) Method,” The Journal of Physical Chemistry B; 2001, 105(3), 623-
629.

M. L. Ocecelli, J. P. Qlivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded Clay
Catalysts from Hybrid Density Functional Theory (DFT) and Adsorption
Microcalorimetry Methods,” Langmuir 2002, 18, 9816-9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in Developing
Characterization Methods.” 61 International Symposium on the
Characterization of Porous Solids, Studies in Surface Science and Catalysis
144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,” Microporous and Mesoporous Materials 2003, 57, 291-296.

Slit

Carbon

Porosity

Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing molecular
parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry:
Substrate:
Category:
Method:

Free surface
Any

Surface energy
Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

Geometry:
Substrate:
Category:
Method:

Cylinder

Oxide

Porosity
Nitrogen at 77K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for a
silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit

Substrate: Carbon

Category: Porosity

Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit

Substrate: Carbon

Category: Porosity

Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of
6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.
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References:  Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit

Substrate: Carbon

Category: Porosity

Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or X-
ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore structure
analysis.,” The Journal of Physical Chemistry C, 113(45):19382-19385,
20009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder

Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P.Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).
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N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder

Substrate: Carbon

Category: Porosity

Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argonat77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an infinitely
long cylinder.

This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argonat77 K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an infinitely
long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES

Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. (Log in to your
customer portal to access the Calculations document.) Be aware that the deconvolution method only
provides a fitting mechanism; it does not overcome any inherent shortcomings in the underlying
theory.

SURFACE ENERGY

The use of classical theories to extract adsorptive potential distribution is mostly of historical interest.
At a minimum, the equation must contain a parameter dependent on adsorption energy and another
dependent on monolayer capacity or surface area. This is sufficient to permit the calculation of the
set of model isotherms that is used to create a library model. The Langmuir equation has been used
in the past, as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these
suffer from the fact that they only describe monolayer adsorption, whereas the data may include
contributions from multilayer formation.

PORE SIZE

Itis well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure, this
knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the pore
wall.
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The commonly used practical methods of extracting mesopore distribution from isotherm data using
Kelvin-based theories, such as the BJH method, were for the most part developed decades ago and
were designed for hand computation using relatively few experimental points. In general, these
methods visualize the incremental decomposition of an experimental isotherm, starting at the highest
relative pressure or pore size. At each step, the quantity of adsorptive involved is divided between
pore emptying and film thinning processes and exactly is accounted for. This computational
algorithm frequently leads to inconsistencies when carried to small mesopore sizes. If the thickness
curve used is too steep, it finally will predict a larger increment of adsorptive for a given pressure
increment than is actually observed; since a negative pore volume is non-physical, the algorithm
must stop. Conversely, if the thickness curve used underestimates film thinning, accumulated error
results in the calculation of an overly large volume of (possibly nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions
corresponding to various classical Kelvin-based methods have been calculated for differing
geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

5.00 /3
t= 3'54<zn(P)P0)>

The nitrogen properties used in the Kelvin equation are:

Surface tension=  8.88 dynes cm™
Molar density = 0.02887 gcm™

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K
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The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

1/2
_ 13.99
t=3.54 ( 0.034—log(P/Py) )

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm™"
Molar density = 0.02887 gcm™

N2 - Harkins and Jura Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J.H. DeBoeretal., J. Colloid and Interface Sci. 21, 405 (1966).

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K
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The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:
- _ t
log (p/po) _ 1t62.11 10.1682-01137
The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm™"
Molar density = 0.02887g cm™

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the International
Symposium on Surface Area Determination, D.H. Everett, R.H. Ottwill,
eds., U.K. (1969).
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DFT MODEL REFERENCES

The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of Adsorp-
tion and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micromeritics
Instrument Corp; presented at the International Symposium on the Effects of Surface Hetero-
geneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July 1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,” Perla
B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier Science Pub-
lishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated by
Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference on
the Fundamentals of Adsorption, Pacific Grove, CA (1995).
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G EXPORTED DATA EXAMPLE

PHYSICAL ADSORPTION

Sample Information

Method: pDefault
Sample: Alumina 004,/16816/00 (Lot 152624-14)
operator: H. Harmon/jch
Submitter: SN3001
Mass tyEe: Calculated
EmpTy Tube 3B.8290 g
Sample + tube: 41.0238 g
Sample mass: 2.1948
Density: 1.000 g/cm™
Type of data: Automatically collected
Instrument tType: 2020
original instrument type: 2020
comments : Nitrogen adsorbate
Sample Tube
sample tube: sample Tube
warm free space: 1.0000 cm®
Cold free space: 1.0000 cm®
Non-ideality factor: 0. 0000620
Use isothermal jacket: Yes
Use filler rod: Yes
vacuum seal type: None
Degas Conditions
Degas conditions: Degas Conditions

Evacuation Phase

Temperature ramp rate: 10.0 *C/min
Target Temperature: 400 *C
Evacuation rate: 5.0 mmHg/s
Unrest. evacuation from: 5.0 mmHg
vacuum level: 1.000000e-02 mmHg
Evacuation time: 10 min

Heating Phase

Ramp rate: 10.0 *C/min
Hold temp: 400 °C
Hold time: 60 min

Evacuation and Heating Phases

Hold pressure: 100 mmHg
Backfill
Backfill sample tube: Yes

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-) — Feb 2019



G Exported Data Example

[M] micromeritics®

analysis conditions: Run Conditions
Absolute pressure dosing: NO

Pressure Table

starting Pressure Ending
Pressure Increment Pressure
(p/Pa) (p/Pol (p/Po)
0. 000000000 0. 050000000 0. 200000000
Preparation
Fast ewvacuation: NO
Unrestricted evacuation from: 5.0 mmHg
Vacuum setpoint: 10 pmHg
Evacuation time: 0.25 h
Leak test: NO
Use TranSeal: NO

Free space

Measured before analysis

Lower Dewar for evacuation: Yes
Evacuation time: 0.10 h
gutgas test: NO

Po and Temperature

PO type: Measured in Psat tube for each point
Temperature type: Entered
Temperature: 77.300 K
Dosing
use first pressure fixed dose: NO
Use maximum volume increment: NO

Target tolerance:
Low pressure dosing: Mo

Equilibration

relative
Prassure Equilibration
(P/PO) Interval (s)
1 1. 000000000 10

Minimum equilibration delay at P/Po >= 0.995:

Sample Backfill

2.0% or 2.000 mmHg

600 s

Backfill at start of analysis: Yes
Backfill at end of analysis: Yes
Backfill gas: N2
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Adsorptive Properties

Adsorptive:

Non-condensing adsorptive:

Maximum manifold pressure:

Therm. tran.
Molecular cross-sectional area:
Adsorbate molecular weight:

hard-sphere diameter:

Thermal conductivity:

Real gas equation of state
Adsorbed-phase free-space correction:

Fluid properties:

posing method:

Psat vs. Temperature Table

saturation
Pressure

(mmHg)

riri
i

Siom=lghu Bkl

=

Report Options

Summary: Yes

607.
645,
686.
728.
737.
746,
755,
764,
L0735
819.

(K

192
E1E8
302
702
417
211
085
040

481

Temperature

. 50
.00
.50
.00
.10
.20
.30
.40
. 50
.00

I B B A B B B B Bt Bt |

L R B B B B B e Wy R |

Report options:
Show report title:
Report title:

show graphic:
Ggraphic file:
Graphic height:
Graphic width:
Apply thermal transpiration correction:

surface Area

Single-point BET: Yes
Multi-point BET: Yes

Langmuir : NO

t-Plot Micropore: NO

t-Plot External: No

BJH Cumulative Adsorption: Mo
BJH Cumulative Desorption: No
D-H Cum. Adsorption: NO

D-H Cum. Desorption: NO

nitrogen (N2)
NO

925.00 mmHg
3.5770 A
0.162 nm*
28.01

1.00

Yes

Mormal

Report oOptions
Yes

Yes
miclogo. emf
0.250 1n
2.000 in

MO

C:\2020NITROGEN. FPI
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Pore volume

Adsorption Total: NO
Desorption Total: NO
t-Plot Micropore: NO
EJH Cum. Adsorption: MO
EJH Cum. Desorption: MO
D-H Cum. Adsorption: NO
D-H Cum. Desorption: NO
Pore size
Average pore diameter: No
BEJH adsorption avg.: No
BEJH desorption avg.: No
D-H adsorption avg.: NO
D-H desorption avg. : NO
other
Freundlich: ND
Temkin: Mo
Alpha-5 method: No
DFT Pore size: NO
DFT Surface Energy: NO
Manoparticle Size: ND

Horvath-Kawazoe

Maximum pore wvolume: MO
Median pore width: MO

Dubinin-radushkevich

Micropore surface area: NGO
Monolayer capacity: NO

pubinin-aAstakhov

Micropore surface area:
Limiting micropore volume:

MP-Method

cumulative surface area:
Cumulative pore volume:
Average pore hydraulic radius:

Pass/Fail

Pass/Fail 1:

MO
MO

NO
NO
NO

S A:5ingle-point BET:

High Range value: 0.2600 m=/g
High Range Message: SP UL
Low Range wvalue: 0.2000 m*/g
Low Range Message: SP LL
Pass/Fail 2: S A:Multi-point BET:
High Range wvalue: 0.2700 m*/g
High Range Message: MP UL
Low Range value: 0.2100 m=/g
Low Range Message: MP LL
Pass/Fail 3: NO
Pass/Fail 4: NO
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Isotherm: yes

Isotherm Reports

Elapsed time: Yes
Time between points: MO
Plot adsorption branch: Yes
Plot desorption branch: Yes
Quantity adsorbed: Fer Gram
Tabular report selected: Yes
Linear plot selected: Yes
Logarithmic plot selected: Yes
Linear absolute plot selected: Yes
Pressure composition plot selected: Yes

Isotherm Linear Plot axis data

Plot curwve: Yes
Plot points: Yes
overlay samples: NO
Autoscale X axis: Yes
Autoscale ¥ axis: Yes

Isotherm Log Plot axis data

Plot curve: Yes
Plot points: Yes
overlay samples: NO
Autoscale X axis: Yes
Autoscale ¥ axis: Yes

Isotherm Linear Absolute Plot axis data

Plot curve: Yes
Plot points: Yes
overlay samples: NO
Autoscale X axis: Yes
Autoscale ¥ axis: Yes

Isotherm Log aAbsolute Plot axis data

Plot curve: Yes
Plot points: Yes
overlay samples: Mo
Autoscale X axis: Yes
Autoscale ¥ axis: Yes

Isotherm Pressure Composition axis data

Plot curve: Yes
Plot points: Yes
overlay samples: NO
Autoscale X axis: Yes
Autoscale ¥ axis: Yes
BET: ¥Yes
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BET: Yes

Tabular report selected:
Transform plot selected:
overlay Samples:
Autoscale X axis:
Autoscale Y axis:

Isotherm plot selected:
overlay Samples:
Autoscale X axis:
Autoscale Y axis:

Fit pressure range:
Langmuir: No
Freundlich: No
Temkin: No
t-Plot: No
Alpha-5 Method: No
f-ratio method: NoO
BJH adsorption: No
BJH Desorption: NoO
polTimore-Heal Ads
polTlimore-Heal Des

Horvath-Kawazoe: N

BET Reports

Yes
Yes
No

Yes
Yes

NO
NO
Yes
Yes

0.050000000 to 0.300000000 P/Po

orption: No

orption: No

o

NLDFT Advanced PSD: No

DFT Pore 5ize: No

DFT surface Energy: No

pubinin: No
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Dubinin: No
MP-Method: Mo
Advanced Rpt.: NoO
options: No
Sample Log: Yes
validation: No
Manufacturing: No

Collected Data

start time: 10/30/2014 2:50:40 PM
End time: 10/30/2014 4:41:59 PM
Type of instrument: E
unit number : 1
Serial number: 3001
Analysis conditions modified: NoO

Po and Temperature

PO Type: Mmeasured in Psat tube for each point
Average Po: 739,890 mmHg
Temperature type: Entered
Temperature: 77.300 K

Psat measurements

Run
time Pressure
(min) {mmHg)

63 740,054
79 739,853
g1 739,841
&3 739,826
85 739,853
g8 739.879
90 739.923

R s RO T N ]

Free Space

Measured before analysis
wWarm free space: 15.4586 cm®
cold free space: 44,7536 cm®
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Isotherm Data Table

Absolute Quantity Quantity Run
Pressure Dosed Adsorbed Time
(mmHg) {mma1) (mmol,/g) (min)
38.165455 0.105E8 0.00247 79
73.716278 0.20036 0.00274 81
110. 708160 0.298E5 0.00293 83
148. 010361 0. 39851 0.00313 85
184, 897751 0.49737 0.00329 B8
221.801132 0. 59670 0.00349 a0
sample log
sample log
Date Time Log Message
10/30/2014 11:09:32 aMm Degas operation started on unit 1
10/30,/2014 11:09:32 aMm started evacuation at 5.0 mmHg/s €
10/30/2014 11:23:30 AM Started temperature ramp at 10.0 °
10/30/2014 11:48:20 AM Started temperature hold at 400 °C
10/30/2014 12:458:21 PM started cool-down wait.
10/30,/2014 1:35:27 PM started backfilling.
10,/30,/2014 1:35:49 PM Degas operation done.
10/30/2014 2:50:40 PM Analysis on file C:“ASAP 2020 Plu.
10/30/2014 4:41:59 PM Aanalysis on file C:hASAP 2020 Plu.
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sample Information
Method: pefault
sample: 1 wt.% Pd on aAlumina (75C)
operator: MM
submitter: JK
Mass type: calculated
Empty tube 22.3748 g |
Sample + tube: 23.4244 g
Sample mass: 1.0496
Density: 1.000 g/cm®
Type of data: Automatically collected
Instrument type: 2020Chemi
original instrument type: 2020Chemi
comments:
Active Metals Table
Percent
0
Sample Percent
atomic Cross Sect pensit weight reduced MOy MxOy
Element Atomic wWeight Area (nm=) (g/cm’{ (9] %) XY
chromium 51.9960 0.0835 7.190 0.00 100.00 1 0
Adsorptive stoichiometry
Hydrogen 2.000
oxygen 2.000
carbon Monoxide 1.000
cobalt 58.9330 0. 0862 8.900 0.00 100.00 1 0
Adsorptive stoichiometry
Hydrogen 2.000
oxygen 2.000
Carbon Monoxide 1.000
copper 63, 5400 0. 0680 8.960 0.00 100.00 1 0
Adsorptive stoichiometry
Hydrogen 2. 000
oxygen 2.000
Carbon Monoxide 1.000
molybdenum 95. 9400 0.0730 10.220 0.00 100.00 1 0
Adsorptive stoichiometry
Hydrogen 2.000
Oxygen 2.000
Carbon Monoxide 1.000
nickel 58.7100 0.0649 8.902 0.00 100.00 1 0
adsorptive stoichiometry
Hydrogen 000
oxygen 2.000
Carbon Monoxide 1.000
palladium 106.4000 0.0787 12.020 1.00 100.00 1 0
Adsorptive Stoichiometry
Hydrogen 2.000
axygen 2.000
Carbon Monoxide 1.000
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platinum 195.0900 0.0800 21.450 0.00 100.00
Adsorptive Stoichiometry
Hydrogen 2. 000
oxygen 2.000
carbon Monoxide 1.000

rhenium 186.2000 0.0649 21.020 0.00 100.00
Adsorptive stoichiometry
Hydrogen 2.000
oxygen 2.000
Carbon Monoxide 1.000

rhodium 102.9050 0.0752 12.410 0.00 100.00
Adsorptive stoichiometry
Hydrogen 2.000
oxygen 2.000
Carbon Monoxide 1.000

silver 107. 8680 0.0869 10. 500 0.00 100.00
Adsorptive stoichiometry
Hydrogen 2.000
axygen 2.000
carbon Monoxide 1.000

jegas Conditions
Degas conditions: Degas Conditions
Evacuation Phase

Temperature ramp rate:

1.0 K/min
Target temperature: 303 K

Evacuation rate: 5.0 mmHg/s
unrest. evacuation from: 5.0 mmHg
vacuum Tevel: 1.000000e-02 mmHg
Evacuation time: 0 min

Heating Phase

Ramp rate: 1.0 k/min
Hold temp: 303 K
Hold time: 10 min

Evacuation and Heating Phases

Hold pressure: 100 mmHg
Backfill
Backfill sample tube: Yes
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analysis Conditions

Analysis conditions:

Fre-analysis evacuation time:

Repeat analysis:

Repeat analysis evacuation time:

Equilibration time:

Adsorptive:

Mon-condensing adsorptive: NO
Maximum manifold pressure: 925.00 mmHg
Molecular cross-sectional area: 0.123 nm*
Adsorbate molecular weight: 2.02
Thermal conductivity: 1.00
Non-ideality factor: 0.0000620
Density conversion factor: 0.0015468
Pressure Table
starting Pressure Ending
Pressure Increment Pressure
(mmHg) (mmHg) (mmHg)
0. 000000 1. 000000
1.000000 2.000000
2.000000 3. 000000
3. 000000 4.000000
4. 000000 5.000000
5.000000 6. 000000
6. 000000 7.000000
7000000 &. 000000
8. 000000 9. 000000
9. 000000 10. 000000
10. 000000 20.000000
20.000000 30. 000000
30. 000000 40. 000000
40. 000000 50. 000000
50. 000000 60. 000000
0. 000000 70.000000
70.000000 £80. 000000
£0.000000 90. 000000
90. 000000 100. 000000
100. 000000 125.000000
125.000000 150. 000000
150. 000000 175. 000000
175.000000 200. 000000
200. 000000 225.000000
225.000000 250.000000
250.000000 275.000000
275.000000 300. 000000
300. 000000 325.000000
325.000000 350. 000000
350. 000000 375.000000
375.000000 400. 000000
400. 000000 425.000000
425.000000 450. 000000
450. 000000 475. 000000
475.000000 500. 000000

2

Hydrogen (H2)

0.50 h

Yes

1.00 h
0

Paladium for Performance testing
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Preparation Options

Backfill and match transducer: Yes
Backfill gas: Helium
Fast evacuation: NO
Unrestricted evac. from: 5.0 mmHg
vacuum Level: 1.0e-02 mmHg
Evacuation time: 0.17 h

Analysis Task 1 - Evacuation

Backfill gas:
Evacuate for 10 min

below 10 pmHg.

Fast evacuation: ND
Unrestricted evacuation pressure: 5.0 mmHg
Temperature: 373.1 K
Temperature rate: 10.0 K/min

Analysis Task 2 - Flow

Gas: Hydrogen
Time: 30 min
Temperature: 623.1 K
Temperature rate: 10.0 K/min
Set external trigger: MO

Analysis Task 3 - Evacuation

Backfill gas:
Evacuate for 180 min

below 10 pmHg.

Fast evacuation: NO
Unrestricted evacuation pressure: 5.0 mmHg
Temperature: 648.1 K
Temperature rate: 10.0 K/ min

analysis Task 4 - Evacuation

Backfill gas:
Evacuate for 5 min

below 10 pmHg.

Fast evacuation: NO
Unrestricted evacuation pressure: 5.0 mmHg
Temperature: 308.1 K
Temperature rate: 10.0 K/min

Analysis Task 5 - Leak Test

outgas rate limit:
Temperature:
Temperature rate:

1.0e-02 mmHg,/min
308.1 K
10.0 K/ min

Free Space Options

Free space type: Measure after analysis

Estimated analysis free space: 0.0000 cm*
Temperature Options
Temperature control: Furnace
analysis temperature: 348.1 K
Temperature rate: 10.0 K/min
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Dosing Options
Absolute pressure tolerance: 5.000 mmHg
Relative pressure tolerance: 5.0 %
Low pressure incremental dose mode: Yes
Low pressure dose: 0.00045 mmol/g
Dose delay: 10 =
Termination Ooptions
Backfill after analysis: Yes
Cool to < 50 °C: Yes
Report Options
Report options: Report Options
Show report title: Yes
Report title:
show graphic: Yes
graphic file: miclogo. emf
Graphic height: 0.250 in
Graphic width: 2.000 in
Use thermal transpiration correction: NO
Isotherm: yes
Tabular report selected: Yes
Plot report selected: Yes
¥-axis scale: Logarithmic
Plot analysis: Yes
Plot repeat analysis: Yes
Isotherm Plot Options
Plot curve: Yes
plot points: Yes
overlay samples: Yes
Autoscale X axis: Yes
Autoscale Y axis: Yes
pifference Mmethod: yes
summary report selected: Yes
Report analysis: Yes
Report repeat analysis: NO
Report differences: Yes
Tabular report selected: Yes
Plot report selected: Yes
Plot analysis: Yes
Plot repeat analysis: Yes
Plot difference: Yes
MicroActive ASAP 2020 Operator Manual G-13
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[M] micromeritics®

Difference Plot Options

Plot curwve:

Plot points:
overlay samples:
Autoscale X axis:
Autoscale ¥ axis:

sinfelt method:

Yes
Yes
NO

Yes
Yes

NO

Langmuir Surface Area: No

Freundlich: No
Temkin: No
Advanced Rpt.:
options: Yes
Sample Log: No
Manufacturing:

Collected Data

Start time:

End time:

unit number :

Serial number:

Port:

Analysis temperature:
Measured free space:
Free space Time:

NO

NO

11,/29/2014

3:23:19 Aam

11/29,/2014 11:38:28 PM

1

3003

2

34E.1 K
14.9139 cm?
852 min
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collected Data Table

Repeat
analysis: Repeat
Run quantity Quantity  Run analysis: quantity qQuantity
Time Pressure Adsorbed Dosed Time Pressure Adsorbed Dosed
{min) (mmHg) (mmol/g) (mmal/g) (min) (mmHg) (mmaol/g) (mmal/g)
30 0.002637 0.00090 0.000%90
35 0.003838 0.00178 0.00179
41 0. 004668 0.00267 0.00267
46 0.005317 0.00355 0.00355
52 0.005948 0.00443 0.00444
7 0.006435 0.00531 0.00532
62 0.007271 0.00619 0.00620
68 0.008303 0.00708 0.00708
7 0.009200 0.00795 0.00796
7 0.010396 0.008E3 0.00884
85 0.011568 0.00971 0.00972
91 0.012362 0.01059 0.01060
7 0.013600 0.01146 0.01148
104 0.014478 0.01234 0.01235
109 0.033804 0.01315 0.01318
115 0.090354 0.01380 0.01388
121 0.193552 0.01431 0.01448
126 0.340375 0.01469 0.01498
131 0.535525 0.01501 0.01545
139 0.836338 0.01533 0.01603
145 1.052009 0.01550 0.01638
27 6.241356 0. 01687 0.02208 665 6. 273385 0.00536 0.01059
27 6.241356 0.01687 0.02208
27 6.241356 0.01687 0.02208
278 6.241356 0. 01687 0.02208
278 6.241356 0.01687 0.02208
665 6. 273385 0.00536 0.01059
065 6.273385 0.00536 0.01059
865 6. 273385 0.00536 0.01059
665 6. 273385 0.00536 0.01059
865 6. 273385 0.00536 0.01059
282 7.484013 0.01711 0.02335 669 7.526332 0. 00557 0.01185
286 8.541224 0.01728 0.02441 673 B8.436768 0.00565 0.01269
289 9. 848126 0.01744 0.02565 67 9. 72B8E3 0. 00577 0.01389
293 10.917328 0.01756 0.02666 680 10.615537 0.00589 0.01475
208 19. 890688 0.01811 0.03470 BE5 20.104963 0. 00649 0.02326
302 28.752640 0.01865 0.04264 689 29.306334 0. 00701 0.03145
306 38.015160 0.01914 0.05085 693 39. 215008 0.00744 0.04015
310 48.783615 0.01970 0.06039 697 49.144562 0. 00792 0.04892
314 58.990738 0.02022 0.06943 701 59.051441 0.00842 0.05768
318 68. 679893 0.02077 0.07805 705 68. 375412 0. 00896 0. 06600
322 78.915894 0.02145 0.08B728 709 78.936531 0. 00967 0.07552
326 89.067955 0.02247 0.096786 713 88. 980087 0.01046 0.08468
330 98. 893509 0.02365 0.10614 717 99.114769 0.01150 0.09417
335 125. 573486 0.02631 0.12105 722 125. 358635 0.01475 0.11931
340 147.B73566 0.02836 0.15171 727 148, 222244 0.01677 0.14041
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340 147. 873566 0.02836 0.1517 727 148, 222244 0.01677 0.14041
344 172.599884 0.03015 0.17412 731 172.549377 0.01819 0.16212
348 197. 348206 0.03122 0.19584 735 197.172211 0.01907 0.18354
352 222.420517 0.03183 0.21737 739 222.105453 0.01969 0.20496
356 247.266022 0.03230 0.23855 743 247.074768 0.02016 0.22625
360 272.295044 0.03259 0.2597 747 271.989532 0.02045 0.24733
364 296, 974365 0.03324 0. 28096 751 297.,237274 0.02074 0. 26867
368 321.808319 0. 03456 0.30299 755 322.047058 0.02096 0.284959
37 347.283539 0.03452 0.32420 759 346.784119 0.02215 0.31141
37 372.285522 0.03431 0. 34484 763 372.017487 0.02287 0.33318
380 397.179291 0.03433 0.36565 768 397.353577 0.02244 0. 35388
385 422.055664 0.03470 0. 38675 77 422,019257 0.02236 0.37438
389 447 _ 089996 0.03474 0.40767 77 446.954742 0.02255 0.39537
393 471.972290 0.03502 0.4287 780 472.161102 0.02265 0.41650
397 496.971558 0.03504 0.44958 784 497 ,032837 0.02284 0.43743
REpeat
RUN quantity analysis: quantity
Time Pressure Adsorbed Pressure Adsorbed
(min) (mmHg) (mmol/g) (mmHg) (mmo1/g9) piff. Sinf. Lang. Freu. Temk.
30 0.002637 0. 00090
35 0.003838 0.00178
41 0.004668 0.00267
46 0.005317 0.00355
52 0.005948 0.00443
7 0.006435 0.00531
62 0.007271 0. 00619
68 0.008303 0.00708
7 0.009200 0.00795
7 0.010396 0.00883
&5 0.011568 0.00971
al 0.012362 0.01059
7 0.013600 0.01146
104 0.014478 0.01234
109 0.033804 0.013215
115 0.090354 0.01380
121 0.193552 0.01431
126 0.340375 0.01469
131 0.535525 0.01501
139 0.836338 0.01533
145 1.052009 0.01550
78 6.241356 0. 01687 6.273385 0.00536
27 6.241356 0. 01687
278 6.241356 0.01687
278 6.241356 0. 0187
278 6.241356 0. 01687
6.273385 0.00536
6.273385 0.00536
6.273385 0.00536
6.273385 0.00536
6.273385 0.00536
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282 7.484013 0.01711 7.526332 0.00557
286 B.541224 0.01728 B.436768 0.00565
289 9., 848126 0.01744 G,728883 0.00577
293 10.917328 0.01756 10. 615537 0.00589
298 19, 890688 0.01811 20.104963 0.00649
302 28, 752640 0.01865 29, 306334 0.00701
306 38. 015160 0.01914 39, 215008 0.00744
310 48, 783615 0.01970 48,144562 0.00792
314 58.990738 0.02022 59.051441 0.00842
318 68, 679893 0.02077 68, 375412 0.00896
322 78.915894 0.02145 78.936531 0. 00967
326 89, 067955 0.02247 88, 9B0OOEY 0.01046
330 Q8. 93509 0.02365 99.,114769 0.01150
335 125. 573486 0.02631 125. 358635 0.01475
340 147, 873566 0.02836 148, 222244 0.01677
344 172. 599884 0.02015 172, 549377 0.01819
348 197, 348206 0.03122 197.172211 0.01907
352 222.420517 0.03185 222.105453 0.01969
356 247 . 2600022 0.03230 247.074768 0.02016
360 272.295044 0.032259 271.989532 0.02045
364 296. 974365 0.03324 297.237274 0.0207
368 321. 808319 0.03456 322.047058 0.02096
372 347, 283539 0.03452 346. 784119 0.02215
376 372, 285522 0.03431 372.017487 0.02287
380 397.179291 0.03435 397, 353577 0.02244
385 422.055664 0.03470 422.019257 0.02236
389 447 . 089996 0.023474 446.954742 0.02255
393 471.972290 0.03502 472.161102 0.02265
3497 496. 971558 0.03504 497 . 032837 0.02284
Experiment Log
start Furnace Sample
Task Task Time Temp Temp Time Pressure
Number Name {h:mind Gas (K) (KD (min) (mmHg)
1 EVAC 0:02 311.9 314.8 10
2 EVAC 0:18 375.6 373.4 10
3 FLOW 0:34 H2 615.5 623.1 30 684 . 224182
4 EVAC 1:25 637.8 e47.7 180
5 EVAC 4:31 304.9 I08.5 5
3] LEAK 5:09 304.9 I08. 3 1 0.009992
7 EVAC 5:13 350.6 348.4 30
Leak Test Results
Max1mum
AlTowed Observed
start outgas outgas
Time Rate Rate
Ch:min) {mmHg,/min) {mmHg,/min) status
5:13 1.0e02 3. 0e04 Pass
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Sample log
Date Time Log Message

11,27 /2014 9:55:02 AM Analysis on file C:ZASAP 2020 Chemi Plus'dz
11,/27 /2014 9:55:11 am A sample analysis for C:“ASAP 2020 Chemi P
11,/27 /2014 9:55:17 AamM A sample analysis for C:\ASAP 2020 Chemi FP]
11,27 /2014 0:55:20 aMm A sample analysis for C:%ASAP 2020 Chemi P
11/27 /2014 9:55:29 aM A sample analysis for C:“ASAP 2020 Chemi FP]
11,/27 /2014 9:55:34 AaM A sample analysis for C:“%ASAP 2020 Chemi P
11/27 /2014 9:55:37 aMm A sample analysis for C:“ASAP 2020 Chemi Pl
11/27 /2014 9:55:40 am A sample analysis for C:%ASAaP 2020 Chemi P
11,/27 /2014 9:55:43 AM A sample analysis for C:h%AsAp 2020 Chemi P
11,/27 /2014 9:55:48 AM A sample analysis for C:ZASAP 2020 Chemi P
11,/27 /2014 9:55:54 AM Manual: Close valwve 6.

11,27 /2014 0:56:04 aMm A sample analysis for C:%ASAP 2020 Chemi P
11/27 /2014 9:56:53 AaM analysis on file C:“AsAP 2020 Chemi Plus'.da
11,/29,/2014 3:23:19 aMm Analysis on file C:%ASAP 2020 Chemi Plus'dz
11/29/2014 11:38:28 PM analysis on file Cc:hAsAap 2020 Chemi Plus'.da
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H FLOWMETER CONVERSION FACTORS FOR CHEMICAL
ADSORPTION

The gas flowmeter on the front panel displays the gas flow rate for air in standard cubic centimeters
per minute (sccm). To obtain the actual flow rate for gases other than air, divide the displayed gas
flow rate by a conversion factor from the following table:

Example 1:

Oxygen is flowing through the meter at a displayed rate of 30 sccm (air). The actual flow rate is:
30 +1.05=28.6 sccm

Example 2:

You require a helium flow rate of 40 sccm. In this case, multiply the required flow rate by the
conversion factor: 40 x 0.37 = 14.8 sccm (air).

Adjust the gas flow until the gas flowmeter displays 14.8 sccm.

Flowmeter Conversion Factors

Gas Factor
Air 1.00
Argon 1.18
Butane 1.42
Carbon dioxide 1.23
Carbon monoxide 0.98
Cyclopropane 1.21
Ethane 1.02
Helium 0.37
Hydrogen 0.26
Isobutane 1.42
Methane (natural gas) 0.75
Neon 0.83
Nitrogen 0.98
Nitrous oxide 1.23
Oxygen 1.05
Propane 1.23
Sulfur hexafluoride 2.25
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Ei micromeritics“ | Advanced Reports - Python Module

| ADVANCED REPORTS - PYTHON MODULE

|:§{r_._ See also:
;‘E’ )

T ‘fcﬂj MicModule Python Calls on page | - 17

« Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with the mic.summary call.

» Tabular reports. Consist of one or more tables each containing one or more labeled columns of
data. Tabular reports are created with the mic.table call.

» Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with the mic.graph call.

Calls for accessing the sample file data can be found in the Mic Module Python Calls section of this
appendix. More advanced example python scripts are included in the analyzer software. Application
specific discussions can be found on http://www.micro-report.com

/ The examples in this topic are also included as a part of the Micromeritics installation pro-
cess and are located in the Scripts sub-directory.

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports a
"mic" Python module must be created. See MicModule Python Calls on page | - 17 for an
example of Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.

2. Open a sample file with a Complete status.

3. Select Advanced in the drop-down list at the bottom of the window to return to the tabbed
view.

4. Onthe Report Optionstab, select Advanced Rpt. (or User-Defined) in the Selected Reports
list box, then click Edit.

5. Onthe Advanced Report Options window, click Add in the Available Scripts group box to loc-
ate and select the Python script. Repeat for each script to be added.
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ol =

Select Reports

1 [overiays | [Pressures... | [¥] Overtay samples

[reports =] [Pressues... | [7]Overlay samples

[summery-table-graph ] [Pressures... | 7] Overlay sampies

2z
3

Overlay samples

Available Scripts

overiays

i
summary-table-graph

6. Inthe Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Onthe Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.

Advanced Reports

Field or Button Description

Add [button] Click to add additional Python reports.

Advanced Report 1 Use the drop-down lists to select currently-defined functions used to
through 5 define the report calculations and output.

[drop-down box]

Available Scripts Lists the available reports and provides the option to add, replace, edit,
[group box] or remove reports.

Overlay samples (if Use to overlay samples as defined by the function.

shown) [check box]

/ For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.
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SCRIPTS

Run a Script

ok wd -~

7.
8.

Open a sample file with a Complete file status.

Select Advanced in the drop-down list at the bottom of the window.

Select the Report Options tab.

Highlight Advanced in the Reports list box, then click Edit.

On the Advanced Report Options window, click Add. Locate and select one or more python
scripts then click Select. The selected scripts become a part of the drop-down list in the Avail-
able Scripts section of the Advanced Report Options window.

In the Selected Reports section, select up to five Advanced reports in the drop-down lists. Use
the Pressures button to include or exclude available pressures in the report.

Click OK.

Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the scriptin the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.
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Edit a Script

side of the application, the script file will have to be re-added to the Advanced Report

/ When a script is added, the code is stored within the application. If the script changes out-

Options window for the changes to take affect.

Field or Button

Description

Add [button] Adds one or more scripts to the Available Scripts box. The added
scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the

original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button]

Select to include or exclude pressures from the report.

« Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

« Cancel. Discards any changes or cancels the current process.

« Exclude All. Select to exclude all pressure points in the table.

« Include All. Select to include all pressure points in the table.

« OK. Saves and closes the active window.

Remove [button]

Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button]

Replaces the contents of the selected script however, the script name
remains the same.
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PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

import mic
import numpy as np

mic.graph( 'My Graph', 'x', 'f(x)' )

myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 1)
mic.graph.add( 'x"2', myx, myx*myx, marker='o' )
mic.graph.add( 'sin(x)', myx, np.sin(myx), marker='""' )

The results are:

User 1: My Graph
—— x'2 —&— sinx)
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Summary Report

This script produces a summary report with two summaries:

import mic
mic.summary ( "My Summaries" )

mic.summary.add( "Summary A",
["label 1:", "label 2:", "label 3:"],
["vall", "val2", "val3"] )

mic.summary.add( "Summary B",
["label 4:", "label 5:", "label 6:"],
["Val4", "Val5", "Val6"] )

The resultis:

summary A
label 1: vall
label 2: val2
label 3: val3

Summary B
label 4: val4
label 5: vals
|abel 6: valb
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Python Reports

Tabular Report

If more than one column is required, the call mic.table is employed. This script produces a tabular
report consisting of two tables. NOTE: This script uses the Python package "numpy" and c-style

formatting of the numerical values.

import mic
import numpy as np

mic.table ("My Tables")

mic.table.addtable( "My set A" )

mic.table.addcolumn( "x", ["1.0", "2
mic.table.addcolumn( "y", ["0.5", "1
x1l = 0.2
x2 = 0.5
x3 = 3.14159/2
mic.table.addtable( "My set B" )
mic.table.addcolumn( "x", ["%8.3f" %
"$8.3f" %
"$8.3f" %
mic.table.addcolumn( "sin(x)", ["%8.
ll%8
"%8
mic.table.addcolumn( "cos(x)", ["%8
H%8

The result is:
My set A
X ¥
1.0 0.5
2.0 1.0
30 1.5
My set B
X sin(x) cos(x)
0.200 0.199 0.980
0.500 0.479 0.878
1.5871 1.000 0.000

.O",
.O",

<1,
K2 p
%3

3f"

Ch
3"

3"
Ch
o JIEX

o® o° o°

o° o oe

113.0111 )
"1.5"] )

np.
np.
np.

np

np

sin(x1),
sin(x2)
sin(x3)

.cos (x1),
np.
.cos (x3)

cos (x2)

o~
~
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ACQUIRE BASIC INFORMATION

Physisorption

To acquire the adsorption isotherm and other basic information about the sample being edited, the
calls mic.isotherm, mic.sample_information, and mic.adsorptive data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

import mic

prel, gads, n_ads, ambient fs, analysis fs, mass, desc = mic.isotherm('rel')
mic.graph( 'Graphical Report 1', 'Rel. Press', 'Quantity Adsorbed' )
mic.graph.add( 'Sample isotherm', prel, gads )

pabs, gads, n_ads, ambient fs, analysis fs, mass, desc = mic.isotherm('abs')

mic.graph( 'Graphical Report 2' 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add ('Sample Isotherm', pabs, gads)

mass = mic.sample information ('sample mass' )
Tanl
dens = mic.sample information('sample density"')

mic.sample information('analysis temperature' )

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",
[ "Number of adsorption points:",
"Ambient Free space:",
"AnalysisFree space:" ,
"Sample mass (g):",
"

"Description:",
"Analysis Temp:",

"Sample Density (g/cm”3):" 1,

[ "$8.3f" % n_ads,

"%$8.3f" % ambient fs,

"%8.3f" % analysis fs,

"$8.3f" % mass,

desc,

"%$8.3f" % Tanl,

"$8.3f" % dens ] )

csa, hsd, dcf, mol weight, analysis gas = mic.adsorptive data ()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",
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"Hard Sphere Diameter",
"Density Conversion Factor",
"Molecular Weight",
"Analysis gas"],

[ "$8.3f" % csa,
"$8.3f" % hsd,
"$8.3f" % dcf,
"%8.3f" % mol weight,

analysis gas ] )

Note the calls to mic.isotherm and mic.adsorptive _data above are each returning results as a list with
elements of varying return type.

Chemisorption

This script produces a graph of the primary, repeat, and difference isotherms, and prints summaries
of the sample information and the adsorptive properties.

To acquire the adsorption isotherm and other basic information about the sample being edited, the
calls mic_chem.isotherm, mic.sample_information, and mic.adsorptive _data are applied.

Note the calls to mic_chem.isotherm and mic.adsorptive data above are each returning results as a
list with elements of varying return type.

import mic

p_primary, g_primary = mic.chem isotherm('primary"')

p_repeat, g_repeat = mic.chem isotherm('repeat')

p _difference, g difference = mic.chem isotherm('difference')
mic.graph( 'Graphical Report 1', 'Abs. Press', 'Quantity Adsorbed')
mic.graph.add('Primary', p primary , d_primary)
mic.graph.add('Repeat', p repeat , g_repeat)
mic.graph.add('Difference', p difference, g difference)

mic.summary( "Sample Information" )
mic.summary.add( "Sample Information:",
[ "Ambient Free space (cm”3):",
"Analysis Free space (cm"3):" ,
"Sample mass (g):",

"Description:",
"Analysis Temp (K):",
"Sample Density (g/cm”3):" 1],

[ "$8.3f" % mic.sample information ('ambient freespace'),
"%$8.3f" % mic.sample information('analysis freespace'),
"%$8.3f" % mic.sample information('sample mass'),

mic.sample information('sample description'),
"%$8.3f" % mic.sample information('analysis temperature'),
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"%8.3f" % mic.sample information('sample density') ] )
csa, hsd, dcf, mol weight, analysis gas = mic.adsorptive data ()

mic.summary.add( "Adsorptive Data",
[ "Cross Sectional Area",
"Hard Sphere Diameter",
"Density Conversion Factor",
"Molecular Weight",
"Analysis gas"],

[ "%8.3f" % csa,
"$8.3f" % hsd,
"$8.3f" % dcf,
"%$8.3f" % mol weight,

analysis gas ] )

1-10 MicroActive ASAP 2020 Operator Manual
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ACQUIRE REPORT RESULTS

Sampile file report results may be accessed using the mic.report call. This script prints a summary of
the results of the t-plot and BET reports.

import mic

sa = mic.report ("bet", "surface area")

© = mic.report ("bet", "bet constant")

vm = mic.report ("bet", "monolayer capacity")

esa = mic.report("tplot", "external surface area")
vol = mic.report("tplot", "micropore volume")

mic.summary ( "BET and T-plot Results" )

mic.summary.add( "Report Results",
[ "bet surface area",
"bet constant",
"bety 6"
"tplot external surface area",
"tplot micropore volume"],

[ "$10.5f" % sa,
"$10.5f" % c,
"$10.5f" % vm,
"$10.5f" % esa,
"%$10.5f" % vol ] )

The result is:

Report Results
bet surface area 796.36286
bet constant 137786.85871
bet monolayer capacity 182.96348
tplot external surface area 416.38843
tplot micropore volume 017931

Acquiring the results from a pore-distribution report such as the BJH method is done in a similar way
as in the previous script except the return values from the mic.report call are slightly different since
they involve lists of data. For example,

import mic

xdat, ydat, desc = mic.report('bjhads' ,'incremental distribution' )
mic.graph( 'BJH Ads/Des', 'Pore diameter', 'Incremental Volume' )
mic.graph.add( desc, xdat, ydat )
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202-42804-01 (Rev-) — Feb 2019



| Advanced Reports - Python Module

[M] micromeritics®

The resultis:

—+— BJH Adsorption Reports

User 1: BJH AdsiDes

=)
=
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Incremental ¥olume

=N

[N N

—
0 400 5
Pore diameter

See the Mic Module Python Calls section for a more complete description of the usage and scope of

the mic.report call.
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ACQUIRE OVERLAY SAMPLE DATA

Physisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file using mic.report and
mic.adsorptive_data have a very similar interface as the mic.overlay call, and a summary of their
usage is shown in the example in this topic.

import mic

p, 9, n, fsw, fsc, mass, desc = mic.isotherm('rel')
pl, gl, nl, fswl, fscl, massl, descl = mic.overlay( 1, 'rel')
2, 92, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')

mic.graph( 'Three Sample Isotherms',
'Rel. Press',
'Quantity Adsorbed (cm”3/g)' )

mic.graph.add( 'Primary Isotherm ', p, g )
mic.graph.add( 'Overlay Isotherm 1', pl, gl )
mic.graph.add( 'Overlay Isotherm 2', p2, g2 )

mic.summary( "A summary report" )

mic.summary.add( "Two samples",
[ "Primary Sample:",
"Overlay Sample 1:",
"Overlay Sample 2:" ],
[ desc,
descl,
desc2] )
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The results are:

User 1: Three Sample Isotherms
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Rel. Press

Two samples
Primary Sample: 12 mm Tube N2 Silica-Alumina ADS-DES with FS
Overlay Sample 1. Activated Carbon Hexane Dosed from Port 3 - 2
Overlay Sample 2. Activated Carbon Tube C4 Butane Port 3

To enable the use of overlay data in the Advanced reports, the following two actions must be taken
prior to running the script:

« Sample files to overlay must be selected, and
« The Overlay samples checkbox on the Advanced Report Options window must be selected

MicroActive ASAP 2020 Operator Manual
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Acquire Overlay Sample Data

Chemisorption

The call to obtain overlay sample data is similar to the calls for the primary sample. This script

involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file using mic.report and
mic.adsorptive_data have a very similar interface as the mic.chem.overlay call, and a summary of
their usage is shown in the example in this topic.

import mic

pO,

pOr,

pl,

plr,

P2,

g0

glr =
ql =
qglr
gz =

p2r, g2r

mic.
mic.

mic

mic.
mic.

mic

mic.

mic.

graph (
graph.
.graph. (
graph. (
.add('rep 1',plr, glr)
(
(

graph

.graph.

mic.graph.

= mic.chem isotherm('primary"')
mic.chem isotherm('repeat')

mic.chem overlay(l, 'primary"')

mic.chem overlay(l, 'repeat')

mic.chem overlay (2, 'primary"')

mic.chem overlay (2, 'repeat')

'Graphical Report 1', 'Abs. Press',

add ('prim 0',p0,90)
add('rep 0',p0r, gOr)
add('prim 1',pl,gl)

add ('prim 2',p2,92)

add('rep 2',p2r, g2r)

summary ( "A summary report" )

summary.add( "Sample and Two Overlays",

[ "Primary Sample:",
"Overlay Sample 1:",
"Overlay Sample 2:" ],

'Quantity Adsorbed')

[ mic.sample information ('sample description'),

mic.sample information('sample description',1),

mic.sample information('sample description', 2) 1)
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ENABLE THE USE OF OVERLAY DATA

1. Onthe Report Optionstab, click Overlays.

2. Onthe Plot Overlay Sample Selection window, to move a file from the Available Files list box
to the Selected Files list box, either double click a file name in the Available Files list box or
click one or more files in the Available Files list box then click Add.

—_— ==

[E]

(use cirlarrow to move the
Sekcted Fies: selected fie up/donn)

3. Click OK.

4. Onthe Report Options tab, highlight Advanced in the Selected Reports list box.
5. Click Edit to the left of the Selected Reports list box.

6. Selectthe Overlay samples checkbox to the right of the selected report.

7. Click OK.

8. Run the script using the instructions found in Scripts on page I - 3.
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MicMoDULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

o Create a new tabular report
« Add acolumn
o Addatable

Add a Table

This script adds a table to the last created tabular report:

mic.table.addtable ( name )
Keyword arguments:

name --- the table name

Add a Column

This script adds a column to the last created table:

mic.table.addcolumn ( header, values )
Keyword arguments:

header --- column header; must be a string (or convertible)
values --- column values; must be a list of strings (or convertible)

Create a New Tabular Report

mic.table( title='User Table' )

Keyword arguments:

title --- the tabular report title (default = 'User Table')
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SUMMARY REPORTS

\[r~. See also:

_;7.'=_r_::'<‘5*f' Python Reports on page |l - 5

Add a Summary Section

This script adds a summary section to the last created summary report:

mic.summary.add( name, labels, values )

Keyword arguments:

name --—- summary section name

labels --- column of labels; must be a list of strings
(or convertible) and the same length as values

values --- column of values; must be a list of strings

(or convertible) and the same length as labels

Create a New Summary Report

mic.summary( title='User Summary' )
Keyword arguments:

title --- the summary title

MicroActive ASAP 2020 Operator Manual
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GRAPHIC REPORTS

\[r~. See also:

__rg Python Reports on page |l - 5

Add a Curve

This script adds a curve to the last created graphical report:

mic.graph.add( name, x, y, yyaxis=False, color=None, linestyle='-', mark-
er='a', graphtype='both' )

Keyword arguments:

name —-—-— the curve name
X --- list of x values; must be a list of floats
(or convertible) and the same length as y
% --- list of y values; must be a list of floats
(or convertible) and the same length as x
yyaxis --- place this curve on the yy-axis if True
otherwise place on the vy-axis (default = False)
color --— RGB color as an HTML hex string (e.g., '#4169el")

or a three-element list or tuple (e.g., [65,105,225]);
if None, color is automatically selected (default = None)

linestyle --- line style; (default = '-")
V=0 : solid
VoV : dash
v : dot
V=g U : dash dot
sy oV : dash dot dot
marker --— marker shape; (default = 'a')
U0 : plus
'o' or '0' : circle
'x! : Cross

up triangle

v down triangle

's! : square

'd’ : diamond

'8! : hourglass

Ve U : horizontal hourglass

'' or None : no marker

'a' : automatically selected
graphtype --- graph type; (default = 'both')

'curve' or 'c' : curve

MicroActive ASAP 2020 Operator Manual
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'points' or 'p' : points
'both’ or 'b' : curve-and-points
'hist' or 'h' : histogram

Add a Curve Using the Second Y-AXxis

This script adds a curve to the last created graphical report using the second y-axis:
mic.graph.addyy( name, xx, Vyy )
Add a curve to the last created graphical report using the second

y-axis. The arguments to this call are the same as to mic.graph.add
with the argument

Create a New Graphical Report

mic.graph( title='User Graph', xlabel='X axis', ylabel='Y axis', yylabel='YY
axis', xlinear=True, ylinear=True, yylinear=True )

Keyword arguments:

title -—-- the graphical report title (default = 'User Graph')

xlabel --- x-axis label (default = 'X axis')

ylabel --- y-axis label (default = 'Y axis')

yylabel --- yy-axis label (default = 'YY axis')

xlinear --- x-axis linear scale; if false, use log scale
(default = True)

ylinear --- y-axis linear scale; if false, use log scale
(default = True)

yylinear --- yy-axis linear scale; if false, use log scale

(default = True)
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GET PRIMARY ISOTHERM DATA
mic.overlay( overlay number = 1, press type='rel' )

Keyword arguments:

overlay number --- the overlay number (1 through 8; default = 1)
press_type -—-— the pressure basis; use 'rel' for relative pressure,
'abs' for absolute (default = 'rel')
Usage:

p, gads, num ads, ambient fs, analysis fs, mass, desc = mic.overlay(1l,
'rel')

js) --- array of pressure (relative or absolute);
empty-array if overlay is unavailable

gads --- array of cumulative quantity adsorbed;
empty-array if overlay is unavailable

num_ads -—— number of points in the adsorption curve;

0 if overlay is unavailable
ambient fs --- ambient free-space; 0.0 if overlay is unavailable
analysis fs —--- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if

overlay is unavailable

Chemisorption

mic.chem isotherm( branch='primary' )
Get primary, repeat and difference isotherm data.

Keyword arguments:
branch --- Specifies which analysis to get isotherm data;
use 'primary' for the first analysis,
'repeat' for the repeat analysis
and 'difference' for the difference of these two

Usage:
P, 9 = mic.chem isotherm('primary')
P, g = mic.chem isotherm('repeat')
P, 9 = mic.chem isotherm('difference')
p --— array of absolute pressures
q --- array of cumulative quantity adsorbed
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GET OVERLAY ISOTHERM DATA

Physisorption

mic.overlay( overlay number = 1, press type='rel' )

Keyword arguments:

overlay number --- the overlay number (1 through 8; default = 1)
press_type -—-- the pressure basis; use 'rel' for relative pressure,
'abs' for absolute (default = 'rel')
Usage:

p, gads, num ads, ambient fs, analysis fs, mass, desc = mic.overlay(l,

'rel')
o) --- array of pressure (relative or absolute);
empty-array if overlay is unavailable
gads -—-— array of cumulative quantity adsorbed;
empty-array if overlay is unavailable
num_ads -—— number of points in the adsorption curve;
0 if overlay is unavailable
ambient fs --- ambient free-space; 0.0 if overlay is unavailable
analysis fs —--- analysis free-space; 0.0 if overlay is unavailable
mass --- sample mass; 0.0 if overlay is unavailable
desc --- sample description; empty-string if
overlay 1is unavailable
Chemisorption
mic chem overlay( overlay number = 1, branch='primary' )

Get overlay isotherm data.
Keyword arguments:
overlay number --- the overlay number (1 through 8; default = 1)
branch --- Specifies which analysis to get isotherm data;
use 'primary' for the first analysis,
'repeat' for the repeat analysis

and 'difference' for the difference of these two

Usage:
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Get Overlay Isotherm Data

P, 9 = mic.chem overlay(l, 'primary')

P, g = mic.chem overlay(l, 'repeat')

P, g = mic.chem overlay(l, 'difference')

js) -—-— array of absolute pressures

q --- array of cumulative quantity adsorbed
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GET ADSORPTIVE DATA FOR EACH SAMPLE

mic.adsorptive data( sample number = 0 )

Keyword arguments:

sample number --- Identifier for the adsorptive data to retrieve
0 : the current sample file
1 through 8 : the corresponding overlay sample file
Usage:
csa, hsd, dcf, mol weight, analysis gas = mic.adsorptive data ()
csa, hsd, dcf, mol weight, analysis gas = mic.adsorptive data (0)
csa —-—— cross sectional area (nm"2)
hsd -—-- hard sphere diameter (angstroms)
dcf --- density conversion factor (dimensionless)
mol weight --— molecular weight
analysis gas --- mnemonic for the analysis gas species

(e.g., 'CO', 'H2'")

GET SAMPLE INFORMATION ITEM

mic.sample information( item, sample number = 0 )

Keyword arguments:

item --—- string identifying the item to be returned.
Accepted identifiers are
'sample mass'
'sample description'
'analysis temperature' (degrees Kelvin)
'sample density' ( g/cm”3 )
sample number --- Sample to retrieve (default = 0).
0 : the current sample file
1 through 8 : the corresponding overlay sample file
Usage:
mass = sample information ('sample mass')
mass = sample information ('sample mass',0)
|04 MicroActive ASAP 2020 Operator Manual
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GET REPORT RESULTS FOR PHYSICAL ADSORPTION

This script gets report results for the indicted report and sample:

mic.report ( report name, result, sample number = 0 )

Keyword arguments:
sample number --- Identifier for the sample data to retrieve
0 : the current sample file

1 through 8 the corresponding overlay sample file

Usage:
sa = mic.report( 'bet' 'surface area' )
porewidth, incvol, desc = mic.report( 'bjhads' ,

'incremental distribution' )

The available report keywords, result keywords and a corresponding
description of the result is listed in the table below:

Report keyword Result keyword Description

bet surface area Surface area ( m"2/g )

bet bet constant BET constant ( dimensionless )
bet monolayer capacity Monolayer capacity ( cm”3/g )
tplot external surface area External surface area (m"2/9g)
tplot micropore volume Micropore volume (cm"3/g)
bjhads incremental distribution Incremental Distribution
bjhdes incremental distribution Incremental Distribution
dhads incremental distribution Incremental Distribution
hk incremental distribution Incremental Distribution

dft incremental distribution Incremental Distribution
nldft incremental distribution Incremental Distribution

where the incremental pore distribution result above (£

reports which return this)

or those

is a list with three components being,

porewidth --- array of pore dimension boundaries (angstroms) ;
empty-array i1f unavailable.

incvol --- array of incremental pore volumes (cm”~3/g);
empty-array if unavailable.

desc --—- Name of data set; empty-string if unavailable.
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GET IMPORTED PORE DATA
mic.imported pore data( import number = 1 )
Keyword arguments:
import number --- the import number (1 through 8)
Usage:
xdat, ydat, desc = mic.imported pore data(l)
xdat --- array of pore dimension boundaries (angstroms) ;
empty-array 1f unavailable.
ydat --- array of incremental pore volumes (cm™~3/g);

empty-array i1f unavailable.
desc --- Name of data set; empty-string if unavailable.
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GET METAL COMPOSITION FOR CHEMICAL ADSORPTION
mic metal composition( metal='' , metal property='"' , sample number
Get information about the active metals in this sample
Keyword arguments:
metal --- the metal to return information about

if '' or None, then return a list of the
active metals

metal property --- the specific property to return information on
if '' or None, then return all the properties
for the specified metal (requires metal to be
specified)
sample number --- Identifier for the metal data to retrieve
0 : current sample file (default)
1 through 8 : corresponding overlay sample file
Usage:
metal list = mic.metal composition ()
copper prop = mic.metal composition( 'copper')
copper perc = mic.metal composition( 'copper',

'percent of sample mass' )

In the above first usage case, the list of active metals is returned.

In the above second usage case, a python dictionary type

is returned which includes all the properties of the metal
available and their corresponding values. The last case returns
a single value (int, float, or string) for the specified property.

The metal property keywords which one can use are

atomic weight

oxygen atoms

density

percent of sample mass
metal atoms

cross sectional area
percent reduced
stoichiometry H2
stoichiometry 02
stoichiometry He
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Or as just mentioned, one can make the call
metal composition( metalname ) without any metal property
keyword provided to see the whole dictionary.
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J VAPOR ADSORPTION OPTION

The Vapor Adsorption Option uses vapors as the adsorbent when the sample is near or above room
temperature. The analysis system is heated to approximately 45 °C and the vapor source to
approximately 40 °C, which allows analyses at up to 35 °C.

The Vapor Adsorption option consists of a vapor enclosure, heated manifold cover, temperature
controller, and vapor source tube.

Water Vapor Controller Temperature Controller

VAPOR ENCLOSURE

The vapor enclosure houses the vapor tube. Its temperature is regulated by the temperature
controller. The door to the vapor enclosure should remain closed while the instrument is in operation.
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TEMPERATURE CONTROLLER

The front panel of the temperature controller has a display for the vapor source and a separate
display for the manifold.

Measured
C1O C2OALT OALZOALBO temperature

DD I s
UQ Uoﬁa Uoﬁg UOUQ UO teﬂoerature
0 i i O
HQUO QUO HQUO UQUO temperature

/

Upon installation, the temperature of the vapor source is set at 40 °C (for analysis temperatures up to
35 °C). The analysis manifold is set between 55 and 60 °C to achieve a 45 - 47 °C manifold
temperature (displayed on the instrument schematic).

Use the Up and Down arrow keys to adjust the temperature.

ANALYSIS MANIFOLD

and calibrated to 45 °C and is suitable for any type of analysis. If the manifold
temperature is changed, recalibration by a Micromeritics Service Representative is
required.

/ Do not adjust the temperature of the manifold. The manifold temperature has been set

The manifold temperature displayed on the schematic will differ from the temperature displayed on
the temperature controller. A difference of 10 °C to 15 °C is typical. The schematic reading reflects
the true manifold temperature and is the one used in calculations.

VAPOR SOURCE

For analysis temperatures up to 35 °C, the recommended temperature for the vapor source is 40 °C.
For analysis temperatures over 35 °C, use the Up and Down buttons to adjust the temperature of
the vapor source to a value that is midway between the manifold temperature and the analysis
temperature. For example, to perform analyses at 40 °C and the manifold temperature displayed on
the instrument schematic is 45 °C, adjust the vapor enclosure temperature to 42.5 °C.
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VAPOR TUBE

The vapor tube contains the vapor source and is installed inside the vapor enclosure.

VAPOR ANALYSIS

When running vapor analyses, it is important to:

« Remove the cold trap dewar to prevent vapor from freezing in the cold trap.

« Thoroughly degas the vapor source. See Degas the Vapor Source Tube on page J - 10.

« Use the metal jacket on the sample tube when performing analyses at temperatures above ambi-
ent; see Use a Metal Jacket on the Sample Tube on page J - 6.

« Close the door on the vapor enclosure.

SPECIFY ANALYSIS PARAMETERS

Create standalone parameter files for analysis conditions and adsorptive properties for the materials
typically analyzed.

The values used in the following example are for silica-alumina reference material having a relatively
large pore volume and analyzed at 25 °C with water vapor derived from a 35 °C source.

Analysis Conditions

Create an analysis conditions parameter file using the parameters in the following table:

Button Enter or select

Insert Range 1. Enter the values:

« Starting relative pressure. 0.01
« Ending relative pressure. 0.9
o Number of points. 50

2. Click OK.
3. ClickInsert Range again. Enter the values:

« Starting relative pressure. 0.99
« Ending relative pressure. 0.45
o Number of points. 6

4. Inthe pressure table, scroll to point number 51.
a. ClickInsert toinsert a new row.
b. Enter0.95
The table should now display 57 points.
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Button

Enter or select

Preparation

« Unrestricted evac. from. 10.0 mmHg
« Vacuum setpoint. 10 mmHg
« Evacuation time. 0.50 hours

Free Space

« Evacuation time. 0.50 hours
« Outgas test duration. Select checkbox and enter 180 seconds.

Ppand T

« Select Calculate P, from the analysis temperature.

« Select Enter the analysis temperature then enter an analysis tem-
perature of 25.0 °C.

Dosing

« Absolute pressure tolerance. 2.000 mmHg
« Relative pressure tolerance. 5.0 %

Equilibration

« Minimum equilibration delay. 600 s

Backfill

« Disable both backfill options.

« When the Backfill option is disabled at the start of an
analysis, the sample must be evacuated before ana-
lysis.

o When Backfill sample is deselected, a message dis-
plays indicating that disabling this option may damage
the instrument. When dosing water vapor, there is no
risk of generating high pressures; therefore, it is safe to
deselect this option. Click Yes, then OK to close the
window.
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Adsorptive Properties

1. Create an adsorptive properties file.

If the adsorption test is solely for the purpose of discovering how water is taken up by the
sample, the Density conversion factor, Therm. tran. hard-sphere diameter, and Molecular
cross-sectional area values are of little consequence. All that is needed is the adsorption
isotherm and, perhaps, the desorption isotherm.

a. Non-ideality factor derived as

o)
Z\ PosTanalysis
NIF = ==
0
where
Z = compressibility factor at the saturation pressure of the vapor
T = analysis temperature
b. Density conversion factor derived as:
Vin
DCF = 22414 em 3 /mol
where
V., = molarvolume of the liquid at the analysis temperature

c. Thermal Transpiration hard-sphere diameter. Enters into calculations when high pre-
cision requires that low-pressure measurements take into account small differences in
temperature along gas passageways. The subject is thoroughly treated in Ross Sidney
and Olivier, James P., On Physical Adsorption, Interscience Publishers, NY, 1964.

d. Molecular cross-sectional area. Required when, from the isotherm, the surface area of
the sample material is to be calculated. The technical literature, beginning with the extens-
ive tabulation of McClellan and Harmsberger [“Cross-sectional Areas of Molecules
Adsorbed on Solid Surfaces,” J. Coll. and Interface Sci. 23, 577-99 (1967)], is replete with
adsorbed cross-sectional areas on various substrates at different temperatures. In the
case of silica-alumina and water, these values range from 0.108 t0 0.198 nm?2. A value of
0.125 nm? gives BET surface area results that agree well with nitrogen analyses.

2. Click Psat vs T; enter:

Row Saturation Pressure (mmHg) | Temperature °C
4.584 0.0000
9.209 10.000

3 23.776 25.000
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USE A METAL JACKET ON THE SAMPLE TUBE

A two-piece metal jacket is included in the accessories kit to use when performing analyses at
temperatures above ambient. The jacket helps to maintain strictly decreasing temperatures from the
instrument to the sample in order to prevent condensation in the portion of the tube above the
sample. The sample may be degassed with the jacket in place. Install the jacket on the tube before

attaching the sample tube to the sample port.

1. Wear latex gloves and place a retaining O-ring onto the sample tube. Slide the O-ring toward
the bulb.

/ The O-rings for the metal jacket are larger than the ones for the sample port. Do not
attempt to use sample port O-rings for retaining the jacket, or vice versa.

2. Position both sides of the metal jacket on the sample tube and slide the O-ring into the lower

groove of the jacket.
3. Slide the other O-ring onto the top of the sample tube and into the upper groove of the jacket.
The top of the jacket should be approximately 3 cm (1 in.) from the top of the tube to allow for

installation in the sample port

4. Attach the sample tube to the sample port.
5. Gently slide the jacket upwards until it touches the sample tube connector nut.
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PERFORM AN ANALYSIS AT ICE WATER TEMPERATURE

1. Create a sample file using the analysis conditions and adsorptive properties for water. To
replace parameters from the Analysis Conditions parameter file created previously in this doc-
ument, use the Replace All button on the Sample Description tab.

Degas the sample to its required conditions.

Prepare the ice-slush bath and place on the elevator.

Transfer the sample tube from the degas port to the analysis port.
Manually evacuate the sample using the instrument schematic.

ok wN

‘ N2 | | Ar co2 | | Kr

[
g o or or or or

PV He PS
Vacuum 2 % 3 a 5
1

25.58 °C

760.00 mmHg

759.10 mmHg

7.6000 mmHg

0.076000 mmHg

Ensure all valves are closed.
Open valves N2 and PS.
Open valves 5 and 7. When 760 mmHg is achieved, close valves 5 and N2.
Open valve PV. Wait approximately 10 seconds, then close valves PV and PS.
Open valves 9 and 2.
At 10 mmHg, open valve 1 and close valve 7.
g. At 10 mmHg, evacuate for 30 minutes.
6. Raise the elevator.
7. Startthe analysis.

a.
b.
C.
d.
e.

f.
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Example of an isothermal linear plot using the analysis conditions parameter file created in this

document:

Isotherm for

water vapor
adsorption on Silica
Alumina reference
material

Analysis Bath Temp.: 25.000 °C

Thermal Correction: No

Warm Free Space: 27.7650 cm* Measured
rval: 20's

Equiliration Interval:
Automatic Degas: No
Comments: Need to measure free space after analysis.
Summary Report
rface Area

Single point surface area at P/Po = 0.293563272; 238.2254 mlg
BET Surface Area: 261.7239 milg
Pore Volume

Single point adsorption total pore volume of pores
less than 35.270 A width at P/Po = 0.960551270: 0585699 crrlg

Pore Size
Adsorption average pore width (4V/A by BET): 89.5140 A

prr—
o
/
/
g /‘
'y f:
= )i |
: I
z /
g y
g v
o
P
bt
PR
e s
[ micromeritics®
2020 Unit 2 Serial #: 944 Page
‘Sample: Silica Alumina with H20 Vapor 944
Operat
it
Fil
Started: Analysis Adsorptive: VW

Summary Report
for water vapor
adsorption on
Silica Alumina
reference material

J-8
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VAPOR SOURCE MAINTENANCE

It is very important to use high-purity, certified liquids as vapor sources. When using water, a
common vapor source, ensure it is distilled or deionized. Use extra care to ensure proper degassing.

The level of the liquid in the vapor tube should be at 25 to 50% of the tube, approximately 3 to 5 mL. If
the level falls below 25%, add more vapor liquid and degas thoroughly.

CLEAN THE VAPOR SOURCE TUBE

A clean vapor source tube is as important as high-purity vapor sources. Clean the tube when
changing vapor sources or when the vapor source becomes discolored

1.
2.
3.

Preheat a drying oven to 110 °C.

Check the bowl of the ultrasonic cleaning unit to ensure it is clean.

Use five grams of Alconox® (or other suitable laboratory detergent) per 500 mL of warm water
and fill the reservoir of the ultrasonic unit with enough water to cover the vapor tube. Ensure
the detergent is dissolved prior to placing the vapor tube into the water. If too much detergent
is used, it may be difficult to rinse from the tube.

Fill the vapor tube with warm water and place it in the ultrasonic cleaning unit. Power on the
ultrasonic cleaning unit for approximately 15 minutes.

Remove the vapor tube from the reservoir.

Clean the interior of the tube with a sample tube brush.

Rinse the vapor tube with hot water, then with isopropyl alcohol. If isopropyl alcohol is not avail-
able, deionized water may be used to rinse the tube.

Stand the vapor tube on a sample tube rack and place the rack in the preheated drying oven
for two hours.

Remove the tube from the oven and allow to cool.

MicroActive ASAP 2020 Operator Manual
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DEGAS THE VAPOR SOURCE TUBE

Vapor source liquids must be degassed thoroughly to remove air (and other dissolved gases) to
achieve desirable results. It is very important to degas vapor liquids on a weekly basis to maintain
purity.

Degas vapor liquids:
« on aregular, weekly basis

« when adding fresh vapor liquid
« when changing vapor liquids

The vapor tube may be degassed by using the vacuum method or the freezing method. The vacuum
method is generally sufficient.

Vacuum Method

1. Ensure the cold trap dewar has been removed.

2. Display the instrument schematic and enable manual control. Ensure all valves are closed.
Valves 1 (vacuum), 7 (isolation), and 8 (vapor) will be used.

Do not open Valves 1 and 8 concurrently. Doing so may cause damage to the
instrument.

759.10 mmHg

25.58 °C 7
760.00 mmHg j B g
7.6000 mmHg Vapor
I | I

L

3. Open valves 1 and 7. Wait until the vacuum gauge reading is 10 mmHg (approximately 5 min).
4. Close valve 1 and open valve 8; wait approximately 2 min.
5. Close valve 8 and open valve 1; wait approximately 2 min.

MicroActive ASAP 2020 Operator Manual
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6. Repeat Steps (3) and (4) six times so that the vapor source will be degassed thoroughly (or
until the 1000 mmHg transducer reads between 40 and 45 mmHg for water at 35 °C in the
vapor enclosure).

a Saturation Pressure vs. Temperature table to determine the appropriate pressure for

/ The pressure in the manifold will vary if using a vapor other than water at 35 °C. Refer to
the vapor being used.

Freezing Method

The vacuum method is typically sufficient for degassing water. However, the freezing method may
be used when maximum purity is required.

/ It is very important to degas vapor source liquids on a weekly basis to maintain purity.

1. Place a dewar of LN2 on the instrument cold trap and another dewar of LN2 about the vapor
tube using the supplied dewar and stand.

2. Open valve 8 and evacuate until a vacuum of 10 mmHg is achieved.

3. After 30 minutes, remove the LN2 from the vapor tube and close valve 8.

4. When the water in the vapor tube warms nearly to ambient temperature, open valve 8 and
allow evacuation to proceed for 10 minutes.

5. Close valve 8.
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REPLACE FUSE IN TEMPERATURE CONTROLLER

A fuse block is located in the input power connector on the back of the temperature controller. A
single or double fuse arrangement can be used depending on the power source.

Power Source Fuse
100-120 VAC Use one 5 Amp, slow-blow
200-240 VAC Use two 3.15 Amp, 5 x 20 mm, slow blow

A The fuses used in the temperature controller must be identical in type and rating to those
specified. Use of other fuses could result in electrical shock and/or damage to the unit.

1. Power off the temperature controller and disconnect the power cord. The cover of the input
power connector cannot be opened when the power cord is installed.

2. Insert the tip of a small screwdriver into the top of the power module. Gently pry the cover
open.

Fuse cover

—

3. The cover is hinged and cannot be removed. Gently grasp the bottom of the cover and swing it
upward.

4. Hold the cover open and remove the fuse block. Needle-nose pliers may make removal
easier.

MicroActive ASAP 2020 Operator Manual
202-42804-01 (Rev-)— Feb 2019



Ei micromeritics“ Replace Fuse in Temperature Controller

5. Replace the blown fuse.
6. Re-insert the fuse block into the input power connector.

« Single fuse arrangement. Position the fuse block so that the single-fuse slot and the jumper
bar are away from the cover.

« Double fuse arrangement. Position the fuse block so that the double-fuse slots are away
from the cover.

7. Ifusing the single fuse arrangement, snap the fuse block into place, then close the cover. If
using the double fuse arrangement, the block will not snap into place. Position the fuse block in
the proper orientation to seat it properly.

8. Reconnect the power cord and power on the temperature controller. Allow at least four hours
for the manifold temperature to stabilize.

temperature is changed, recalibration by a Micromeritics Service Representative is

/ Do not adjust the manifold temperature to speed the process. If the manifold
required.
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K Worksheets

K WORKSHEETS

Worksheets in this section may be copied as needed.

» Input Gas Worksheet on page K - 4
o« Sample Data Worksheet for Gas Adsorption on the next page
o Valve Test Worksheet for ASAP 2020 on page K - 3
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SAMPLE DATA WORKSHEET FOR GAS ADSORPTION

Sample tube identification:

Sample Mass (g)
Before Degas | After Degas | After Analysis
Mass of empty sample tube set g
Mass of sample tube set plus sample g g
Mass of sample (step 2 minus step 1) g g

Degas Information

Degas apparatus

Temperature (°C)

Time (hours)

Actual time started

Actual time finished

Degas Notes:
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VALVE TEST WORKSHEET FOR ASAP 2020

Valve P1 P2 Outgassing
(1st Pressure (2nd Pressure Rate
Reading) Reading)

Analysis Valves

Manifold

Gas inlet
valves

3

P1

P2

P3

P4

P5

P6

PS

5

7

10 and 11

9

8

1,2, and PV
1,2, and PV
1

Degas Valves

Manifold
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INPUT GAS WORKSHEET

Port

Gas
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INDEX port assembly 17-3

A

about this manual iv
active metals 3-9
adsorptive properties 4 -2
advanced report options 8- 1
Alpha-S method report 8- 2
analysis
perform 6 - 1
prepare for 6-3
sequence 6-23
analysis conditions 4 -5
chemical adsorption tasks 4 - 714
analyzer
components 71-1,1-6
configure 2-15
show status 2-22
software 2- 1
atomic weights A - 1

B

BJH

plot options 8- 10

report options 8-6

tabular report options 8- 11
Broekhoff-de Boer

model F-15

C

calibrate

furnace resistance 10- 1

pressure zero 10-2
calibration 70-1

cryostat D-9

load fromfile 10-3

savetofile 10-3
chemical adsorption

methods

carbon monoxide analysis of
platinum C -1

tasks 4- 14
clean
analyzer exterior 12- 11
dewar 12-10
fillerrod 6-5
sample tubes 6-5
coldtrap 171-1
cleantube 712-12
components analyzer 1-1
configuration
unit 2- 15
contact us i
control chartreport 7-7
corporate profile i
cryostat
about D -1
calibration D-9
elevator D - 1
enable D -1
operating instructions D - 1
preventive maintenance D - 8
remove from analyzer D - 4
rotameter scale readings D - 3
sample tube, install D - 2
troubleshooting D - 5

D

data
manually enter 3-5
data chemisorption temperature ramp data E
-7
datalogging E -1
degas
conditions 4- 18
manual control 5-5
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show schematic 5-7
show status 5-6
start 5- 1
degassing 5- 1
sample transfer to analysis port, chemical
adsorption 5-4
sample transfer to analysis port, physical
adsorption 5-2
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dewar
check 12-10
clean 12-10
filland install 6- 19
precautions 6-1,6-1,6-19
DFT
model references F- 17
models based on classical theories F- 13
models based on statistical ther-
modynamics F - 1
models, all
Broekhoff-de Boer model F- 15, F-16
modelsincluded F- 14
pore size F-13
pore size report
options 8-12
regularization 8-13,8- 13
surface energy report options 8- 14
DFT Models F- 1
diagnostics 9- 1
save files for problem diagnosis 9- 5
schedule 9-3,9-3
show all readings 9-6
starttest 9- 1
testreport 9-4
Difference method 8- 51
report 8- 15
Dollimore-Heal
plot options 8- 21
report options 8- 18
tabular report 8- 22
Dubinin
pore volume report options 8- 25
report options 8- 23
tabular report options 8- 26
transformed isotherm plot options 8- 27

E

elevator, lubricate drive assembly 72- 13
equipment options and upgrades 71-8
evacuationrules 4- 17

evaluate reportresults 7- 11

export files 2-23

exported data example G- 1

F

f-Ratio method report 8- 28
fields and buttons, common 2-3
files
default locations 2-6
description 2-6
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extensions 2-6
list 2-23
open asamplefile 3-5
status 2-6
filler rod, clean 6-5
filter
port 12- 14
replace 12- 14
replace analysis 12- 14
replace degas 12- 17
replace exhaust 72- 15
flowmeter conversion factors H - 1
free space
calculating values for micropore
analyses B - 1
Freundlich report 8- 30
furnace
attach 771-4
calibrate resistance 10- 1
chemical adsorption port assembly 771-3
installation 717-3
fuses
vapor adsorption option, replace fuse, tem-
perature controller J- 12

G

gas
depleted cylinder 12-5
guidelines for connecting 712- 3
ports, specify 2- 15
replacement cylinder 12-4,12-6
requirements 7-9
set flow rates 12-7

graph
features and shortcuts 7 - 20
generate overlays 7 - 26
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H

Halsey, thickness curve F- 14
hardware installation 77 -1
Harkins and Jura, thickness curve F- 15
heat of adsorption report 7-2
heating mantle installation 717-5
Horvath-Kawazoe

plot options 8- 36

report options 8- 33

tabular report options 8- 36

input gas worksheet K -4
install
furnace 171-3
heatingmantle 17-5
Mass Spectrometer 171-6
sample tube, physical adsorption 6- 16
instrument status 2- 18
interactive reports 7- 10
isotherm report option 8- 37

K

kernel function F-14,F-15

L

Langmuir

report option 8- 39
libraries 2-12
list files 2-23

log
show instrument 2- 18

maintenance 712 -1
clean analyzer exterior 12-11
coldtrap 712-12

guidelines for connecting gases 72-3

preventive 12-9
replace analysis port filter 12- 14
replace degas portfilter 12-17
replace exhaust portfilter 72- 15
replace portfilters 12- 14
replacement cylinder 72-4
specify gas ports 2- 15
vacuum pump 12-8
manual control
degas ports 5-5
enable 72-13
manual, about this iv
mass spectrometer
install 17-6
menu structure 2 -2
methods, about 2- 13
MicroActive reports 7- 11
MP-Method
plot report options 8- 44
report options 8- 42
tabular report options 8-45

N

NLDFT advanced PSD report 8- 46

O

operating instructions, cryostat D - 1
option presentation 2- 10
options report 8- 50
overlays
generate 7-26
multiple graph 7 - 26
sample file 7-29

P

parameter files
about 4 -1
adsorptive properties 4 -2
analysis conditions 4 -5
degas conditions 4 - 18
file name extensions 4 - 1
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report options 4 - 20, 4- 20 R
sample tube 4-23

perform an analysis
vapor adsorption option, ice water tem- references, DFT models F - 17

perature J-7 regression report 7-5

plot options report examples
BJH 8-10 Horvath-Kawazoe differential pore volume
Dollimore-Heal 8- 21 plot 7-33

Dubinin transformed isotherm 8- 27
Horvath-Kawazoe 8- 36
MP-Method 8- 44
pore distribution data, import 7-32,7-32
pore size F-13
power analyzer on and off 12-21
power failure, recover from 12-21
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preventive maintenance 72-9
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pump
oil-based vacuum pump 72-8
Python module /-1
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acquire reportresults /- 11
advanced reports /-1
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scripts /-3
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features and shortcuts 7- 16
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generate sample file overlays 7 - 29
heat of adsorption 7-2
Horvath-Kawazoe 8- 33
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tabular report options 8 - 36
interactive 7-10
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plot report options 8- 44
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options 4-20, 4 - 20, 8- 50
regression 7-5
sample log 8- 50
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Sinfelt method 8- 15, 8- 51
SPC report options 7 -4
summary report options 8- 52
t-Plot report options 8- 54
Temkin 8-57
user-defined 8- 1
validation report options 8- 60
reports, Python module /-5
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report 8-50
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tion 5-2
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create 6-7
defined 3-1
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installation 17-6
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application 2-8
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setup 2-1
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Software Uninstall 2- 24
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analyzer 2-22

instrument 2- 18
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options 8- 52
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t-Plot
report options 8- 54
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replace fuse J- 12
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thickness curve sample data K- 2
Halsey F- 14 valve test K- 3
Harkinsand Jura F-15,F-15

troubleshooting

and maintenance 712-1

elevator drive assembly, lubricate 72 -
13

manual control, enable 712-13
power failure, recover from 12 -21
Psat tube, replace O-ring 12-17
sample tube O-ring 12- 18
service test mode 712-8

cryostat D -5
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unit configuration, specify gas ports 2- 15
unit selections 2- 17
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vacuum pump
oil-based 12-8
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